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GIỚI THIỆU VỀ MÔ ĐUN TIN HỌC VĂN PHÒNG 

 

VỊ TRÍ, TÍNH CHẤT CỦA MÔ ĐUN: 

- Vị trí:  Mô đun được bố trí sau khi sinh viên học xong các môn học             chung, 

tin học đại cương và trước các môn học, mô đun đào tạo chuyên môn nghề. 

- Tính chất: Là mô đun kỹ thuật cơ sở nghề bắt buộc. 

 

MỤC TIÊU MÔ ĐUN: 

- Sử dụng Internet như là công cụ nhằm phục vụ cho việc học tập của mình; 

- Thao tác được các công cụ trong bộ phần mềm Microsoft Office hoặc phần mềm 

nguồn mở Open Office; 

- Sử dụng thành thạo phần mềm soạn thảo văn bản (Microsoft Word hoặc phần 

mềm nguồn mở Open Office Writer) để tạo các tài liệu đạt tiêu chuẩn theo qui 

định; 

- Sử dụng phần mềm bảng tính (Microsoft Excel hoặc bảng tính trong Open Office 

Calc) để tạo lập, biểu diễn các kiểu dữ liệu: số, chuỗi ký tự, Thời gian, biểu đồ và 

lập được các bảng tính...  

- Sử dụng phần mềm trình diễn (Microsoft PowerPoint hoặc trình diễn trong Open 

Office Draw) thiết kế các bài báo cáo, chuyên đề một cách chuyên nghiệp. 

- Bố trí làm việc khoa học đảm bảo an toàn cho người và phương tiện học tập. 

 

NỘI DUNG MÔ ĐUN 

- Tổng quan về Internet 

- Dịch vụ World Wide Web – Truy cập Internet 

- Tổng quan về phần mềm xử lý văn bản 

- Trình bày văn bản 

- Xử lý bảng biểu 

- Bảo mật và In ấn 

- Tổng quan về Excel 

- Hàm trong Excel 

- Đồ thị và In ấn 

- Tổng quan về Powerpoint 

- Hiệu ứng và trình diễn 
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BÀI 1: TỔNG QUAN VỀ INTERNET 

Giới thiệu:         

  Inerternet có thể định nghĩa là mạng của các mạng máy tính (Network of 

Networks) sử dụng giao thức TCP/IP. Từ một dự án nghiên cứu, phát triển mạng 

thông tin máy tính dựa trên công nghệ chuyển mạch gói (packet switching 

technology) phục vụ nghiên cứu, phát triển của Bộ quốc phòng Mỹ giữa những năm 

1960, Internet ngày nay đã trở thành mạng của các mạng thông tin máy tính toàn 

cầu, được kết nối với nhau trên cơ sở bộ giao thức trao đổi dữ liệu TCP/IP 

(Transmission Control Protocol/ Internet Protocol), đáp ứng ngày càng phong phú 

hầu hết các dịch vụ thông tin liên lạc của xã hội, tiến tới trở thành hạ tầng thông tin 

liên lạc duy nhất của xã hội thông tin tương lai.  
 

1.  Khái niệm về Internet 

1.1. Những khái niệm cơ bản về mạng máy tính và internet 

Việc nối máy tính thành mạng từ lâu đã trở thành một nhu cầu khách quan vì  

- Có rất nhiều công việc về bản chất là phân tán hoặc về thông tin, hoặc về xử 

lý  hoặc  cả  hai  đòi  hỏi  có  sự  kết  hợp  truyền  thông  với  xử  lý  hoặc  sử  dụng 

phương tiện từ xa. 

- Chia sẻ các tài nguyên trên mạng cho nhiều người sử dụng tại một thời điểm 

(ổ cứng, máy in, ổ CD ROM . . .) 

- Nhu cầu liên lạc, trao đổi thông tin nhờ phương tiện máy tính. 

-  Các  ứng  dụng  phần  mềm đòi  hòi  tại  một  thời  điểm cần  có  nhiều  người  sử 

dụng, truy cập vào cùng một cơ sở dữ liệu. 

* Định nghĩa mạng máy tính 
Mạng máy tính là tập hợp các máy tính độc lập (autonomous) được kết nối với 

nhau thông qua các đường truyền vật lý và tuân theo các quy ước truyền thông nào 

đó. 

Khái niệm máy tính độc lập được hiểu là các máy tính không có máy nào có 

khả năng khởi động hoặc đình chỉ một máy khác. 

Các đường truyền vật lý được hiểu là các môi trường truyền tín hiệu vật lý (có 

thể là hữu tuyến hoặc vô tuyến). 

Các quy ước truyền thông chính là cơ sở để các máy tính có thể "nói chuyện" được  

với  nhau  và  là  một  yếu  tố  quan  trọng  hàng  đầu  khi  nói  về  công  nghệ mạng máy 

tính. 

1.2. Lịch sử mạng máy tính 

1969: Đưa vào sử dụng thử nghiệm mạng thông tin máy tính trên cơ sở công 

nghệ chuyển mạch gói (packet switching technology).  

1977: Thử nghiệm thành công việc kết nối ba mạng thông tin máy tính của ba 

trường đại học lớn ở Mỹ bằng giao thức TCP/IP.  

1986: Việc đưa vào sử dụng mạng NFSNET, mạng Backbone Internet tốc độ 

cao (34Mbit/s - 45 Mbit/s) phục vụ cho nghiên cứu, giảng dạy đã kích thích sự phát 
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triển mạnh mẽ của Internet trong cộng đồng nghiên cứu và giáo dục ở Mỹ và các 

nước Tây Âu.  

1990/1991: Internet được thương mại hoá với sự ra đời của tổ chức khuyến 

khích phát triển và sử dụng Internet "Xã hội Internet" (Internet Society), bắt đầu thời 

kỳ phát triển bùng nổ của Internet. Từ đây, Internet đã thực sự trở thành mạng thông 

tin máy tính của toàn xã hội.  

1997: Đã có hơn 100000 mạng thông tin máy tính được kết nối trong Internet 

toàn cầu với hơn 15 triệu máy chủ và 50 triệu người sử dụng. Người ta dự đoán 

những con số này sẽ tăng gấp đôi sau mỗi năm.  

Thời gian đầu, Internet chỉ cho phép các tổ chức phi lợi nhuận sử dụng bởi vì 

phần lớn thông tin được cung cấp từ các tổ chức khoa học quốc gia, cơ quan quản 

trị hàng kkông và không gian, và bộ quốc phòng Mỹ, với ngân quỹ lấy từ chính phủ. 

Nhưng khi các hệ thống mạng công ty bắt đầu bùng nổ, người dùng có thể truy cập 

các Website thương mại - các Website này không sử dụng từ ngân quĩ chính phủ. 

Vào cuối năm 1992, xuất hiện nhà cung cấp thông tin thương mại đầu tiên - Delphi 

- cung cấp dịch vụ đầy đủ trên Inernet cho khách hàng. Và sau đó, một vài nhà cung 

cấp khác ra đời. 

Ngày nay, không ai kiểm soát toàn bộ Internet mà mỗi nhà quản trị mạng chỉ 

quản lý phần mạng của tổ chức mình. Tuy nhiên  để Internet phát triển theo một 

chiều hướng thống nhất, W3C có nhiệm vụ theo dõi các chuẩn về Web, phát triển 

các giao thức truyền thông chung trên Internet. W3C cung cấp các thông tin, các mã 

tham khảo, các nguyên mẫu (prototype), các ứng dụng cho người dùng và các nhà 

phát triển, nagỳ nay W3C có trụ sở đặt tại Mỹ, Châu Âu và Nhật. 

Có thể kể đến những yếu tố chính thúc đẩy sự phát triển mạnh mẽ của Internet 

mà thực chất là việc mở rộng thực hiện kết nối một cách mềm dẻo và tin cậy các 

máy tính và các mạng máy tính với nhau trên cơ sở bộ giao thức trao đổi dữ liệu 

TCP/IP sau đây: 

Việc sử dụng bộ giao thức TCP/IP trong hệ điều hành UNIX để thực hiện trao 

đổi dữ liệu giữa các tiến trình trên một máy và giữa các máy được kết nối trong 

mạng. UNIX là hệ điều hành được sử dụng rộng rãi từ 1983 trong các trường Đại 

học và các Viện nghiên cứu ở Mỹ.  

Kỹ thuật vi xử lý và các máy tính cá nhân PC (Personal Computer) ra đời vào 

giữa những năm 1980 và ngày càng được hoàn thiện, nâng cao về công suất tính 

toán và tiện lợi trong giao diện sử dụng, đã thực sự rút ngắn khoảng cách giữa người 

sử dụng và các thiết bị tính toán, làm cho máy tính thâm nhập ngày càng sâu vào tất 

cả các lĩnh vực của đời sống xã hội và thúc đẩy nhu cầu kết nối máy tính và mạng 

máy tính.  

NFSNET, mạng xương sống Internet ra đời năm 1986 ở Mỹ với tốc độ truy 

nhập đường trục là 45 Mbit/s, đã nâng cao một bước cơ bản về dải thông và chất 

lượng truy nhập mạng, đáp ứng được yêu cầu trao đổi thông tin ngày càng cao trong 

cộng đồng nghiên cứu và giảng dạy.  

Việc sử dụng hệ thống tên miền (DNS) đã làm cho việc truy nhập Internet trở nên 

đơn giản và tiện lợi. 
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1.3. Mạng máy tính và lợi ích của mạng. 

Nhu cầu của việc kết nối mạng máy tính 
Việc nối máy tính thành mạng từ lâu đã trở thành một nhu cầu khách quan vì 

: 

- Có rất nhiều công việc về bản chất là phân tán hoặc về thông tin, hoặc về xử 

lý  hoặc  cả  hai  đòi  hỏi  có  sự  kết  hợp  truyền  thông  với  xử  lý  hoặc  sử  dụng 

phương tiện từ xa. 

- Chia sẻ các tài nguyên trên mạng cho nhiều người sử dụng tại một thời điểm 

(ổ cứng, máy in, ổ CD ROM . . .) 

- Nhu cầu liên lạc, trao đổi thông tin nhờ phương tiện máy tính. 

-  Các  ứng  dụng  phần  mềm đòi  hòi  tại  một  thời  điểm cần  có  nhiều  người  sử 

dụng, truy cập vào cùng một cơ sở dữ liệu.  

2. Sử dụng Internet 

2.1. Trao đổi E-mail và tập tin qua mạng Internet 

Phương thức gửi và nhận thư 

Để nhận thư điện tử, người dùng cần thực hiện các thao tác sau: 

- Khởi động Outlook Express 

-  Kích chuột vào nút  hoặc vào mục menu Tools\Send and Receive\Send 

and Receive All. 

- Hộp biểu diễn tiến trình sẽ cho người dùng biết được tiến trình gửi và nhận thư. 

- Trong khi gửi/nhận, người dùng cũng có thể ngưng công việc này bằng cách bấm 

nút Stop. Hoặc bấm nút Hang up when finished để hủy kết nối tới hộp thư. 

 

Hộp biểu diễn tiến trình gửi/nhận thư 

Lưu ý: Nếu người dùng chưa khai báo mật khẩu truy cập hộp thư trong Account 

tương ứng thì Outlook Express sẽ yêu cầu người dùng phải nhập vào mật khẩu truy 

nhập hộp thư để thực hiện việc kết nối tới hộp thư và tải thư từ hộp thư về hay gửi 

thư đó đi. 

Tạo mới một bức thư 



 Trang 5  

Để tạo mới một bức thư, người dùng chỉ kích chuột vào nút  trên thanh 

Toolbar. 

Màn hình New Message xuất hiện cho người dùng soạn thảo bức thư để gửi đi. 

Một bức thư thông thường được cấu trúc làm  02 phần: phần tiêu đề và phần nội dung 

thư. 

Phần tiêu đề sẽ có một số mục sau: 

Địa chỉ người nhận (To): Là địa chỉ của tất cả những người nhận bức thư. 

Địa chỉ của người đồng nhận (CC): Về chức năng những địa chỉ thư trong 

phần CC cũng sẽ nhận được thư giống hệt như trong phần To. Tuy nhiên vai trò của 

người nhận thư lại khác nhau. 

Địa chỉ của người đồng nhận dấu tên (BCC): những địa chỉ trong phần này 

đều nhận được bức thư gửi tới. Tuy nhiên khác với phần CC, trong phần tiêu đề của 

bức thư được gửi đi sẽ không có địa chỉ của người nhận đó mặc dù người đó vẫn 

nhận được thư. Phần BCC sẽ xuất hiện khi người dùng Kích chuột vào nút 

 hoặc . 

Tiêu đề của bức thư (Subject): Thông thường đó là dòng chữ biểu thị cho toàn bộ 

nội dung bức thư. 

Chú ý: Nếu có nhiều địa chỉ trong phần To hay CC của bức thư thì các địa chỉ này 

phải được viết phân cách nhau bởi dấu chấm phẩy (;). 

Phần nội dung thư: 

Trong phần này, người dùng có thể tùy ý soạn thảo nội dung bức thư theo ý muốn của 

mình. 

 

Màn hình New Message để tạo một bức thư  

Đính kèm file vào bức thư 

Người dùng có thể đính kèm bất kỳ một file dữ liệu nào vào trong nội dung 

của bức thư. Khi đó toàn bộ file đính sẽ được gửi đi cùng với bức thư tới hộp thư 

của người nhận. Tại đây người nhận có thể tải về và lưu file đính kèm lên đĩa hay 

trực tiếp mở file. 
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Đây là một hình thức truyền tài liệu rất phổ biến thông qua con đường thư điện tử. 

Để thực hiện việc đính kèm file, người dùng thực hiện theo các bước sau: 

- Kích chuột vào nút có biểu tượng đinh ghim  trên thanh ToolBar hoặc chọn 

chức năng Insert\File Attachment. 

- Hộp thoại Insert Attchment hiện ra cho phép người dùng tìm và chọn tên của file 

thông tin đính kèm. Bấm nút -Attachment để thực hiện việc đính kèm file. 

- Một bức thư có thể có nhiều file đính kèm khác nhau. 

Lưu ý: Không nên đưa quá nhiều file đính kèm vào trong thư vì như vậy thư gửi đi 

có thể có dung lượng quá lớn. Như vậy sẽ tốn nhiều thời gian để gửi và nhận thư. 

Kiểm tra thư và đọc thư 

Công việc kiểm tra và đọc thư còn được gọi là Check mail. Sau khi người dùng đã 

bấm nút Send/Recv để thực hiện nhận và chuyển thư. Các thư gửi tới hộp thư của 

người dùng đều sẽ được tải về máy tính của mình. Thông thường, các thư tải về đều 

được đặt trong Folder Inbox và Folder này sẽ được thể hiện dưới dạng chữ nét đậm.  

Chuyển tới Folder Inbox, các thư trong Folder sẽ được hiện ra trong danh sách phía 

bên phải. Có một số đặc điểm trong danh sách thư mà người dùng cần biết: 

- Tên thư có nét đậm cho biết thư đó chưa được đọc. Ngược lại, tên thư đó sẽ có nét 

nhạt. 

- Các thư có file đính kèm, sẽ có một biểu tượng kẹp giấy nằm phía bên trái. 

 

Danh sách thư có trong Folder 

Để đọc thư, người dùng chỉ cần đơn giản chọn thư cần đọc trong danh sách thư phía 

bên phải. Toàn bộ nội dung của bức thư tương ứng sẽ được hiển thỉ ở ngay màn hình 

phía phía dưới. 
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Nội dung bức thư 

Thư có file đính kèm thì sẽ có một biểu tượng kẹp giấy nằm ngay góc trên phải. 

Người dùng khi này có thể tải file đính kèm về máy hoặc mở file đính kèm ra xem. 

Để làm được điều này, người dùng cần: 

- Kích chuột vào biểu tượng kẹp giấy.  

- Trong hộp thoại Windows Attachment Warning, người dùng có thể tiếp tục chọn 

Open it nếu muốn mở file đính kèm luôn, hoặc chọn Save it to disk để lưu giữ file 

này vào máy tính. 

 

Hộp thoại xác nhận mở file đính kèm hay ghi lên đĩa 

Trả lời thư 

Người dùng có thể trả lời tất cả các bức trong Folder thư. Trong thư trả lời, địa chỉ 

gửi tới (địa chỉ To) sẽ chính là địa chỉ của của người đã gửi bức thư đến hộp thư của 

người dùng trước đó (địa chỉ From). 

Người dùng có thể chọn chức năng Reply  để gửi thư trả lời tới chỉ duy nhất địa 

chỉ của người đã gửi bức thư (phần From của bức thư gửi đến). 

Hoặc người dùng cũng có thể chọn chức năng Reply All  để gửi thư trả lời tới 

địa chỉ của cả người đã gửi bức thư (phần From của bức thư gửi đến) lẫn địa chỉ của 

những người khác có nhận được bức thư (phần CC của bức thư gửi đến). 
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Nội dung của thư ban đầu sẽ được thể hiện ngay trong bức thư gửi trả nhưng được 

đánh dấu ở phía bên trái của mỗi dòng thư. 

Trong bức thư trả lời, người dùng cũng có thể đưa vào đó các file đính kèm tương 

tự như trong phần tạo thư. 

Xóa thư 

Để xóa một bức thư nào đó, người dùng chỉ cần đơn giản chọn tiêu đề của bức thư 

cần xóa rồi bấm nút Delete trên bàn phím. 

Lưu ý: Khi xóa một bức thư, Outlook Express sẽ chuyển thư đó vào trong Folder 

Delete. Vì vậy để xóa hẳn thư này, người dùng cần phải xóa cả bức thư có trong 

Folder Delete. 

2.2 Tạo hộp thư (địa chỉ)email miễn phí trên Gmail. 

Có rất nhiều địa chỉ  web ta có thể tạo được một địa chỉ thư miễn phí như 

Yahoo.com, hotmail.com, vietfun.com,… 

Hướng dẫn tạo hòm thư miễn phí trên Yahoo.com 

- Gõ địa chỉ www.yahoo.com  

- Chọn Email hoặc Chekmail 

- Chọn Sign Up Now 

- Chọn Sign Up Now ( Tại ô Free Yahoo! Mail) 

 

- YahooID: Gõ tên hòm thư cần tạo (Không dấu, không cách) 

- Password : Gõ mật khẩu ( ít nhất 6 ký tự, phải tắt chế độ gõ tiếng Việt) 

- Retype password: Gõ lại mật khẩu  

- Sercurity Question: Chọn câu hỏi tùy chọn (chọn bất kỳ) 

- Your answer:  Gõ vào câu trả lời (ít nhất 4 ký tự) 

- Birthday: Gõ ngày tháng năm sinh   
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- Gender: Chọn giới tính  

- First / Last name: Gõ họ và tên đệm  

- Langgue: Chọn ngôn ngữ  

- Zip Code:  Gõ mã nước  

- Industry : Chọn nghề nghiệp (chọn bất kỳ) 

- Title : Chọn chức vụ (chọn bất kỳ) 

- Enter the word: Gõ từ hiển thị ở hộp dưới  

          - Chọn Submit this form  

3. Tìm hiểu về Internet 

3.1. Định nghĩa mạng máy tính và mục đích của việc kết nối mạng 

 

* Định nghĩa mạng máy tính 

Mạng máy tính là tập hợp các máy tính độc lập (autonomous) được kết nối với 

nhau thông qua các đường truyền vật lý và tuân theo các quy ước truyền thông nào 

đó. 

Khái niệm máy tính độc lập được hiểu là các máy tính không có máy nào có 

khả năng khởi động hoặc đình chỉ một máy khác. 

Các đường truyền vật lý được hiểu là các môi trường truyền tín hiệu vật lý (có 

thể là hữu tuyến hoặc vô tuyến). 

Các quy ước truyền thông chính là cơ sở để các máy tính có thể "nói chuyện" được  

với  nhau  và  là  một  yếu  tố  quan  trọng  hàng  đầu  khi  nói  về  công  nghệ mạng máy 

tính. 

* Nhu cầu của việc kết nối mạng máy tính 
Việc nối máy tính thành mạng từ lâu đã trở thành một nhu cầu khách quan vì 

:  

- Có rất nhiều công việc về bản chất là phân tán hoặc về thông tin, hoặc về xử 

lý  hoặc  cả  hai  đòi  hỏi  có  sự  kết  hợp  truyền  thông  với  xử  lý  hoặc  sử  dụng 

phương tiện từ xa. 

- Chia sẻ các tài nguyên trên mạng cho nhiều người sử dụng tại một thời điểm 

(ổ cứng, máy in, ổ CD ROM . . .) 

- Nhu cầu liên lạc, trao đổi thông tin nhờ phương tiện máy tính. 

-  Các  ứng  dụng  phần  mềm đòi  hòi  tại  một  thời  điểm cần  có  nhiều  người  sử 

dụng, truy cập vào cùng một cơ sở dữ liệu. 

3.2. Đặc trưng kỹ thuật của mạng máy tính: 

Một mạng máy tính có các đặc trưng kỹ thuật cơ bản như sau: 

* Đường truyền 
Là thành tố quan trọng của một mạng máy tính, là phương tiện dùng để truyền 

các tín hiệu điện tử giữa các máy tính. Các tín hiệu điệu tử đó chính là các thông 

tin, dữ liệu được biểu thị dưới dạng các xung nhị phân (ON_OFF), mọi tín hiệu 
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truyền giữa các máy tính với nhau đều thuộc sóng điện từ, tuỳ theo tần số mà ta có 

thể dùng các đường truyền vật lý khác nhau 

Đặc trưng cơ bản của đường truyền là giải thông nó biểu thị khả năng truyền 

tải tín hiệu của đường truyền. 

Thông thuờng người ta hay phân loại đường truyền theo hai loại: 

- Đường truyền hữu tuyến (các máy tính được nối với nhau bằng các dây cáp 

mạng). 

- Đường truyền vô tuyến: các máy tính truyền tín hiệu với nhau thông qua các 

sóng vô tuyền với các thiết bị điều chế/giải điều chế ớ các đầu mút. 

* Kỹ thuật chuyển mạch: 
Là đặc trưng kỹ thuật chuyển tín hiệu giữa các nút trong mạng, các nút mạng 

có chức năng hướng thông tin tới đích nào đó trong mạng, hiện tại có các kỹ thuật 

chuyển mạch như sau: 

- Kỹ thuật chuyển mạch kênh: Khi có hai thực thể cần truyền thông với nhau 

thì giữa chúng sẽ thiết lập một kênh cố định và duy trì kết nối đó cho tới khi hai bên 

ngắt liên lạc. Các dữ liệu chỉ truyền đi theo con đường cố định đó. 

- Kỹ thuật chuyển mạch thông báo: thông báo là một đơn vị dữ liệu của người 

sử dụng có khuôn dạng được quy định trước. Mỗi thông báo có chứa các thông tin 

điều khiển trong đó chỉ rõ đích cần truyền tới của thông báo. Căn cứ vào thông 

tin điều khiển này mà mỗi nút trung gian có thể chuyển thông báo tới nút kế tiếp 

trên con đường dẫn tới đích của thông báo 

- Kỹ thuật chuyển mạch gói: ở đây mỗi thông báo được chia ra thành nhiều gói 

nhỏ hơn được gọi là các gói tin (packet) có khuôn dạng qui định trước. Mỗi gói tin 

cũng chứa các thông tin điều khiển, trong đó có địa chỉ nguồn (người gửi) và địa 

chỉ đích (người nhận) của gói tin. Các gói tin của cùng một thông báo có thể được 

gởi đi qua mạng tới đích theo nhiều con đường khác nhau. 

* Kiến trúc mạng 
Kiến  trúc  mạng  máy  tính  (network  architecture)  thể  hiện  cách  nối  các máy 

tính với nhau và tập hợp các quy tắc, quy ước mà tất cả các thực thể tham gia truyền 

thông trên mạng phải tuân theo để đảm bảo cho mạng hoạt động tốt. 

Khi nói đến kiến trúc của mạng người ta muốn nói tới hai vấn đề là hình trạng 

mạng (Network topology) và giao thức mạng (Network protocol) 

- Network Topology: Cách kết nối các máy tính với nhau về mặt hình học mà 

ta gọi là tô pô của mạng 

Các hình trạng mạng cơ bản đó là: hình sao, hình bus, hình vòng 

- Network Protocol: Tập hợp các quy ước truyền thông giữa các thực thể truyền 

thông mà ta gọi là giao thức (hay nghi thức) của mạng 

Các giao thức thường gặp nhất là : TCP/IP, NETBIOS, IPX/SPX, . . . 

* Hệ điều hành mạng 

Hệ điều hành mạng là một phần mềm hệ thống có các chức năng sau: 

- Quản lý tài nguyên của hệ thống, các tài nguyên này gồm: 

+ Tài nguyên thông tin (về phương diện lưu trữ) hay nói một cách đơn giản 

là quản lý tệp. Các công việc về lưu trữ tệp, tìm kiếm, xoá, copy, nhóm, đặt các 

thuộc tính đều thuộc nhóm công việc này 

+ Tài nguyên thiết bị. Điều phối việc sử dụng CPU, các ngoại vi... để tối ưu 
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hoá việc sử dụng 

- Quản lý người dùng và các công việc trên hệ thống. Hệ điều hành đảm bảo 

giao tiếp giữa người sử dụng, chương trình ứng dụng với thiết bị của hệ thống. 

- Cung cấp các tiện ích cho việc khai thác hệ thống thuận lợi (ví dụ FORMAT 

đĩa, sao chép tệp và thư mục, in ấn chung ...) 

Các  hệ  điều  hành  mạng  thông  dụng  nhất  hiện  nay  là:  WindowsNT, Windows9X, 

Windows 2000, Unix, Novell. 

4. Các dịch vụ trên Internet 

4.1. World Wide Web 

World Wide Web (WWW hay Web) là một dịch vụ mới nhất và có hiệu quả 

nhất trên Internet. WWW với những đặc trưng của riêng nó cùng với tổ hợp các dịch 

vụ thông tin đã  biến nó trở thành một dịch vụ rất hữu ích nhưng lại rất dễ hiểu. Nếu 

khi chúng ta cần FTP thì client FTP sẽ cho phép chúng ta có thể truy nhập vào tài 

nguyên của FTP. Nếu chúng ta cần WAIS thì client WAIS sẽ cho phép chúng ta truy 

nhập vào WAIS server. Nếu là client Gopher thì có thể nối với Gopher server. Còn 

trình duyệt Web có thể cho phép chúng ta truy nhập vào tất cả  các dịch vụ trên và 

còn hơn thế nữa. Tài liệu WWW được viết bằng ngôn ngữ HTML (HyperText 

Markup Language) hay còn gọi là ngôn ngữ siêu văn bản. Dưới dạng nguyên thủy 

nó giống như văn bản bình thường nhưng nó có thêm một số lệnh định dạng. HTML 

bao gồm nhiều cách liên kết với các tài nguyên FTP, Gopher server, WAIS server 

và Web server. Web server trao đổi các tài liệu HTML bằng giao thức HTTP 

(HyperText Transfer Protocol) hay gọi là giao thức truyền siêu văn bản. Với một 

cách định dạng đặc biệt bởi các lệnh của HTML, ta biết được có sự liên kết với siêu 

văn bản khác hay không bằng cách nhận biết qua việc gạch dưới một cụm từ. Khi 

đó người dùng chỉ việc kích chuột thì trình duyệt sẽ tự động chuyển tới kết nối đó. 

Nếu đó là một tài liệu HTML thì trình duyệt chỉ đơn giản là hiển thị văn bản đó. Nếu 

đó là một thư mục của một tài nguyên FTP thì trình duyệt sẽ liệt kê danh sách thư 

mục và thể hiện nội dụng bằng một loạt các kết nối với tên sau khi các thư mục con 

và các tệp đã được liệt kê đầy đủ trên thư mục. Khi chúng ta kích vào tệp thì liên kết 

phục hồi thành tệp và hiện chúng nếu có thể hoặc truyền nó đến người sử dụng. Cũng 

như trên, theo các liên kết thì một Gopher Server hiển thị một thực đơn từ chính 

Gopher Server đó. Liên kết xác định thực đơn mức cao nhất hoặc bất cứ thực đơn 

nào trong hệ thống thực đơn bậc của Gopher. Mỗi một thư mục đơn hoạt động như 

một liên kết siêu văn bản dẫn tới thực đơn con.  

Để sử dụng trình duyệt đồ hoạ, người dùng là các công ty hay các trường đại học 

phải kết nối IP vào Internet. Đối với người sử dụng tại nhà riêng thì cần kết nối SLIP 

hoặc PPP để sử dụng trình duyệt đồ hoạ. Với người dùng thông qua các máy kết nối 

Internet hoặc kết nối Internet đơn giản sẽ không được hỗ trợ trình duyệt Web đồ hoạ 

mà chỉ sử dụng trình duyệt dạng ký tự và do vậy, không thể có hình ảnh đồ hoạ đẹp. 

Việc dịch vụ WWW có thể cho phép kết nối các thông tin trên quy mô lớn, sử dụng 

đơn giản đã giúp nó trở thành một dịch vụ quan trọng trên Internet. Tài liệu HTML 

có khả năng cung cấp các nội dung có giá trị và các thông tin bổ ích, đơn giản. Chỉ 

cần một lần kích chuột là có thể truy nhập vào các Server thông tin ở bất cứ đâu. 



 Trang 12  

4.2. E-mail 

E-mail - viết tắt của Electronic Mail (thư điện tử) là một dịch vụ được triển 

khai trên các mạng máy tính cho phép người dùng có thể gửi thư cho nhau. 

Ở đây “thư” là một tệp dạng text, hành động chuyển thư được thực hiện theo 

phương thức truyền gửi các tệp này trên các đường truyền dẫn của mạng. Trong 

nhiều trường hợp thư còn có từ đồng nghĩa là thông điệp (message), đúng ra thông 

điệp cần được hiểu là một thư ngắn không vượt quá một câu. 

E-mail là dịch vụ cơ bản nhất và phổ thông nhất trên mạng, là nền tảng để xây dựng 

một văn phòng không giấy (paperless office). 

*Các mô hình họat động của dịch vụ E mail: 

- Mô hình thông điệp trực tiếp: Theo mô hình này, các thông điệp được gửi trực tiếp, 

ngay lập tức tới các máy đang họat động trên một LAN. 

- Mô hình hộp thư lưu: Là mô hình khách-chủ của dịch vụ thư điện tử, theo đó 

chương trình thực hiện dịch vụ này được viết thành hai phần chương trình chạy độc 

lập tương đối: 

+Chương trình phía Client (khách) chạy trên các máy trạm làm việc của mạng và 

phần phía Server (chủ) chạy trên máy chủ của mạng. Người dùng soạn thảo thư, ấn 

định địa chỉ nhận và “ra lệnh” gửi thư thông qua chương trình client về máy chủ của 

mạng. 

+ Chương trình Server đón nhận các thư gửi từ Client, lưu trữ vào các hộp thư lưu. 

+Mỗi người dùng cũng nhận và đọc thư của mình bằng cách dùng chương trình phía 

client duyệt danh sách các thư gửi cho mình và đọc thư quan tâm. 

+Chương trình Server cũng có thể phát tín hiệu báo có thư cho những người đang 

làm việc trên mạng. 

- Mô hình Internet Mail: Là mô hình liên kết các hộp thư lưu trên Internet, mỗi hộp 

thư lưu cho một vùng. Nếu tất cả các liên kết đang được thực hiện, thư sẽ được 

chuyển đếp hộp thư lưu đích trong vài giây, trường hợp ngược lại nó sẽ được chuyển 

bước qua từng hộp thư lưu và các đường liên kết đang thực hiện để đến đích cuối 

cùng. 
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Bài tập và sản phẩm thực hành 

Kiến thức: 

Câu 1: Hãy mở trình duyệt Internet Explore và truy cập vào trang web: 

mail.yahoo.com hay gmail.com. 

Câu 2: Tạo một hộp mail yahoo hay Gmail cho mình, sau đó thực hiện theo 

các yêu cầu sau: 

 - Gởi mail cho chúng ta của mình  

 - Gởi mail cung một lúc cho nhiều người 

- Thực hiện gởi một attach file cho chính hộp mail của mình  

Kỹ năng: 

Bài tập ứng dụng:  Hướng dẫn khai thác Web qua mail: 

Dich vụ Agora 

 Để lấy trang web qua mail từ dịch vụ Agora, ta thực hiện như sau: 

+Gởi đến một trong các địa chỉ sau (Nhập địa chỉ vào vùng to) 

Agora@dna.affrarc.go.jp 

Agora@kamakura.mss.co.jp 

Agora@www.eng.dmu.ac.uk 
 + Trong phần nội dung thư đanh câu lệnh sau: 

Send<địa chỉ trang web> hoặc resend<đia chỉ mail > <địa chỉ web> 

Dịch vụ Getweb 

 Để lấy lấy về trang web qua mail từ dịch vụ Getweb, thực hiện như sau: 

+ Gởi một trong các địa chỉ sau: 

Getweb@usa.healthnet.org 

Getweb@unganisha.idrc.ca 

W3mai@gmd.de 

CHỈ DẪN ĐỐI VỚI HỌC SINH THỰC HIỆN BÀI TẬP ỨNG DỤNG 

1. Bài tập ứng dụng phải thực hiện đúng trên máy tính giáo viên giao cho. 

2. Kiểm tra các ứng dụng chạy trên máy tính và hướng dẫn sử dụng trước khi 

thực hiện lệnh. 

3. Thực hiện đầy đủ các bước chuẩn bị khi thực hiện lệnh khai thác web qua 

mail . 

4. sử dụng ứng dụng theo qui định và thao tác đúng các lệnh. 

5. Tổng điểm và kết cấu điểm của các bài như sau: 

Tổng số điểm tối đa cho bài: 100 điểm, kết cấu như sau: 

a, Phần thực hành khi thực hiện : Tổng cộng 70 điểm 

b, Phần chính xác và nhanh chóng : 30 điểm 

- Thời gian thực hiện bài tập vượt quá 25% thời gian cho phép sẽ không được 

đánh giá. 

- Thí sinh phải tuyệt đối tuân thủ các qui định an toàn lao động, các qui định của 

xưởng thực tập, nếu vi phạm sẽ bị đình chỉ thực tập 

mailto:Agora@dna.affrarc.go.jp
mailto:Agora@kamakura.mss.co.jp
mailto:Agora@www.eng.dmu.ac.uk
mailto:Getweb@usa.healthnet.org
mailto:Getweb@unganisha.idrc.ca
mailto:W3mai@gmd.de
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Đánh giá kết quả học tập 

 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

người 

học 

I Kiến thức    

1 Các câu lệnh dùng để vào 

mail. 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

1  

1.1 Liệt kê đầy đủ các mục trong 

mail 
0,5  

1.2 Liệt kê đầy đủ các cú pháp 

lệnh trong mail 
0,5  

2 Chức năng, nguyên lý làm 

việc của màn hình IE 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

2.1 Nêu đầy đủ cấu tạo của màn 

hình IE 
0,5  

2.2 Trình bày công dụng và  

nguyên lý làm việc của các 

lệnh trong mail.  

1  

2.3 Trình bày đúng cách thực hiện 

các lệnh. 
0,5  

3 Phạm vi ứng dụng của IE,mail 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

3.1 Nêu đúng thực chất của 

IE,mail 

 

1  

3.2 Trình bày đầy đủ đặc điểm của 

mail 

0,5  

3.3 Nêu đúng phạm vi ứng dụng 

của các lệnh trong IE,mail 

 

0,5  

4 Trình bày màn hình và cách 

thực hiện lệnh 

 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

1,5  

5 Chọn chế độ làm việc và cách 

thực hiện lệnh hợp lý. 
Làm bài tự luận 

và trắc nghiệm 

đối chiếu với nội 

dung bài học 

1,5  

5.1 Nêu cách chọn lệnh phù hợp 0,5  
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5.2 Trình bày đúng cách thực hiện 

lênh.  

0,5  

5.3 Trình bày cách chọn đường 

dẫn đến lệnh chính xác 

0,5  

6 Trình bày đúng kỹ thuật thực 

hiện lệnh 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 
2 

 

                                      Cộng: 10 đ  

II Kỹ năng    

1 Nhận biết một số giao diện của 

IE 

Quan sát hình 

ảnh, đối chiếu 

với nội dung bài 

học để nhận biết 

2 

 

2 Vận hành thành thạo một số 

lệnh trong IE. 

Quan sát các thao 

tác, đối chiếu với 

quy trình vận 

hành 

3 

 

3 Nhận biết và sử dụng các loại 

lệnh phụ trợ trong mail một 

cách  thành thạo 

Quan sát hình 

ảnh, ký hiệu các 

loại lệnh đối 

chiếu với nội 

dung bài học để 

nhận biết 

2 

 

4 Phân biệt và phân loại các loại 

lệnh trong mail. 

Quan sát các 

lệnh, đối chiếu 

với nội dung bài 

học để nhận biết 

3 

 

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp khi vẽ Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1,5  

1.2 Không vi phạm nội quy lớp học 1,5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 
2 
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 với thời gian quy 

định. 

3 Đảm bảo an toàn thực hành và 

vệ sinh công nghiệp 
Theo dõi việc 

thực hiện, đối 

chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 

khi thực hiện lệnh trong mail  
1,5 

 

3.2 Đầy đủ bảo hộ lao động( quần 

áo bảo hộ, giày, thẻ học sinh…) 
1,5 

 

3.3 Vệ sinh phòng máy thực hành  

đúng quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

                                                                                              

Cộng: 
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BÀI 2: DỊCH VỤ WORLD WIDE WEB –TRUY CẬP WEBSITE 

1.Giới thiệu: 

 Ðây là dịch vụ mới và phát triển mạnh trên Internet. Nó bao gồm nhiều chức 

năng, cộng thêm khả năng tích hợp được hầu hết các dịch vụ hiện có trên Internet. 

World Wide Web cho phép ta truy cập được Gopher, Wais, FTP, sử dụng Telnet, 

Finger. 

Web hoạt động theo mô hình client/server. Các khách hàng gửi yêu cầu (request) về 

một tài liệu HTML (tức là khách hàng gửi URL của tài liệu) tới Web server, Web 

server dùng thông tin về URL được cung cấp để xác định trang Web và trả lời.  

 

 

 

 

 

Trang Web được trả về cho khách hàng có thể là trang Web tĩnh nghĩa là nó 

được tạo ra và lưu trữ từ trước khi có yêu cầu (Web server chỉ đơn thuần lấy nó và 

trả về ) hoặc là trang Web động nghĩa là nó được Web server tạo ra dựa trên yêu cầu 

và các thông tin cung cấp của khách hàng, có thể dựa trên sự hỗ trợ của các phần 

mềm ứng dụng nào đó. 

Mỗi khi có yêu cầu từ phía khách hàng thì một kết nối (connection) giữa khách 

hàng chạy trình duyệt Web và Web server được thiết lập, sau khi Web server phục 

vụ xong yêu cầu thì kết nối đó được hủy đi. Như vậy mối kết nối giữa client và server 

chỉ được thiết lập trong quá trình trao đổi thông tin điều này làm giảm mật độ sử 

dụng đường truyền trên mạng. 

Các tài liệu World Wide Web được viết bằng ngôn ngữ HTML, hay còn gọi 

là Hyper Text Markup Language. Nó cho phép ta mô tả các mối liên kết giữa các tài 

liệu với nhau và các mối liên kết tới các dịch vụ Internet khác. Web truyền các tài 

liệu HTML thông qua một giao thức gọi là HTTP (HyperText Transfer Protocol). 

Các tài liệu HTML bao gồm khả năng liên kết tới rất nhiều dạng thông tin 

khác nhau như văn bản, hình ảnh, âm thanh v.v… 

Tuy nhiên do khả năng hỗ trợ multimedia như vậy, chỉ những người có đường 

kết nối tốc độ cao vào mạng Internet mới có khả năng tận dụng hết các khía cạnh ưu 

việt của dịch vụ World Wide Web. 

HTTP (HyperText Transfer Protocol) là giao thức dùng trong việc trao đổi thông 

tin giữa trình duyệt Web và Web server. Giao thức này hỗ trợ và truyền các thông 

tin dưới nhiều dạng khác nhau như văn bản, hình ảnh, âm thanh, v.v... theo chuẩn 

MIME (Multipurpose Internet Mail Extension). 
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URL (Uniform Resource Locator) là một phương thức để tham chiếu tới một tài 

nguyên bất kỳ trên Internet. URL được sử dụng trong các dịch vụ thông tin trên 

Internet như Gopher, WAIS, WWW, v.v... Mỗi một trang Web có một URL duy 

nhất để xác định trangWeb đó. Cú pháp của URL có dạng như sau: 

protocol://host name[:port]/path/filename----- 

hoặc protocol:// IP address[:port]/path/filename 

Trong đó:  

+ protocol là giao thức dùng để truy nhập và lấy thông tin. Có 3 giao thức 

thường dùng là HTTP (Hypertext Transfer Protocol), Gopher protocol và  

FTP. 

+ Host name là tên của máy có thông tin cần tra cứu. 

+ IP address là địa chỉ IP của máy có thông tin cần tra cứu.  

+ port là cổng trao đổi thông tin (tham số này có thể có hoặc không).  

+ path là đường dẫn tới nơi chứa thông tin. 

+ filename là tệp được trỏ tới (nếu là HTML thì có phần mở rộng là.htm hay.html ). 

Ví dụ:  

http://www.microsoft.com/catalog/order.htm 

http://203.160.0.110/vninfo/index.htm 

Hyperlink là các siêu liên kết giúp ta di chuyển (navigate) giữa các trang Web. Mỗi 

hyperlink trỏ tới URL của một trang Web, nếu ta nhấn con trỏ của chuột vào 

hyperlink này thì trang Web đó sẽ được hiển thị. 

Web page là trang Web trên đó thông tin có thể được biểu diễn dưới dạng văn bản, 

hình ảnh, âm thanh hoặc các đoạn phim. Trang Web được lưu trữ dưới dạng file có 

phần mở rộng là htm hoặc html. Trên một trang Web có thể chứa các liên kết 

(hyperlink) tới những trang Web khác, điều này giúp người dùng có thể truy cập 

được thông tin ở rất nhiều trang Web khác nhau. 

HTML (Hypertext Markup Language) là ngôn ngữ để tạo nên các trang Web. HTML 

dùng các thẻ (tag) để mô tả cấu trúc của một trang Web và các liên kết tới các trang 

Web khác. 

Mục tiêu: 

-  Mô tả được dịch vụ World Wide Web trên Internet; 

- Cài đặt và sử dụng được các trình duyệt internet thông dụng; 

- Trình bày các sử dụng thư điện tử ( E-Mail); 

- Trình bày được địa chỉ Internet. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung . 
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2. Dịch vụ World wide web 

2.1. Trang chủ  

Internet Explorer (IE) là phần mềm duyệt Web của hãng Microsoft và được tích hợp 

ngay trong hệ điều hành Windows 9x, Windows NT và Windows2000,... 

  

 

H1. Màn hình hiển thị trang Web trong IE 

Màn hình IE bao gồm các thành phần chính sau: 

- Tiêu đề: Hiển thị tiêu đề của trang Web hiện tại. 

- Menu: Cho phép người sử dụng thực hiện các lệnh thông qua các mục chọn Menu 

- ToolBar: Cho phép người sử dụng có thể thực hiện lệnh thông qua việc kích chuột 

một cách nhanh chóng. 

- Địa chỉ trang Web: Người sử dụng nhập vào địa chỉ của trang Web muốn hiển thị. 

- Màn hình chính: Phần hiển thị nội dung của trang Web. 

- Thanh trạng thái: Hiển thị thông tin bổ sung. 

. Tiêu đề 

Phần này hiển thị thông tin về trang Web hiện thời 

 

H2. Tiêu đề trang Web 

. Menu trong IE 
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Cho phép người sử dụng thực hiện các lệnh thông qua các mục chọn Menu. 

Hệ thống menu trong các phần mềm nói chung cũng như trong IE nói riêng đều bao 

gồm hai loại menu chính: 

- Menu Bar: Phần menu nằm trải ngang ngay trên màn hình. Mỗi mục trên menu 

thường chứa một nhóm các mục menu con khác. 

 

H3. Menu Bar trong IE 

 Menu Pulldown: Phần menu chứa các mục chọn thực hiện lệnh cụ thể hoặc 

chứa tập hợp các mục chọn khác. Tiếp theo, ta xem xét lần lượt các Menu Pulldown 

sau: File, Edit, View, favouries.   

Lưu ý: Ta chỉ chú trọng vào các chức năng hay được sử dụng  

Menu File: Các mục menu liên quan đến file 

 

H4. Menu File trong trình duyệt IE5 

 Menu  Edit: Các tiện ích, copy, cut, tìm kiếm,... 
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H5. Menu Edit trong trình duyệt IE 

Menu  View: Các chế độ thể hiện của IE 

 

H6. Menu View trong trình duyệt IE 

Menu  Favorites: Tổ chức, lưu giữ các trang Web của người dùng 

 

H.7 Menu Favorites trong trình duyệt IE 

. Toolbar trong IE 

Cho phép người sử dụng có thể thực hiện lệnh thông qua việc kích chuột một cách 

nhanh chóng. 

 

H.8 Diễn giải một số chức năng chính trên thanh ToolBar 
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Phần địa chỉ 

Người sử dụng nhập vào địa chỉ của trang Web muốn hiển thị. 

Mỗi trang Web đều có một địa chỉ phân biệt gọi là địa chỉ URL. 

 

H.9 Địa chỉ trang web trong IE 

 

H.10 Các thành phần của một địa chỉ trang Web 

- Giao thức: hiện tại có nhiều loại giao thức đang được sử dụng trên mạng Internet. 

Tuy nhiên có hai loại giao thức hay gặp nhất là: http – giao thức truyền trang Web 

và  ftp – giao thức truyền file. 

- Miền địa chỉ: các địa chỉ được phân định theo các miền khác nhau và chúng được 

ngăn cách nhau bởi dấu chấm ‘.’. Đối với các trang Web của Việt Nam, miền địa chỉ 

thường được gắn liền với:.vn. Ví dụ:    www.moste.gov.vn, www.moet.edu.vn, 

www.fpt.com.vn 

- Thông thường mỗi tên miền địa chỉ ứng với địa chỉ web server. 

- Chi tiết địa chỉ: là địa chỉ cụ thể của trang Web tại Web server có chứa nó. 

Màn hình chính 

Màn hình chính thông thường bao gồm ba phần chính 

- Phần đầu: nằm ở phía trên cùng của trang Web. 

- Phần danh mục liên kết: thường nằm dọc phía bên trái của trang Web 

- Phần nội dung chính: thường là phần có diện tích lớn nhất và nằm phía bên phải. 

Phần này hiển thị nội dung của trang Web. 

Các thông tin hiển thị trong trang Web dưới dạng: văn bản, hình ảnh, đồ họa, 

âm thanh,... Một đoạn văn bản hay hình ảnh lại có thể có các liên kết tới các trang 

Web khác. Những đoạn văn bản hay hình ảnh thuộc loại này thường có mầu sắc biến 

đổi khác với mầu sắc của đoạn văn bản hay hình ảnh không có liên kết. Khi đưa 

chuột tới những nơi có chứa liên kết thì hình dạng của chuột thường bị biến đổi 

(thông thường là biến thành hình: bàn tay). 

Có 3 thành phần chính trong một địa chỉ trang Web: 

http://www.moste.gov.vn/
http://www.moet.edu.vn/
http://www.fpt.com.vn/
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 Thanh trạng thái 

Hiển thị trạng thái của chương trình IE cũng như của trang Web dưới dạng các thông 

báo. 

Thanh trạng thái nằm ở phần dưới cùng của màn hình trình duyệt IE5. 

 

H.11 Thanh trạng thái của trình duyệt 

. Các chức năng chính của ie5 

Di chuyển trong IE 

Công cụ Tác động Sử dụng khi 

 
Quay trở về trang trước Đã vào từ hai trang trở lên 

 
Quay trở về trang sau Đã vào từ hai trang trở lên 

 
Dừng việc tải trang Web Khi muốn xem tiếp trang khác 

 
Nạp lại trang Web 

Khi đang dừng mà muốn tải lại trang 

đó 
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Trở về trang khởi tạo 

Đang ở trang bất kỳ muốn về trang 

đầu tiên 

 
Tìm kiếm Khi không có địa chỉ chính xác 

 

Lưu các địa chỉ trang ưa 

thích 

Không muốn lần sau vào mà phải lại 

gõ lại địa chỉ 

 
Lưu các trang Web đã vào Đọc lại khi không kết nối 

 

Gửi và nhận thư chính 

chủ 
  

 
In các trang Web   

Quay trở lui 

Để quay lại trang đầu chúng ta có thể thực hiện các cách sau: 

- Nháy chuột vào nút Back liên tục cho đến khi chúng ta đạt được trang khởi đầu 

(Để dùng tính năng này chúng ta cũng có thể sử dụng tổ hợp phím ALT và mũi tên 

sang trái). Bằng cách này chúng ta sẽ quay trở lại nơi chúng ta khởi đầu hoặc là các 

trang trước đó nhưng cách này chậm, tương đối mất nhiều thời gian nếu chúng ta đã 

duyệt qua rất nhiều trang. 

- Nháy vào hình mũi tên trỏ xuống bên cạnh nút lệnh Back chúng ta sẽ thấy một 

danh sách bảng chọn thả xuống hiển thị danh sách các trang chúng ta muốn chuyển 

tới 

- Nháy chuột vào nút lệnh Home (hoặc chọn Home Page trong bảng chọn Go) chúng 

ta sẽ quay trở lại trang Web khởi đầu chúng ta sử dụng IE. 

Tiến về trước 

Một điều mọi người thường hay nhầm lẫn khi sử dụng IE đó là nút lệnh 

Forward (hoặc chúng ta có thể sử dụng tổ hợp phím Alt và mũi tên sang phai cũng 

như là sử dụng lệnh Forward trong bảng chọn Go). Trong phần trước chúng ta nháy 

chuột vào các siêu liên kết sau đó chúng ta sử dụng nút lệnh Back để quay về các 

trang trước đó chúng ta muốn trở lại. Nếu chúng ta đã sử dụng lệnh Back chúng ta 

hãy thử sử dụng nút lệnh Forward, chúng ta sẽ thấy điểm Web mà chúng ta vừa từ 

đó quay lại sẽ được hiển thị. 

Tránh nhầm lẫn chúng ta có thể tham khảo tính năng của hai nút lệnh Back và 

Forward: 
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Back: Nháy chuột vào nút Back để xem tài liệu mà chúng ta vừa từ đó chuyển tới 

thông qua một siêu liên kết. Nếu chúng ta vẫn giữ nút lệnh Back chúng ta sẽ tiếp tục 

chuyển ngược lại một loạt các trang mà chúng ta đã chuyển tới trong phiên làm việc 

này. Khi nút lệnh Back trở thành màu xám và không thể dùng được chúng ta đã 

chuyển tới trang đầu tiên chúng ta thấy trong phiên làm việc này. Để chuyển lui tới 

một điểm xác định, chúng ta chỉ đơn giản nháy vào mũi tên trỏ xuống bên cạnh nút 

lệnh Back sau đó chúng ta chọn trang chúng ta muốn chuyển tới trong danh sách các 

trang trong bảng chọn thả xuống vừa hiện ra. 

Forward: Chọn nút lệnh Forward để chọn lại điểm mà chúng ta vừa từ đó tới. Nếu 

trong trường hợp chúng ta chưa dùng nút lệnh Back nút lệnh Forward sẽ không có 

tác dụng và nó sẽ được hiển thị dưới trạng thái hình mờ, Cũng giống như với nút 

lệnh Back chúng ta có thể chọn mũi tên thả xuống cạnh nút lệnh Forward để hiển thị 

danh sách bảng chọn các điểm chúng ta đã trở lui từ đó. Việc này sẽ làm tiết kiệm 

thời gian cho chúng ta 

Sử dụng thanh History Explorer 

Để hiển thị thanh History Explorer chúng ta nháy vào nút lệnh History trên thanh 

công cụ chuẩn hoặc chuyển tới bảng chọn View, chọn lệnh Explorer Bar, sau đó 

chọn lệnh History. Khi đó cửa sổ vùng làm việc sẽ chia đôi, thanh history Explorer 

xuất hiện ở bên trái vùng làm việc. Đây thực sụ là một tính năng khá hữu ích. Danh 

sách được liệt kê trong phần 1/4/99 là tất cả các điểm mà chúng ta đã truy xuất trong 

ngày 4-1-99. Khi chúng ta chọn một điểm bất kì IE sẽ mở rộng điểm đó, liệt kê tất 

cả các tài liệu các trang chúng ta đã truy nhập trong phiên bản làm việc trước đó... 

2.2.Tìm hiểu các địa chỉ trang web 

STT Domain Mô tả 

1 com Các tổ chức thương mại doanh nghiệp 

2 edu Các tổ chức giáo dục 

3 gov Các tổ chức chính phủ 

4 Int Các tổ chức quốc tế 

5 Mil Các tổ chức quân sự 

6 Net Một mạng không thuộc các loại phân vùng khác 

7 Org Các tổ chức không thuộc một trong các loại trên 

Các trang web của một số trường Đai học 

Đại học Bách khoa HCM  www.hcmut.edu.vn 

Đại học Bách khoa Hà Nội      www.hut.edu.vn 

Đại học Cần Thơ             www.ctu.edu.vn 

Học Viện BCVT             www.ptit.edu.vn 

Các Website phổ biến nhất 

 Việt Nam Net     www.vnn.vn 

 VNN Sài gòn   saigon.vnn.vn 

 VNN Đà Nẵng   danang.vnn.vn 

 ------------------------------------------------------------------------ 

http://www.ptit.edu.vn/
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 FPT Hà Nội               www.fpt.vn 

 FPT Sài gòn              www.hcm.fpt.vn 

 ------------------------------------------------------------------------ 

  Phương Nam Net           www.tlnet.com.vn 

  SaiGon Net            www.saigonnet.vn 

Các báo-Truyền hình 

 Sài gòn giải phóng             www.sggp.org.vn 

 Người lao động               www.nld.com.vn 

 Tuổi trẻ   www.tuoitre.com.vn  

 Thanh niên              www.thanhnien.com.vn 

 Báo ảnh Việt Nam     vnagency.com.vn 

 Sài gòn   www.htv.com.vn 

 Hà Nội   www.vtv.org.vn 

Các địa phương 

 Sài gòn             www.hochiminhcity.gov.vn 

 Hà Nội               www.thudo.gov.vn 

 Hải Phòng                       www.haiphong.gov.vn 

 Huế                        www.huevietnam.com 

 Đà Nẵng            www.danang.gov.vn 

 Cần Thơ            www.cantho.gov.vn 

Các tạp chí tin học-máy tính 

 Tin học & Nhà trường   www.thnt.com.vn 

 Công ty T&H       www.tnt.com.vn 

 Vi tính Sài gòn     www.vtsaigon.com 

 IT Park    www.itpark.com.vn 

 Internet Today                www.vnn.vn/i-today 

Mua bán-thương mại-đi chợ 

 Quảng cáo                  vnwebshop.com 

 Rao vặt ĐTDD       www.raovatdtdd.com 

 Giá cả         bttt.vasc.com.vn 

 Mua sắm                 www.webmuasam.com 

 Mua sắm        www.24hoursn.com  

 Siêu thị                  www.vietnambook.com.vn 

 Thương xá                  www.thuongxavn.com 

 Hoa                  www.hoaxinh.com 

 Rao vặt                 www.webraovat.com 

 Siêu thị      vdcsieuthi.vnn.vn 

 Tranh                           www.bachvangallery.com 

 www.tuviglobal.com 

 TUVI.vietshare.com 

 www.thuongviet.com 

 www.tamlinh.net 

 www.trochoiviet.com 

 www.nghenhac.go.to 

 www.webduhoc.com 

http://www.saigonnet.vn/
http://www.sggp.travel-vn.com/
http://www.vtv.org.vn/
http://www.cantho.gov.vn/
http://www.vnn.vn/i-today
http://www.vietnambook.com.vn/
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 www.vietnamwebsite.net 

3.Cài đặt trình duyệt internet Explorer 

Thông số để cấu hình ADSL Router 

Kết nối vào mạng VDC: 

WAN Configuration 

VPI: 8 

VCI: 35 

ENCAPSULATION: PPPoE LCC 

User name: tên truy nhập 

Password: mật khẩu 

Kết nối vào mạng FPT: 

WAN Configuration 

VPI: 0 

VCI: 33 

ENCAPSULATION: PPPoE LCC 

User name: tên truy nhập 

Password: mật khẩu 

 Kết nối vào mạng Viettel: 

WAN Configuration 

VPI: 8 

VCI: 35 

ENCAPSULATION: PPPoE LCC 

User name: tên truy nhập 

Password: mật khẩu 

 

Trong phần TCP/IP setting của máy trạm chúng ta chỉ cần add thêm thông tin sau 

Default Gateway: 10.0.0.2 (địa chỉ IP của router) 

Preferred DNS Server: 203.162.4.190 (VDC) / 210.245.31.130 (FPT) / 

203.113.131.1 (Viettel) 

Alternate DNS Server: 203.162.4.191 (VDC) / 210.245.31.10 (FPT) / 203.113.131.2 

(Viettel) 

Trên đây là những thông số thiết yếu nhất để chúng ta có thể sử dụng internet, còn 

sau đây là một số thông tin thêm tuỳ theo nhu cầu sử dụng các chúng ta có thể dùng 

hay không là tuỳ ý: 

Để router tự động cấp IP cho các máy trạm(DHCP Server): 

LAN Configuration 

IP Address: 10.0.0.2 

Subnet mask: 255.0.0.0 

DHCP Server: Enable 

User Defined Start Address: 10.0.0.4 

User Defined End Address: 10.0.0.254 

DNS Configuration 

Preferred DNS Server: 203.162.4.190 (VDC) / 210.245.31.130 (FPT) / 

203.113.131.1 (Viettel) 
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Alternate DNS Server: 203.162.4.191 (VDC) / 210.245.31.10 (FPT) / 203.113.131.2 

(Viettel) 

Sau khi cấu hình router theo như trên đây trong phần TCP/IP settings của các máy 

trạm không cần phải khai báo gì cả, cứ chọn Obtain an IP Address Automatically và 

Obtain DNS Server Address Automatically là xong. 

Để dùng được các ứng dụng khác như Web Server, FTP Server, Mail Server, VPN 

Server các chúng ta add các port dưới đây trỏ tới IP của máy chủ: 

Virtual Server Configuration 

Port: 80 Type: TCP (Web Server) 

Port: 443 Type: TCP (Https) 

Port: 21 Type: TCP (FPT Server) 

Port: 1723 Type: TCP (VPN) 

Port: 1701 Type: TCP (VPN) 

Port: 47 Type: TCP (VPN) 

Port: 25 Type: TCP (SMTP) 

Port: 110 Type: TCP (POP3) 

Modem Router ADSL Billion 

Các thành phần bên ngoài của Router ADSL Billion : 

Mặt trước của Modem Router ADSL Billion : 

Mặt trước của Router gồm 5 đèn tín hiệu: tương ứng thứ tự từ trái sang phải như 

sau:  

 

Sau khi cắm modem vào máy tính, HUB, hoặc Switch tiến hành kiểm tra các 

đèn tín hiệu trên modem. 

POWER: Đèn nguồn – sáng. 

SYS: Đèn hệ thống - sáng. 

LAN: Đèn tín hiệu của LAN – sáng. 

ADSL: Đèn tín hiệu của ADSL – sáng 

PPP: Đèn trạng thái kết nối – sáng 

Đèn LAN : Nếu sáng xanh tức chúng ta có gắn vào cổng Ethernet (RJ45 port), 

nếu tắt chúng ta không gắn vào cổng Ehternet.  

Đèn SYS : Nếu đèn sáng xanh thể hiện modem ổn định. 
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Đèn PPP : Nếu sáng xanh thể hiện việc modem đã kết được Internet. 

Đèn ADSL : Nếu sáng xanh tức đã đồng bộ tín hiệu ADSL, nếu nhấp nháy hoặc 

tắt chúng ta nên kiểm tra lại đường sử dụng ADSL.  

Đèn Nguồn : Nếu sáng xanh tức chúng ta đã cắm nguồn. Lưu ý các modem nên 

cắm qua Ổn áp thì dòng điện mới ổn định và không bị mất tín hiệu hoặc mất 

mạng. 

Mặt sau của Modem Router ADSL Billion : 

 

PWR: Điểm cắm nguồn . 

RESET: Nút reset về tham số chuẩn của nhà sản xuất  

LAN: Điểm cắm đầu dây Ethernet (RJ45 port) 

LINE : Điểm cắm đầu dây tín hiệu ADSL. 

Lắp đặt và cấu hình Modem Router ADSL Billion qua cổng RJ45 cho 1 máy 

tính:  
- Cắm nguồn cho Router và cắm đầu dây ADSL vào cổng RJ11 (cổng ADSL) 

của Router bằng cách nối dây điện thoại từ ngoài vào cắm qua bộ tách tín hiệu 

(dây chung thoại), 1 đầu ra tín hiệu ADSL cắm vào cổng RJ11 của modem, 1 

đầu ra còn lại cắm vào máy điện thoại. 

- Nối dây mạng (straight-through ethernet cable RJ45) từ cổng RJ45 của Router 

đến cổng RJ45 card mạng của máy tính (xem hình ). 

-  

 

Lắp đặt Modem Router ADSL Billion cho nhiều máy dùng chung Internet 

trong mạng LAN: Cắm nguồn cho Router và cắm đầu dây ADSL vào cổng 

RJ11 (cổng ADSL) của Router bằng cách nối dây điện thoại từ ngoài vào cắm 

qua bộ tách tín hiệu (dây chung thoại), 1 đầu ra tín hiệu ADSL cắm vào cổng 

RJ11 của modem, 1 đầu ra còn lại cắm vào máy điện thoại. 

- Nối dây mạng (cable RJ45) từ cổng RJ45 của Router đến cổng RJ45 
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Hub/Switch. 

  

 

Cấu hình Modem Router ADSL Billion:  
Bước 1: Để vào cấu hình Router chúng ta mở Internet Explorer và gõ địa chỉ 

http://192.168.1.254 

Bước 2: Nhập UserName và password (mặc định User name: admin; Password: 

password) 

 

 

 

 

 

Bước 3: Cấu hình chung để dùng Internet 

 

- Nhấp vào menu Wizard Setup, điền các thông số sau: 

- Mode: Routing 

- Encapsulation: PPPoE 

http://www.ptic.com.vn/dichvu_mega_modem8.asp#1#1
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- Multiplex: LLC 

- VPI: 0 

- VCI: 35  

- Nhấp vào nút Next 

Bước 4: Nhập tên truy nhập (User Name) và mật khẩu (Password) sử dụng 

rồi nhấp vào nút Next 

 

Bước 5: Kiểm tra lại các thông số rối nhấp vào nút Apply.  

 

Bước 6: Tiếp theo chọn nút Start Diagnose để kiểm tra cấu hình. Chờ khoảng 

20 giây để Router kiểm tra lại cấu hình. Nếu tất cả đều hiện Pass hết tức là đã 
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cấu hình đúng nếu Fail kiểm tra lại (Bước 3,4). Sau đó nhấp vào nút RESTART 

để ghi lại toàn bộ cấu hình. 

 

Bước 7: Kiểm tra kết nối Internet:  
Vào mục Maintenance, chọn System Status (xem hình). 

 

Nếu thấy trạng thái của WAN có địa chỉ IP (ví dụ: 222.252.41.149) thì modem 

đã kết nối vào Internet, nếu là không thấy có địa chỉ IP của WAN cần kiểm tra 

lại các thông số (Bước 3,4). 

Bước 8: Cấu hình địa chỉ IP gateway cho mạng LAN: 

Cấu hình mặc định địa chỉ IP gateway là 192.168.1.254/255.255.255.0 

Nếu thay đổi IP tại Advanced Setup chúng ta nhấp vào LAN (xem hình ). 
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Thay đổi địa chỉ IP theo ý muốn, nếu chúng ta muốn Router làm server DHCP 

thì chọn Server. 

Bước 9: Nhấp vào nút Apply tiếp theo nhấp vào nút OK để ghi lại cấu hình. 

 

Bước 10: Đặt lại mật khẩu vào modem Router:  

Trong mục Advanced Setup nhấn vào Password (xem hình), nhập mật khẩu 

cũ, nhập mật khẩu mới và nhập lại mật khẩu một lần nữa tại Retype to Confirm 

tiếp theo nhấp vào nút Apply để ghi lại sự thay đổi mật khẩu. 
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Bước 11: Cấu hình máy các con để sử dụng chung Internet qua Router: 
Giả sử có mạng Lan với địa chỉ IP như sau 192.168.1.0/255.255.255.0 định cấu 

hình kết nối mạng theo từng hệ điều hành như sau: 

Win9x/Me: Control Panel --> Networking --> General --> TCP/IP --> 

Properties --> Gateway --> New Gateway, nhập địa chỉ IP 192.168.1.254 và 

chọn Add, tại DNS Configuration nhập vào 203.162.0.181 và nhấp nút Add sau 

đó nhập 203.210.142.132 và Add.  

WinNT: Chúng ta vào Control Panel --> Network --> Protocol --> General --> 

TCP/IP --> Properties, tại Default Gateway gõ địa chỉ IP 192.168.1.254 vào, 

tại DNS nhấp vào nút Add nhập 203.162.0.181 và 203.210.142.132 và nhấp nút 

Add 
Win2000/XP: Control Panel --> Network Connections --> Local Area 

Connection --> General --> Internet Protocol(TCP/IP) -->Properties, tại Default 

gateway nhập địa chỉ IP 192.168.1.254 vào, tại Primary DNS Server gõ 

203.162.0.181, tại Secondary DNS Server gõ 203.210.142.132 

Kiểm tra địa chỉ Ip của máy con, Ip Gateway và ping đến DNS server : Chọn 

Start-Run gõ lệnh CMD, xuất hiện dấu nhắc mời đánh lệnh : Ipconfig rồi Enter 

sẽ thấy các địa chỉ Ip của máy, gateway, DNS. Sau khi về dấu nhắc mời gõ tiếp 

lệnh : ping 203.162.0.181 hoặc 203.210.142.132 nếu thấy Reply from 

203.162.0.181 : byte = … thì đã kết nối được Internet. 

 

Bước 12: Cấu hình các ứng dụng dùng chung Internet 

- Internet Explorer: Cotrol Panel --> Internet Options --> Connections, 

chọn Never dial a connection. Chú ý không dùng Proxy.  

- Yahoo Messenger: chọn Preference --> Connection --> No Proxy  

Bước 13 (tuỳ chọn): Khởi tạo lại thông số cho modem về các thông số chuẩn 

của nhà sản xuất: 

Trong trường hợp quên mật khẩu của modem Router hoặc cấu hình sai, có thể 

khôi phục lại cấu hình mặc nhiên của nhà sản xuất: Cắm nguồn cho Router sau 

đó dùng một que nhỏ (paper clip duỗi thẳng) ấn nhẹ vào nút Reset đằng sau 

Router sau đó tắt nguồn của Router và bật nguồn cho Router lại, bây giờ Router 

của chúng ta đã được Reset về chuẩn của nhà sản xuất.  
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Trình duyệt web 

Web browser (trình duyệt Web) là chương trình để xem các tài liệu Web. Trình 

duyệt Web gửi các URL tới Web server sau đó nhận trang Web từ Web server dịch 

và hiển thị chúng. Khi giao tiếp với Web server thì Web browser sử dụng giao thức 

HTTP. Khi giao tiếp với một Gopher server thì Web browser hoạt động như một 

Gopher client và sử dụng giao thức gopher còn khi giao tiếp với một FTP server thì 

Web browser hoạt động như một FTP client và dùng giao thức FTP. Web browser 

có thể thực hiện các công việc khác như ghi trang Web vào đĩa, gửi E-mail, tìm kiếm 

xâu ký tự trên trang Web, hiển thị tệp HTML nguồn của trang Web, v.v... Hiện nay 

có hai chương trình Web browser được sử dụng nhiều nhất là Netscape Navigator 

của Netscape Corp. và Internet Explorer của Microsoft Corp. 

Web server là phần mềm phục vụ các yêu cầu trang Web được cài đặt trên máy chủ 

(server). Web server thường chờ các yêu cầu của khách hàng được gửi tới và sau đó 

nó có thể lấy các trang Web tĩnh hoặc tạo ra các trang Web động để trả về cho khách 

hàng. 

4.Truy cập website 

4.1 . Khởi động và kết thúc Mozilla FireFox 

Giả sử chúng ta nhập vào địa chỉ sai hoặc địa chỉ điểm Web chúng ta không cần 

hoặc chúng ta không muốn tải nạp xuống các phần của tài liệu chúng ta đang hiển 

thị. Chúng ta muốn ngừng việc này lại. Để làm được việc này, chúng ta đơn giản 

chỉ cần nháy vào nút lệnh Stop (hoặc nhấn nút Esc) 

4.2. Duyệt web từ FireFox 

5. Lưu trữ trang web hiện hành 

5.1 . In trang web hiện hành 

*Thiết kế một trang in 

Chọn File 

Chọn Page setup. Xuất hiện màn hình 
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*Xác định Header and footer 

Internet Explore có thể in các tiêu đề đầu trang và tiêu đề cuối trang theo các cách 

sau: 

- Left header – Tiêu đề sẽ nằm ở đầu trang. Theo định sẵn vùng này chứa Title của 

tài liệu. 

- Center header – Tiêu đề sẽ nằm ở giữa và trên đầu trang. Theo định sẵn thì vùng 

này trắng 

- Right header – Tiêu đề sẽ nằm ở bên phải ở trên đầu trang. Theo định sẵn thì vùng 

này chứa số trang của tài liệu 

- Left footer – Tiêu đề sẽ nằm về bên trái ở phía dưới của trang. Theo định sẵn vùng 

này chứa ngày tháng của tài liệu 

- Center footer – Tiêu đề sẽ nằm ở giữa và phía dưới của trang. Theo định sẵn thì 

vùng này trắng. 

- Right footer – Tiêu đề sẽ nằm ở chính giữa ở phía dưới trang. Theo định sẵn thì 

vùng này chứa thời gian in tài liệu. 

Chúng ta có thể sử dụng các mã đặc biệt để lấy các thông tin hiện nay từ tài 

liệu(chẳng hạn như số trang) hay là từ hệ thống (chẳng hạn như ngày, giờ). Các mã 

sau đây sẽ bắt đầu bằng dấu & theo sau một ký tự. Chú ý rằng chữ hoa hay chữ 

thường rất quan trọng. Bằng cách sử dụng các mã này thì chúng ta có thể in các tiêu 

đề theo ý mình: 

Nhập vào          Sẽ in ra 

&w                Tựa đề của tài liệu giống như khi nó xuất hiện trong thanh tựa đề. 

&u                 Địa chỉ của trang 

&d                 Ngày hiện nay ở dạng tắt xác định trong Regional Setting/Control 

Panel 

&D                Ngày hiện nay ở dạng đầy đủ xác định trong Regional Setting/Control 

Panel 

&t                  Giờ hiện nay ở dạng xác định trong Regional Setting/ Control Panel 
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&T                 Giờ hiện nay theo dạng 24 giờ 

&p                 Số trang 

&P                 Tổng số trang 

&&                 Một dấu & 

&b                 Vị trí xác định 

Dấu cuối cùng (&b) cho phép chúng ta xác định mục đã cho sẽ in ở header hay ở 

footer. Sau đây là cách thức làm việc của nó: 

- Nếu chúng ta sử dụng mã này chỉ một lần thì phần bên trái của &b sẽ in ở bên trái 

còn phần ở bên phải sẽ in ở bên phải. 

Chẳng hạn, &w&b&p sẽ in tựa đề của tài liệu ở bên trái còn số trang sẽ in ở bên 

phải. 

- Nếu chúng ta sử dụng mã này hai lần thì phần bên trái của &b thứ nhất sẽ in ở bên 

trái, phần ở giữa hai &b sẽ in ở chính giữa và phần ở bên phải của &b sẽ in ở bên 

phải. 

Chẳng hạn, &d&b&p&b&t sẽ in ngày hiện nay ở bên trái, trang ở chính giữa và in 

thời gian hiện nay ở bên phải. 

- Chúng ta cũng có thể kết hợp văn bản và mã. Chẳng hạn nếu chúng ta gõ Page %p 

of &P thì Internet explore sẽ hiện trang hiện nay trên tổng số trang: Page 7 of 10.  

* In tài liệu 

-    Chọn File, chọn Print hoặc ấn Ctrl + P. Màn hình xuất hiện: 

 

Duyệt trong chế độ không kết nối (Offline) 

Nếu chúng ta muốn duyệt các trang Web mà chúng ta đã duyệt qua trước đó mà 

không kết nối tới Internet làm theo các bước sau: 
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Chọn lệnh File trên bảng chọn. 

Chọn lệnh Work Offline trong bảng chọn thả xuống. 

Trong thanh History Explorer chọn điểm chúng ta muốn truy nhập. 

Cách làm việc của IE: Khi chúng ta chọn Work Offline IE sẽ không kết nối vào 

mạng để kiểm tra xem thực sự trang Web đó đã thay đổi hay chưa. Thay vào đó nó 

tải nạp bản sao của tài liệu đã được tạo ra trên ổ đĩa của chúng ta khi chúng ta lần 

đầu tiên tải nạp trang đó. Khi chúng ta chọn Work Offline lựa chọn này sẽ giữ lại 

cho đến khi chúng ta chọn lại Work Offline trên bảng chọn File để loại bỏ đánh dấu 

cho lựa chọn này. 

5.2.  Lưu trang web hiện hành 

Lưu giữ trang Web quan tâm vào Favorite 

Bên cạnh chức năng duyệt Web, IE còn cho phép người dùng có thể lưu lại 

địa chỉ của các trang Web cần quan tâm kiểu như các Album. Người dùng có thể 

cũng tạo các thư mục riêng để lưu giữ địa chỉ trang Web theo chủ đề. 

Để đưa địa chỉ của trang Web hiện tại vào Favorite, người dùng chỉ cần đơn 

giản chọn mục menu Favorites\Add to Favorite... Cửa sổ Add Favorite hiện ra cho 

phép người dùng nạp địa chỉ trang Web hiện tại vào sưu tập 

 

Lưu lại trang Web hiện tại vào sưu tập 

Để tạo mới một thư mục lưu giữ địa chỉ của trang Web, người dùng chỉ cần bấm nút 

New Folder. Cửa sổ Create New Folder hiện ra cho phép người dùng nhập vào tên 

của Folder lưu giữ. 
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Cửa sổ tạo Folder lưu giữ trong Favorite 

Các địa chỉ lưu giữ trong Favorite được tổ chức dưới dạng cây phân cấp. Để thuận 

tiện cho việc quản lý các Folder trong Favorite, IE cho phép người dùng có thể tổ 

chức lại cấu trúc các thư mục lưu giữ địa chỉ trang Web thông qua cửa sổ Organize 

Favorites. Người dùng chọn mục menu Favorite\Organize Favorites... 

 

Tổ chức cây thư mục Favorite 

Thay đổi các tính chất của IE5 

 

Thay đổi các tính chất chung của IE 
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Trong phần Home page người dùng có thể nhập vào địa chỉ trang Web bất kỳ 

khác. Địa chỉ này sẽ được xem là địa chỉ Home, và người dùng có thể chuyển tới 

trang Web này một cách nhanh chóng thông qua việc kích chuột vào nút  trên 

thanh ToolBar. 

Khi tải các trang Web về máy tính của người sử dụng, IE sẽ lưu lại một số 

trang Web vừa mới hiển thị trong phần nháp của mình để nâng cao tốc độ duyệt 

Web. Trong trường hợp người dùng xem lại trang Web vừa mới xem qua, IE sẽ lấy 

luôn trong bản nháp của mình thay vì tải lại từ Internet. Để tăng tính bảo mật và 

xóa hết dấu vết, người dùng có thể bấm nút   và nút  trước 

khi thoát khỏi IE. 

Thiết lập các chế độ bảo vệ trong IE 

 

Thiết lập chế độ bảo vệ trong IE 

Người dùng có thể tự điều chỉnh lại chế độ bảo vệ của trình duyệt để tránh việc tải 

về những thứ không cần thiết từ Internet nhất là Virus. 
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Thiết lập các tùy chọn bảo vệ 

Cách đơn giản nhất là người dùng sử dụng ngay chính một trong số các tùy chọn 

bảo vệ có sẵn trong IE. 

 6.Quản lý mail 

Ngoài việc gửi và nhận thư điện tử, Outlook Express còn cung cấp một sổ 

danh bạ địa chỉ cho phép người dùng có thể lưu lại các địa chỉ nói chung của bất kỳ 

một cá nhân hay tổ chức nào đó. 

 

Sổ danh bạ địa chỉ 

Thêm mới địa chỉ của một cá nhân vào danh bạ 

Để thêm mới địa chỉ vào danh bạ, người dùng chọn mục File\New contact. 

Một cửa sổ Properties hiện ra cho phép người dùng nhập vào các thông tin về một 

cá nhân hay tổ chức nào đó.  
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Lưu thông tin về một cá nhân 

Chọn nút Add để nạp các thông tin đã khai báo vào danh sách địa chỉ lưu giữ trong 

máy tính. 

Người dùng lặp lại các thao tác khai báo thông tin và Add để đưa thêm nhiều địa chỉ 

khác nhau vào danh sách lưu giữ. 

Để loại bỏ địa chỉ của một cá nhân ra khỏi danh sách, người dùng chỉ cần chọn địa 

chỉ cần loại bỏ rồi bấm nút Remove. 

Nhóm liên hệ trong danh bạ 

Người dùng cũng có thể tạo các nhóm liên hệ trong sổ danh bạ. Việc làm này 

rất hữu dụng khi người dùng muốn gửi các thông điệp đến nhiều người trong nhóm 

mà không cần thiết phải nạp vào địa chỉ của từng người trong nhóm, Outlook Express 

thực hiện công việc này thay cho người dùng. 

Thêm mới một nhóm liên hệ 

Người dùng chọn mục menu File\New Group để thêm mới một nhóm. 

Cửa sổ properties cho phép người dùng nhập vào thông tin của nhóm. 
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Cửa sổ properties quản lý nhóm 

Mỗi nhóm có một tên nằm trong phần Group Name và có một danh sách các thành 

viên trong nhóm Group Members. 

Người dùng có thể bấm nút Select Members để đưa các thành viên vào nhóm và 

bấm nút Remove để loại bỏ thành viên khỏi nhóm. 

 

Cửa sổ thêm mới thành viên vào nhóm 

Tìm kiếm địa chỉ có trong danh bạ 

Outlook Express cho phép người dùng có thể dễ dàng tìm kiếm địa chỉ của một cá 

nhân nào đó trong sổ danh bạ. 

Người dùng có thể tìm kiếm địa chỉ một cách chính xác hay gần chính xác. Người 

dùng cũng có thể tìm kiếm địa chỉ căn cứ theo một hoặc nhiều loại thông tin khác 

nhau như: tên gọi, số điện thoại, địa chỉ,... 
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Gửi thư cho một người hay một nhóm trong danh bạ 

Với việc lưu giữ các địa chỉ trong sổ danh bạ của Outlook Express. Mỗi khi muốn gửi 

thư cho một cá nhân hay một nhóm trong sổ địa chỉ, người dùng chỉ việc Kích chuột vào 

nút  hoặc  trong phần đầu đề của bức thư đang soạn thảo. Cửa sổ Select 

Recipients cho phép người dùng có thể lựa chọn địa chỉ cá nhân hay nhóm để gửi tới. 

 

Lựa chọn các địa chỉ gửi thư 

Một cách khác nhanh và đơn giản hơn, người dùng có thể Kích đúp chuột vào địa 

chỉ của một cá nhân hay một nhóm trong màn hình Contacts 

 

Màn hình Contacts chứa các địa chỉ có trong danh bạ 

 

Bài tập và sản phẩm thực hành bài 07.2 

 

Kiến thức: 

Câu 8: Tìm kiếm vào download một trình điều khiển VGA card bất kỳ. 

Câu 9: Tìm kiếm những webside liên quan đến lĩnh vực nói về thiết bị tin học 

(lĩnh vực phần cứng)  

Kỹ năng: 

Bài tập ứng dụng:  Tìm kiếm bằng Yahoo: 
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 + Tìm kiếm theo tên(Bằng một từ) 

Mở trang web có URL : http://www.yahoo.com 

Trong trường hợp Search, nhập StarTrek, Rock Music 

Nhấp chọn Advanced Search 

Dưới Select a Search Method, chọn An Exact Phare math 

Dưới select a Area, chon website 

Rong phần lựa chọn;” Find only new listings added during the past” hãy chọn chỉ 

tìm kiếm các danh sách mới thêm vào trong suốt một tháng qua. 

 

+ Tìm kiếm phân loại: 

Mở một trang web co URL : www.yahoo.com 

Cuộn xuống đến danh sách có hạng mục của yahoo 

Nhấp vào siêu liên kết Entertainment 

Chọn một trong các mục của Movies, TV, Game, Music và Astrology. 

Cuộn xuống dưới cho đến khí nhìn thấy thi chọn nó. 

StarTrek là một buổi chiếu phim khoa khọc viễn tưởng. 

http://www.yahoo.com/
http://www.yahoo.com/
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CHỈ DẪN ĐỐI VỚI HỌC SINH THỰC HIỆN BÀI TẬP ỨNG DỤNG 

 

1. Bài tập ứng dụng phải thực hiện đúng trên máy tính giáo viên giao cho. 

2. Kiểm tra các ứng dụng chạy trên máy tính và hướng dẫn sử dụng trước khi 

thực hiện lệnh. 

3. Thực hiện đầy đủ các bước chuẩn bị khi thực hiện lệnh khai thác web qua 

mail . 

4. sử dụng ứng dụng theo qui định và thao tác đúng các lệnh. 

5. Tổng điểm và kết cấu điểm của các bài như sau: 

Tổng số điểm tối đa cho bài: 100 điểm, kết cấu như sau: 

a, Phần thực hành khi thực hiện : Tổng cộng 70 điểm 

b, Phần chính xác và nhanh chóng : 30 điểm 

- Thời gian thực hiện bài tập vượt quá 25% thời gian cho phép sẽ không được 

đánh giá. 

- Thí sinh phải tuyệt đối tuân thủ các qui định an toàn lao động, các qui định của 

xưởng thực tập, nếu vi phạm sẽ bị đình chỉ thực tập 

Đánh giá kết quả học tập 

 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

người 

học 

I Kiến thức    

1 Các câu lệnh dùng để vào 

mail. 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

1  

1.1 Liệt kê đầy đủ các mục trong 

mail 
0,5  

1.2 Liệt kê đầy đủ các cú pháp 

lệnh trong mail 
0,5  

2 Chức năng, nguyên lý làm 

việc của màn hình IE 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

2.1 Nêu đầy đủ cấu tạo của màn 

hình IE 
0,5  

2.2 Trình bày công dụng và  

nguyên lý làm việc của các 

lệnh trong mail.  

1  

2.3 Trình bày đúng cách thực hiện 

các lệnh. 
0,5  
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3 Phạm vi ứng dụng của IE,mail 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

3.1 Nêu đúng thực chất của 

IE,mail 

 

1  

3.2 Trình bày đầy đủ đặc điểm của 

mail 

0,5  

3.3 Nêu đúng phạm vi ứng dụng 

của các lệnh trong IE,mail 

 

0,5  

4 Trình bày màn hình và cách 

thuwch hiện lệnh 

 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

1,5  

5 Chọn chế độ làm việc và cách 

thực hiện lệnh hợp lý. 

Làm bài tự luận 

và trắc nghiệm 

đối chiếu với nội 

dung bài học 

1,5  

5.1 Nêu cách chọn lệnh phù hợp 0,5  

5.2 Trình bày đúng cách thực hiện 

lênh.  

0,5  

5.3 Trình bày cách chọn đường 

dẫn đến lệnh chính xác 

0,5  

6 Trình bày đúng kỹ thuật thực 

hiện lệnh 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 
2 

 

                                      Cộng: 10 đ  

II Kỹ năng    

1 Nhận biết một số giao diện của 

IE 

Quan sát hình 

ảnh, đối chiếu 

với nội dung bài 

học để nhận biết 

2 

 

2 Vận hành thành thạo một số 

lệnh trong IE. 

Quan sát các thao 

tác, đối chiếu với 

quy trình vận 

hành 

3 

 

3 Nhận biết và sử dụng các loại 

lệnh phụ trợ trong mail một 

cách  thành thạo 

Quan sát hình 

ảnh, ký hiệu các 

loại lệnh đối 

chiếu với nội 

2 
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dung bài học để 

nhận biết 

4 Phân biệt và phân loại các loại 

lệnh trong mail. 

Quan sát các 

lệnh, đối chiếu 

với nội dung bài 

học để nhận biết 

3 

 

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp khi vẽ Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1,5  

1.2 Không vi phạm nội quy lớp học 1,5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 

với thời gian quy 

định. 

2 

 

3 Đảm bảo an toàn thực hành và 

vệ sinh công nghiệp 
Theo dõi việc 

thực hiện, đối 

chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 

khi thực hiện lệnh trong mail  
1,5 

 

3.2 Đầy đủ bảo hộ lao động( quần 

áo bảo hộ, giày, thẻ học sinh…) 
1,5 

 

3.3 Vệ sinh phòng máy thực hành  

đúng quy định 
1 

 

                              Cộng: 10 đ  

 

 

 

 

 

 

 

 

KẾT QỦA HỌC TẬP 
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Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

                                                                                              

Cộng: 
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BÀI 3: TỔNG QUAN VỀ PHẦN MỀM XỬ LÝ VĂN BẢN 

 

Giới thiệu: 

Bộ Microsoft  Office 2003 người sử dụng quen thuộc với thanh menu chuẩn  nằm ở 

phía trên cửa sổ thì Microsoft Word 2010 sử dụng thanh menu theo giao diện 

Ribbon, các chức năng sẽ được chia ra theo từng tab riêng biệt trên menu. Ngoài 

những tính năng cơ bản của phần mềm soạn thảo văn bản nó còn cung cấp cho người 

sử dụng những tính năng giúp người sử dụng có thể giao tiếp với các trình ứng dụng 

khác.  

Mục tiêu:  

- Trình bày được các thao tác căn bản trên một tài liệu. 

- Mô tả được chức năng của các thanh công cụ. 

-   Thực hiện các thao tác an toàn với máy tính. 

Nội dung:  

1. Giới thiệu về Word 2010 

Với thanh menu theo giao diện Ribbon, các chức năng sẽ được chia ra theo từng tab 

trên menu, không hiển thị ra toàn bộ như kiểu menu cũ 2003  

 

 

 

 

Thanh Ribbon có 3 thành phần căn bản:  

1. Tab (thẻ) có 8 Tab cơ bản nằm ngang phía trên, mỗi Tab đại diện cho một vùng 

hoạt động.  

2. Group (nhóm) mỗi Tab bao gồm nhiều Group tập họp các đối tượng có liên 

quan mật thiết với nhau.  

3. Command (lệnh) mỗi Command có thể là một nút, một vùng để nhập nội dung 

hoặc một Menu (trình đơn). Mọi thứ trên một Tab đều được lựa chọn cẩn thận dựa 

trên các hoạt động của người dùng. Ví dụ Tab Home chứa những lệnh có tần suất 

sử dụng nhiều nhất chẳng hạn như các lệnh trong nhóm Font để định dạng văn bản 

như: Font, Font Size, Bold, Italic, v.v... 

2. Các thao tác căn bản trên một tài liệu 

2.1. Tạo mới văn bản 

Thông thường sau  khởi động Word, một màn hình trắng xuất hiện. Đó là tài liệu 

mới mà Word tự động tạo ra. Tạo mới gồm các cách sau đây: 

Hình 3.1: Menu Ribbon trên Word 2010 
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+ Nhấn chuột vào Microsoft Office Button (hoặc Tab File), chọn New, nhấn đúp 

chuột vô mục Blank document. 

+  Nhấn tổ hợp phím tắt Ctrl + N 

Tạo một tài liệu mới từ mẫu có sẵn: Nhấn Microsoft Office Button (hoặc Tab File), 

chọn New. Nhấn nút Create để tạo một tài liệu mới từ mẫu đã chọn. 

 

 

 

 

 

 

 

 

 

 

 

Mặc định lưu tài liệu dạng Word 2003 trở về trước 

Mặc định, tài liệu của Word 2010 được lưu với định dạng là *.DOCX, khác với 

*.DOC  quen thuộc. Với định dạng này, không thể nào mở được trên Word 2003 trở 

về trước nếu không cài thêm bộ chuyển đổi. Để tương thích khi mở trên Word 2003 

mà không cài thêm chương trình, Word 2007 cho phép   lưu lại với định dạng Word 

2003 (trong danh sách Save as type của hộp thoại Save As, chọn Word 97-2003 

Document). 

Muốn Word 2010 mặc định lưu với định dạng của Word 2003,  nhấn Microsoft 

Office Button (hoặc Tab File), chọn Word Options để mở hộp thoại Word Options. 

Trong khung bên trái, chọn Save. Tại mục Save files in this format, chọn Word 97-

2003 Document (*.doc). Nhấn OK. 

 

 

 

 

 

 

 

 

Hình 3.2 : Tạo mới văn bản 
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2.2. Mở một văn bản tạo sẵn 

Tương tự như Word 2007, phím tắt mở tài liệu có sẵn là Ctrl+O.  Chúng ta cũng có 

thể vào Microsoft Office Button (hoặc Tab File), chọn Open. 

 

 

 

 

 

 

 

2.3. Lưu một văn bản đã soạn thảo 

Để ghi tài liệu lên đĩa có các cách sau: 

+ Nhấn Microsoft Office Button (hoặc Tab File), chọn Save. 

+ Nhấn tổ hợp phím Ctrl + S 

2.4. Kết thúc làm việc trong Word 

Khi không làm việc với Word, thực hiện một trong các cách sau: 

+ Mở mục chọn File / Exit 

+ Mở mục chọn File / Close 

+ Nhấn tổ hợp phím Alt + F4   

2.5. Thao tác với chuột và bàn phím 

2.5.1. Thao tác với chuột 

2.5.1.1.  Sao chép dạng văn bản 

Dùng Format Painter (nút hình cây cọ trên thanh công cụ Standard). Chúng ta có thể 

dùng nó để sao chép dạng từ một đoạn văn bản này đến một hoặc nhiều đoạn văn 

bản khác.  

Cách dùng: 

 

Hình 3.4: Mở văn bản tạo sẵn 
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+ Đánh khối văn bản có dạng cần chép 

+ Bấm một lần vào nút Format Painter (nếu muốn dán dạng vào một đoạn văn bản 

khác) hoặc bấm đúp nút (nếu muốn dán dạng vào nhiều đoạn văn bản khác). 

+ Để dán dạng vào những đoạn văn bản nào thì đánh khối chúng là xong (nhấn thêm 

phím Esc để tắt chức năng này  nếu bấm đúp nút Format Painter). 

2.5.1.2. Sao chép hoặc di chuyển dòng hoặc cột trong table 

Trong một table, nếu muốn chép thêm hay di chuyển một hay nhiều dòng hoặc cột 

thì có thể dùng cách kéo và thả bằng chuột như sau: chọn dòng hoặc cột cần chép 

hoặc di chuyển, kéo khối đã chọn (nếu sao chép thì trước đó nhấn giữ phím Ctrl) đặt 

tại vị trí  mong muốn. 

2.5.1.3. Sao chép hoặc di chuyển văn bản 

Sao chép:     

 Chọn khối muốn sao chép 

 Chọn HOME →  Clipboard→ Copy    

 Di chuyển con trỏ đến điểm cần chèn 

 Chọn HOME →  Clipboard→ Paste    

Di chuyển:  

 Chọn khối muốn sao chép 

 Chọn HOME →  Clipboard→  Cut 

 Di chuyển con trỏ đến điểm cần chèn 

 Chọn HOME →  Clipboard→  Paste 

2.5.1.4. Phóng to hoặc thu nhỏ tài liệu 

 Chọn VIEW → Zoom → Nút Zoom 

 Chọn Zoom trong hộp thoại 

 

 

 

 

 

 

 

2.5.1.5. Đánh 

khối toàn bộ tài liệu 

Thực hiện một trong các cách sau: 

+ Chọn HOME→Editing→Select All 

 

Hình 3.5: Hộp thoại phóng to hoặc thu nhỏ tài liệu 
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+ Nhấn tổ hợp phím Ctrl+A 

+ Đưa chuột về lề trái văn bản (mũi tên trỏ chuột sẽ nghiêng về phải) và bấm nhanh 

3 lần  chọn toàn bộ tài liệu.  

2.5.2. Thao tác với bàn phím 

Các phím thường dùng trong Winword gồm các phím: 

Các phím di chuyển con trỏ: 

Phím ↑: Di chuyển con trỏ lên một dòng. 

Phím ↓: Di chuyển con trỏ xuống một dòng. 

Phím →: Di chuyển con trỏ sang phải một ký tự. 

Phím ←: Di chuyển con trỏ sang trái một ký tự. 

Các phím xoá ký tự: 

Phím Delete: Xoá ký tự tại vị trí con trỏ (bên phải con trỏ). 

Phím Backspace: Xoá ký tự liền trái vị trí con trỏ. 

Phím Insert: Để chuyển đổi giữa chế độ chèn (Insert) và thay thế (Overwrite) ký tự. 

Các phím điều khiển: 

Phím Home: Chuyển vị trí con trỏ về đầu dòng văn bản chứa con trỏ. 

Phím End: Chuyển vị trí con trỏ về cuối dòng văn bản chứa con trỏ. 

Phím Page Up: Chuyển vị trí con trỏ lên trên một trang màn hình. 

Phím Page Down: Chuyển vị trí con trỏ xuống dưới một trang màn hình. 

Muốn về đầu văn bản: ấn đồng thời Ctrl+Home. 

Muốn về cuối văn bản: ấn đồng thời Ctrl+End. 

Một số thao tác nhanh trong văn bản với các phím tắt thông dụng 

Ctrl+1:  Giãn dòng đơn (1) 

Ctrl+2:Giãn dòng đôi (2) 

Ctrl+5: Giãn dòng 1,5 

Ctrl+0: (zero) Tạo thêm độ giãn dòng đơn trước đoạn 

Ctrl+Shift+F:  Thay đổi phông chữ 

Ctrl+Shift+P: Thay đổi cỡ chữ 

Ctrl+D: Mở hộp thoại định dạng font chữ 

Ctrl+B: Bật/tắt chữ đậm 

Ctrl+I: Bật/tắt chữ nghiêng 

Ctrl+U: Bật/tắt chữ gạch chân đơn 

Ctrl+A: Lựa chọn (bôi đen) toàn bộ nội dung file 

Ctrl+F: Tìm kiếm k tự 
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Ctrl+G (hoặcF5): Nhảy đến trang số 

Ctrl+H: Tìm kiếm và thay thế ký tự 

Ctrl+]: Tăng 1 cỡ chữ 

Ctrl+[: Giảm 1 cỡ chữ 

Ctrl+W: Đóng file 

Ctrl+Shift+>: Tăng 2 cỡ chữ 

Ctrl+Shift+<: Giảm 2 cỡ chữ 

Ctrl+F2: Xem hình ảnh nội dung file trước khi in 

Alt+Shift+S: Bật/Tắt phân chia cửa sổ Window 

Ctrl+enter: Ngắt trang 

Ctrl+Home: Về đầu file 

Ctrl+End: Về cuối file 

Alt+Tab: Chuyển đổi cửa sổ làm việc 

2.5.3 Chọn khối và thao tác trên khối 

 Chọn khối:  

Thực hiện các cách sau: 

+ Nhắp chuột  từ điểm đầu đến điểm cuối của văn bản cần chọn 

+ Nhắp chuột để đặt con trỏ text ở điểm đầu, giữ Shift và nhắp chuột 

ở điểm cuối của đoạn văn bản cần chọn 

+ Dùng phím Home, End và phím mũi tên trên bàn phím để di chuyển 

con trỏ text đến điểm đầu 

Giữ phím Shift và gõ các phím mũi tên thích hợp để di chuyển con trỏ text đến điểm 

cuối của đoạn văn bản cần chọn 

 Sao chép, di chuyển: 

Lệnh  Biểu tượng Phím tương đương Ý nghĩa 

Cut 

 
 Ctrl + X 

Chuyển đoạn văn bản đã chọn 

vào bộ nhớ Clipboard 

Copy  
Ctrl + C 

 

Chép đoạn văn bản đã chọn vào 

bộ nhớ Clipboard 

Paste 
 

Ctrl + V 

 

Dán đoạn văn bản có trong 

Clipboard vào vị trí con trỏ text 

Đánh dấu chọn đoạn văn bản 

- Vào menu HOME →  Clipboard  chọn Copy hoặc Cut 



 Trang 56  

- Đặt con trỏ ở vị trí kết quả chọn Paste 

 Xóa khối 

- Chọn đoạn văn bản cần xóa. Nhấn phím Delete trên bàn phím 

2.6. Truy tìm và thay thế trong văn bản 

Truy tìm: Thực hiện các cách sau  

+ Chọn HOME → Editing → chọn Find  

+ Nhấn tổ hợp phím Ctrl+F xuất hiện hộp thoại 

 

 

 

 

 

 

 

 

 

Thay thế:  

+ Chọn HOME → Editing → chọn Replace  xuất hiện hộp thoại:  

 

 

 

 

 

 

 

 

3. Soạn thảo văn bản 

Cách gõ Tiếng Việt: 

Có rất nhiều cách gõ Tiếng Việt trong môi trường Windows. Sau đây là 2 cách gõ 

thông dụng nhất: 

- Kiểu gõ Telex: 

aa    â   s  dấu sắc 

aw    ă    f  dấu huyền 

dd    đ   r  dấu hỏi 

Gõ từ cần tìm 

Kết quả tìm kiếm 

Hình 3.6: Hộp thoại tìm kiếm 

Gõ từ cần tìm 

Gõ từ cần thay thế 

Hình 3.7: Hộp thoại thay thế 
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ee    ê   x  dấu ngã 

oo    ô   j  dấu nặng 

ow,]   ơ   z  hủy dấu 

w,uw,]   ư 

Lặp dấu: 

 ddd  dd  [[  [ 

 ooo  oo  ]]  ] 

 eee  ee 

Ví dụ: Gõ dòng chữ:  Nước chảy đá mòn 

bằng dãy các phím sau: 

 Nwowcs chayr ddas monf  hoặc  N][cs chary ddas mofn 

- Kiểu VNI: 

    Phím số số 1 = Dấu sắc               

    Phím số số 2 = Dấu huyền             

    Phím số số 3 =  Dấu hỏi 

    Phím số số 4 =  Dấu ngã              

Phím số số 5 =  Dấu nặng                

Phím số số 6 =  Dấu mũ của chữ â, ê và ô         

Phím số số 7 =  Dấu râu của chữ ơ và ư 

Phím số số 8 =  Dấu mũ của chữ ă 

Phím số số 9 =  Dấu gạch ngang của chữ đ      

Phím số số 0=  Hủy dấu (xóa dấu)  

Ví dụ: Gõ dòng chữ: Nước chảy đá mòn 

bằng dãy các phím sau: 

  Nu7o71c  cha3y d9a1 mo2n  hoặc  Nu7o7c1  chay3 d9a1 mon2 

Bảng mã và Font chữ Tiếng Việt: 

Để  gõ được Tiếng Việt, ngoài kiểu gõ, thì còn cần phải có sự tương thích giữa 

Bảng mã và Font chữ. Hiện nay có rất nhiều Bảng mã dùng để gõ tiếng Việt. Tuy 

nhiên thông dụng nhất vẫn là các Bảng mã sau đây: 

 Bảng mã TCVN3 - 5712: 

Là loại font 1 Byte được dùng hầu hết tại các tỉnh khu vực phía Bắc và Hà nội. 

Font này tuân thủ theo bảng mã chuẩn quốc gia TCVN 5712 được phát hành năm 

1993 và được khuyến cáo dùng trong khối cơ quan nhà nước. 

Font chữ soạn thảo cho bảng mã TCVN3 có 2 loại: 

- Font soạn thảo chữ thường có dạng: .Vn................ 

Ví dụ: Các Font chữ như: .VnTime, .VnArial, ...... 

- Font soạn thảo chữ hoa có dạng: .Vn...............H 
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Ví dụ: Các Font chữ như: .VnTimeH, .VnArialH, ...... 

 Bảng mã VNI: 

Font VNI do công ty Vietnam International (USA) phát triển, là font chữ 2 byte 

thường được sử dụng trong khu vực phía Nam và ở nước ngoài. 

Font chữ soạn thảo cho bảng mã VNI có dạng: VNI-............... 

Ví dụ: Các Font chữ như: VNI-Times, VNI-Univer, VNI-Vari, ......... 

 Bảng mã Vietware_X: 

Là loại Font chữ 2 Byte. 

Font chữ soạn thảo cho bảng mã Vietware_X có dạng: VN............... 

Ví dụ: Các Font chữ như: VNtimes new roman, VNarial, VNrenfrew, ......... 

 Bảng mã Unicode: 

Là loại Font chữ 1 Byte. Rất thông dụng hiện nay, và đang là Font chuẩn trên các 

trang Web tiếng Việt. 

Font chữ dành cho bảng mã này: Times new roman, Tahoma, Verdana,..... 

Sử dụng bộ gõ Unikey trong soạn thảo: 

 Để sử dụng bộ gõ này cần tiến hành như sau: 

- Khởi động Unikey (Nếu bộ gõ chưa khởi động). 

- Nhấp phải chuột vào biểu tượng Unikey trên Taskbar, chọn mục “Hiện cửa sổ 

Unikey” (Unikey Panel). Màn hình Unikey có dạng: 

 

 

 

 

 

 

 

 

o Trong 

mục “Kiểu 

gõ”, chọn kiểu 

gõ (Telex/VNI); chọn kiểu bỏ dấu 

o Trong mục “Bảng mã”, chọn bảng mã cần dùng. 

o Trong mục “Mở rộng”, dùng  bật/tắt các chức năng tùy chọn . 

Bài tập và sản phẩm thực hành số 1 

Kiến thức: 

Câu 1: Các tổ hợp phím sau có tác dụng gì ?  

Ctrl - I Ctrl - P Ctrl - L Ctrl - F Ctrl - V 

 

Hình 3.8: Giao diện Unikey 
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Alt - F4 Ctrl - B Ctrl - N Ctrl - G Ctrl - S 

Câu 2: Trình bày cách  sao chép và di chuyển khối văn bản? 

Câu 3:  Trình bày kiểu gõ Telex trong tiếng việt ?  

Kỹ năng: 

BÀI  TẬP THỰC HÀNH WORD  1 

YÊU CẦU :  
- Gõ và trình bày văn bản theo mẫu  sau va lưu lại với tên TH01.DOC 

- Sao chép khổ thơ thứ hai xuống dưới khổ thơ thứ ba 

- Di chuyển tên tác giả dưới tiêu đề 

- Thay thế từ “ta” thành từ “anh” 

- Tìm từ “sơn ” trong đoạn thơ trên  

Hướng dẫn thực hành  

1. 

- Mở file mới:File/New/Blank  document 

- Gõ  bài thơ theo mẫu 

- Chọn thẻ File/Save hay CTRL+ S để lưu bài thơ tên TH01.doc 

2. Sao chép: Đánh khối khổ thơ thứ hai;chọn  Home/Copy hoặc Ctrl+C; sau đó 

chuyển điểm chèn xuống dưới khổ thơ thứ ba rồi chọn  home/paste hoặc ctrl+v 

3. Di chuyển tên tác giả: Thao tác như trên nhưng chọn home/cut 

4. Chọn Home→ Editing → chọn Replace thay thế từ “ta” thành từ “anh” 

5. Chọn Home → Editing → chọn Find hoặc CTRL+F 

 

ĐÔI MẮT NGƯỜI SƠN TÂY 

Em ở thành sơn chạy giặc về 

Ta từ chinh chiến cũng ra đi 

Cách biệt bao ngày quê Bất Bạt 

Chiều xanh không thấy bóng  Ba Vì 

Vầng trán em mang trời quê hương 

Mắt em dìu dịu buồn Tây Phương 

Ta nhớ xứ đoài mây trắng lắm 

Em có bao giờ em em nhớ thương? 

… 

Đôi mắt  sơn tây 

U uẩn nhiều lưu lạc 

Buồn viễn xứ khôn khuây 

Ta gửi niềm nhớ thương 

Em mang giùm ta nhé 

Ngày trở lại quê hương 
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Đường hoa khô ráo lệ 

… 

Bao giờ ta gặp em lần nữa 

Ngày ấy thanh bình rộn tiếng ca 

Đã hết sắc màu chinh chiến cũ 

Còn có bao giờ em nhớ ta? 

Lưu Trọng Lư 

Đánh giá kết quả học tập 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

người 

học 

I Kiến thức    

1 Nắm được công dụng các 

phím tắt 
Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

2  

2 Nắm được cách sao chép và di 

chuyển khối văn bản  
4  

3 Biết được  kiểu gõ Telex 4  

                                      Cộng: 10 đ  

II Kỹ năng    

1  Biết khởi động và thoát khỏi 

Word, gõ tiếng việt kiểu Telex  

  

 Kiểm tra sản 

phẩm sau buổi 

thực hành 

  

  

3 
 

2  Biết cách chọn bảng mã phù 

hợp với font chữ. 

 
3 

 

3 Luyện tập các kĩ năng  gõ văn 

bản 
2  

4   Biết các chức năng chung của 

hệ soạn thảo văn bản. 

 
2 

 

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp 4  
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1.1 Đi học đầy đủ, đúng giờ Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

1,5  

1.2 Không vi phạm nội quy lớp học 
1,5 

 

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 

với thời gian quy 

định. 

2 

 

3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 1,5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1,5 

 

3.3 Vệ sinh phòng thực hành đúng 

quy định 
1 

 

                              Cộng: 10 đ  

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

                                                                                              

Cộng: 
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BÀI 4: TRÌNH BÀY VĂN BẢN 

 

Giới thiệu: 

Trong Windows loại chữ được dùng có bề rộng ký tự không cố định, do đó khi soạn 

thảo không được dùng dấu khoảng cách để chỉnh dòng, chỉnh đoạn. Không nên để 

hai dấu cách hoặc hơn liền nhau. Đầu dòng thứ nhất của một đoạn không được gõ 

các dấu khoảng cách mà dùng chức năng định dạng đoạn để lùi đầu dòng.  

Word là một bộ xử lý từ có định dạng, tức là sau khi nhập nội dung ta có thể quy 

định hình thức trình bày cho các nội dung đó tùy ý. Hai yếu tố cơ bản để định dạng 

cho văn bản là định dạng ký tự (quy định hình dạng từng ký tự trong văn bản). Về 

cơ bản thuộc tính của ký tự bao gồm: font chữ, kiểu chữ (thường, đậm, nghiêng, 

gạch chân, chỉ số trên, chỉ số dưới), cỡ chữ tính theo chiều cao của ký tự và màu 

chữ. Thuộc tính của đoạn bao gồm: lề trái và lề phải của đoạn, khoảng cách lùi vào 

của dòng đầu tiên trong một đoạn, cách dóng đoạn (dóng trái, dóng phải, dóng giữa 

và dóng đều hai bên) và khoảng cách các dòng trong đoạn.  

Mục tiêu:                                                        

- Sử dụng được các đối tượng và hiệu ứng để trình bày văn bản. 

- Trình bày cách thức định dạng văn bản. 

- Định dạng được một văn bản đúng yêu cầu. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung: 

1. Định dạng văn bản 

1.1.  Định dạng đoạn văn bản 

Định dạng chữ: Chọn đọan văn bản  muốn định dạng, đưa con trỏ chuột vào vùng 

chọn cho đến khi xuất hiện thanh công cụ Mini. 

 

 

 

 

 

 

 

 

 

 

Căn lề đoạn văn: 

Để căn lề cho đoạn văn thực hiện các bước sau: 

- Bước 1: Chọn 1 đoạn văn hoặc các đoạn văn cần căn lề 

In đậm 

In nghiêng Gạch dưới 

Font chữ 

Cỡ chữ 

Màu chữ 
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- Bước 2: Trong thẻ Home, nhóm Paragraph, nhấn nút Align Left để canh lề trái, 

nhấn Align Right để canh phải, nhấn nút Center để canh giữa (giữa 2 lề trái và phải), 

hay nhấn nút Justify để canh đều hai bên. 

Định dạng khoảng cách các đoạn văn: 

Để định dạng khoảng cách cho đoạn văn thực hiện các bước sau: 

- Bước 1: Chọn đoạn văn bản muốn thay đổi. 

- Bước 2: Trong thẻ Home, nhóm Paragraph, nhấn nút Line Spacing. 

- Bước 3: Chọn khoảng cách muốn, chẳng hạn 2.0 

 

Các kiểu khoảng cách dòng mà Word hỗ trợ: 

- Single (dòng đơn). Tùy chọn này hỗ trợ font lớn nhất trong dòng đơn  

- 1.5 lines: Gấp 1,5 lần khoảng cách dòng đơn. 

- Double: Gấp 2 lần khoảng cách dòng đơn. 

- At least: Lựa chọn này xác lập khoảng cách dòng tối thiểu cần thiết để phù hợp với 

font hoặc đồ họa lớn nhất trên dòng. 

- Exactly: Cố định khoảng cách 

dòng và Word sẽ không điều 

chỉnh nếu sau đó   

tăng hoặc giảm cỡ chữ. 

- Multiple: Xác lập khoảng cách 

dòng tăng hoặc giảm theo tỉ lệ % 

so với dòng đơn mà ta chỉ định. 

Ví dụ, nhập vào 1.2 có nghĩa là 

khoảng cách dòng sẽ tăng lên 

20% so với dòng đơn.  

Ghi chú: Nếu muốn đặt nhiều 

khoảng cách giữa các dòng 

nhưng khoảng cách này không có 

trong menu xuất hiện khi nhấn 

nút Line Spacing, hãy chọn Line 

Spacing Options, và nhập vào 

khoảng cách cần định dạng. 

Thụt lề dòng đầu tiên của đoạn 

Thực hiện các bước sau 

- Bước 1: Nhấn chuột vào đoạn mà ta  muốn thụt lề dòng đầu tiên. 

- Bước 2: Trong thẻ Home, nhấn vào nút mũi tên góc dưới bên phải của nhóm 

Paragraph. 

- Bước 3: Ở hộp thoại Paragraph, chọn thẻ Indents and Spacing. Tại mục Special, ta 

chọn First line. Tại mục By, chọn khoảng cách thụt vào. Nhấn OK. 
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1.2. Định dạng cột, tab, Numbering  

 Định dạng cột: 

Cách thứ nhất: Gõ văn bản trước, chia cột sau: 

- Bước 1: Nhập văn bản, hết đoạn  nhấn Enter để xuống hàng. Sau khi đã gõ hết nội 

dung văn bản, nhấn Enter để con trỏ xuống hàng tạo một khoảng trắng. 

- Bước 2: Bôi đen nội dung cần chọn (không bôi đen dòng trắng ở trên), tại thẻ Page 

Layout, nhóm Page Setup chọn các mẫu cột do Word  mặc nhiên ấn định. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nhấn vào More Columns hiển thị hộp thoại: 

 

 

Hình 4.1: Chọn mẫu cột mặc định 
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+  Presets : các mẫu chia 

cột 

+ One – Two – Three : 

Các cột có độ rộng bằng 

nhau 

+  Left – Right : Các cột 

có độ rộng khác nhau 

+  Number of Columns : 

Số cột (nếu muốn số cột 

chữ >3) 

+  Line Between : Đường 

kẻ giữa các cột 

+ Width and Spacing : 

Điều chỉnh độ rộng và 

khoảng cách 

+ Equal column width: 

Các cột có độ rộng cột bằng nhau nếu nhắp chọn vào ô vuông phía trước 

Cách thứ hai: chia cột trước, gõ văn bản sau 

- Tại thẻ Page Layout, nhóm Page Setup chọn các mẫu cột do Word mặc nhiên 

ấn định - Nhập văn bản vào. 

- Tại thẻ Page Layout, nhóm Page Setup  chọn Breaks, Column Break: để ngắt 

cột khi muốn sang các cột còn lại. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 4.2: Hộp thoại Column 

 

Hình 4.3: Ngắt cột 



 Trang 66  

 Định dạng tab: 

Hiển thị thước ngang trên đầu tài liệu bằng cách nhấn nút View Ruler ở đầu trên 

thanh cuộn dọc. 

Chọn tab bằng cách lần lượt nhấn vào ô tab selector – là ô 

giao nhau giữa thước dọc và thước ngang (ở góc trên bên trái 

trang tài liệu) cho đến khi chọn được kiểu tab mong muốn, 

  

 

 

Tab trái:  Đặt vị trí bắt đầu của đoạn văn bản chạy sang phải khi nhập liệu 

Tab giữa:  Đặt vị trí chính giữa đoạn văn bản. Đoạn văn bản sẽ nằm giữa vị 

trí đặt tab. 

Tab phải:  Nằ m ở bên phải cuối đoạn văn bản. Nhập liệu, đoạn văn bản sẽ di 

chuyển sang trái kể từ vị trí đặt tab. 

Tab thập phân:  Khi đặt tab này, những dấu chấm phân cách phần thập phân 

sẽ nằm trên cùng một vị trí. 

Bar Tab:  Chèn một thanh thẳng đứng tại vị trí đặt tab. 

 Định dạng Numbering: 

Số thứ tự tự động cho 

phép định dạng và tổ chức văn 

bản với các số, các bullet (dấu 

chấm tròn). Chọn HOME 

→Paragraph 

Các danh sách Bullet có các dấu 

chấn tròn 

Danh sách các Number có các số và 

danh sách các Ountline là sự phối 

hợp giữa các số và các chữ cái phụ 

thuộc vào sự tổ chức của danh sách. 

 

 

 

 

Kích chuột đến khi xuất hiện 

loại Tab cần dùng 

 
Hình 4.4: Bulleted and Numbered 
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 Định dạng khung và làm nền: 

Để dễ dàng cho việc tạo nền và đóng khung cho văn bản, ta nên gõ văn bản xong rồi 

mới thực hịên. 

 Quét chọn văn bản chọn HOME→Paragraph→ chọn → Border and Shading, 

hộp thoại hiển thị với 3 thẻ sau: 

Border: Các định dạng về đường kẻ 

khung: 

+ None: không đóng khung 

+ Box: đóng khung với kiểu đường 

được chọn ở mục Stype 

+ Shadow: đóng khung có viền bóng 

với kiểu đường chọn ở mục Stype 

+ 3- D: đóng khung với hiệu ứng 

không gian 3 chiều với kiểu đường 

chọn ở mục Stype 

+ Custom: tuỳ chọn kiểu đường khung, 

có thể Nhấp chọn cho từng đường trên từng cạnh Stype khác nhau và Nhấp 

chỉ định tương ứng ở mục Preview 

+ Color và Width: chọn màu và độ rộng cho đường kẻ khung  

Thẻ Page Border: Tương tự như áp dụng cho kẻ khung câu văn nhưng the này áp 

dụng cho cả trang vản bản. Đặc biệt mục Art liệt kê các kiểu đường viền cho cả trang 

theo các mẫu được thiết kế sẵn. 

Thẻ Shading: Chọn kiểu tô nền cho câu văn chọn. Các mục gồm: 

+ Fill: chọn màu tô cho câu văn, ngầm định no Fill không tô nền 

+ No Fill: huỷ chọn việc tô nền 

+ Stype: chọn kiểu tô nền 

+ Color: chọn màu tô, ta có thể Nhấp More Color để tự pha trôn màu tô. 

Thẻ Shading:  

 

 

 

 

 

 

 

 

1.3. Drop Cap (Tạo chữ hoa thụt cấp) 

Tạo một chữ hoa thụt cấp (Dropped Cap) 

 
 

Hình 4.5: Định dạng khung và làm nền 

Fill: Kích chuột chọn một 

màu làm màu nền từ bảng 

màu  

Patterns: Chọn nét hoa văn 

làm nền 

+Stype: Chọn lựa kiểu hoa 

văn 

+Color: Chọn màu cho nét 

Hình 4.6: Định dạng khung và làm nền (thẻ Shading) 
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Microsoft Word có tính năng tạo chữ nhấn manh gọi là Drop Cap. Đó là chữ cái đầu 

câu được phóng to và thả xuống. Kiểu trình bày văn bản này có tính mỹ thuật cao.  

Chọn  Insert → nhóm Text → chọn lệnh Drop Cap  

Có 2 chế độ: 

1. Dropped cap. 

2. In-margin dropped cap. 

Để có thể tùy biến chữ cái nhấn mạnh này,  nhấn chuột lên lệnh Drop Cap 

Options trên menu của Drop Cap. Trên hộp thọai Drop Cap, có thể chọn vị trí 

của chữ nhấn mạnh, font chữ, số dòng thả xuống và khoảng cách từ chữ nhấn mạnh 

tới văn bản. Nhấn OK để hoàn tất. 

 

Sau này, nếu không muốn nhấn mạnh kiểu Drop 

Cap, vào lại màn 

hình Drop Cap và chọn lệnh None. 

 Đối với văn bản vừa trình bày chia cột, vừa có 

tạo chữ Drop Cap, cần chú ý: 

 Nếu tạo: Chia cột trước, tạo chữ Drop sau. 

 Nếu hủy: Hủy chữ Drop Cap trước, hủy chia 

cột sau. 

 

 

 

 

1.4. Watermark (Nền bảo vệ 

văn bản) 

Một hình mờ là một ảnh trong 

suốt mà xuất hi n ngay sau văn 

bản trong tài liệu. Để chèn một 

hình mờ: 

-  Chọn tab Page Layout trên 

vùng Ribbon 

-  Chọn nút Watermark trong 

nhóm Page Background 

-  Nhấp chọn Watermark  cần 

chọn hoặc Chọn Custom 

Watermark và tạo một hình mờ riêng. 

- Để bỏ một hình mờ, thực hiện các bước như trên nhưng chọn Remove 

Watermark. 

 
Hình 4.7: Tạo chữ Drop Cap 

 
Hình 4.8: Hình bảo vệ văn bản  
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1.5. Tạo tiêu đề trên và dưới (Header và Footer) 

Các văn bản như  giáo trình dạy học, tài liệu, chuyên đề, báo cáo, v.v... thường phải 

có các thông tin mang tính hướng dẫn, xuất xứ như: Tên chuyên đề, người thực hiện, 

số trang, người hướng dẫn, v.v...Các thông tin này thường được đặt ở đầu trang và 

chân trang (Header and Footer). 

Tại thẻ Insert  → nhóm Header & Footer, nhấn  nút Header hay Footer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Menu xổ xuống với các Header, Footer mẫu cần chọn. 

- Nhập nội dung cho Header hay Footer đó. 

- Nhấn đúp chuột vào vùng nội dung của trang, lập tức Header/ Footer sẽ được 

áp dụng cho toàn bộ trang của tài liệu. 

1.6. Đánh số thứ tự cho trang văn bản 

 Chèn số trang vào văn bản 

- Chọn thẻ Insert → nhóm Header & Footer, nhấn nút Page Number 

 

Hình 4.9: Hình tạo Header & Footer 



 Trang 70  

 
- Trong menu xuất hiện, trỏ tới Top of Page (chèn số trang vào phần 

Header) hoặc Bottom of Page (chèn vào 

Footer) 

 Thay đổi dạng số trang 

- Nhấn đúp vào Header hay 

Footer, nơi cần đặt số trang.  

- Tại thẻ Design, nhấn  

Header & Footer, nhấn nút Page Number, 

chọn tiếp Format Page Numbers. 

+ Number format: Chọn dạng số thứ tự 

+ Include Chapter Number: Số trang 

được kèm với số chương 

+ Continue From Previous Section: Số 

trang nối tiếp với section trước đó 

+ Start at: Số trang được bắt đầu từ số 

+ Trong hộp thoại Page Number, tại mục Number format, chọn một kiểu 

đánh số mình thích, sau đó nhấn OK. 

 Xóa số trang đã đánh 

Thẻ Insert, nhấn Header & Footer, nhấn nút Page Number, sau đó chọn Remove 

Page Numbers ở cuối menu. 

1.7. Định dạng trang văn bản  

 Chỉnh sửa lề trang: 

+ Chọn tab Page Layout  → Page Setup, Nhấp chọn Margins 

 Chọn Default Margin, hoặc 

 Chọn vào Custom Margins và hoàn thành hộp thoại 
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 Định hướng lề trang, Nhấp thước hay cột của trang: 

 Chọn thẻ Page Layout  →  nhóm Page Setup, Chọn Orientation, Size 

hay Columns 

 Chọn kiểu thích hợp. 

 

 

 

 

 

 

 

 

Áp dụng đường viền trang và màu sắc 

 

4.11: Định lề trang 

 

Hình 4.12:  Định hướng trang 
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Chọn tab Page Layout  →  nhóm Page Background, Chọn Page Colors và 

lựa chọn màu muốn áp dụng cho trang hoặc Page Borders và chọn đường viền thích 

hợp cho trang. 

 

 

 

 

 

 

 

 

 Tạo một ngắt trang 

Để chèn một ngắt trang: 

Chọn tab Page Layout  → Page Setup, chọn menu Breaks, chọn Page Break. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Chèn một Trang bìa 

Để chèn một trang bìa: 

Chọn tab Insert  → nhóm Pages, chọn nút Cover Page , chọn một kiểu trang 

bìa. 

 

Hình 4.13:  Tạo viền trang và màu sắc 

 
Hình 4.14:   Tạo ngắt trang 
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 Chèn một trang trống 

Để chèn một trang trống: 

Chọn tab Insert → nhóm Page,  chọn nút Blank Page. 

 

 

 

 

 

 

2.Chèn các đối tượng vào văn bản  

2.1 Chèn các kí tự đặc biệt 

Để chèn các kí hiệu ta có thể chọn các font, cỡ, kiểu, màu v.v…Ví dụ một số ký hiệu 

trong bộ font Winding: …  

  + Để chèn ta đặt  con trỏ vào nơi  muốn chèn ký  hiệu 

  + Chọn thẻ  Insert → nhóm Symbols,  Chọn nút Symbol   

  + Chọn ký hiệu phù hợp 

 

 

 

hoặc More Symbols  hộp thoại sau xuất hiện: 

 

Hình 4.15: Chèn trang bìa 

 
Hình 4.16: Chèn trang trống 
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+ Tiếp theo ta chọn ký hiệu tại mục Font. Thông thường, các ký hiệu phổ biến nằm 

ở các bộ font: Winding, Webding… 

+ Chọn ký hiệu cần chèn, Nhấp chọn nút lệnh Insert. Thực hiện xong Close. 

 Với các ký hiệu thường xuyên sử dụng, ta có thể gán cho mỗi ký hiệu là một 

kí tự hoặc một từ, tổ hợp phím tắt nào đó để tiện dùng. 

   Gán ký hiệu cho một từ: Trong hộp Symbol, ta Nhấp ký hiệu cần tạo 

từ viết tắt, chọn nút lênh AutoCorrect…, Tiếp theo tại mục Replace gõ từ thay thế, 

xong Nhấp Ok và Close. Ví dụ: ta thường xuyên hay dùng ký hiệu , vậy ta gán 

cho nó là từ “sach”. Như vậy khi gõ “sach” và ấn nút Space thì kí hiệu  sẽ được 

thay thế cho từ sách.      

   Gán tổ hợp phím tắt cho ký hiệu:Trong hộp Symbol, ta Nhấp ký hiệu 

cần tạo từ viết tắt, chọn nút lệnh Shotcut Key  

    Tiếp theo tại mục Press new shortcut key, ta ấn tổ hợp phím tắt 

phù hợp (được kết hợp với phím Ctrl…, Alt… hoặc cả Ctrl- Alt…phía trước, ví dụ 

Ctrl-T) 

    Nhấp Assign để chuyển vào danh sách các phím tắt (Current 

key) ấn Close. 

Ví dụ ta thường xuyên dùng ký hiệu, ta gán tổ 

hợp phím tắt cho nó là Ctrl-T, ấn ‘Ctrl- T’  thì ký 

hiệu  sẽ hiển thị.  

 

 

 

 

 

 

 

 
Hình 4.17: Chèn kí tự đặc biệt 

 

 Hình 4.18: Gán ký hiệu   
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2.2 Chèn ClipArt và hình ảnh 

Để thực hiện chèn hình vào văn bản tại vị trí con trỏ nháy của văn bản, ta thực hiện 

các bước sau: 

+ Đặt con trỏ vào nơi  muốn chèn hình minh họa hay hình ảnh 

+ Chọn thẻ Insert →   Chọn nút Clip Art 

+ Hộp thoại xuất hiện và có thể tìm hình mẫu 

+ Nhấp chuột vào nút Go nếu không thấy hình, 

xuất hiện ngay trong vùng danh sách hình. 

+ Nhấp chuột vào ngay hình cân chèn từ vùng danh 

sách hình ảnh, ảnh sẽ xuất hiện trong văn bản ngay 

tại vị trí con trỏ. 

 

 

 

 

 

 

 

2.3 Chèn và định dạng hình ảnh 

 Để chèn một hình ảnh: 
+ Đặt con trỏ vào nơi muốn chèn 

+ Chọn tab Insert → Chọn nút Picture 

+ Duyệt qua hình ảnh muốn chèn và chọn ảnh. 

+ Chọn Insert 

 

 

 

 

 

 

 Định dạng hình ảnh 

Để định dạng hình ảnh ta Nhấp phải, chọn lệnh Format Picture hộp thoại sẽ xuất 

hiện, Nhấp chọn thẻ Layout 

- In line with text: hình ảnh xếp nối tiếp theo văn bản tại vị trí đặt trỏ lúc chèn ảnh. 

- Square: Đặt đối tượng nằm vào một khung vuông bao quanh bởi văn bản. 

- Tight: Đối tượng được văn bản bao quanh theo biên đối tượng. 

- Behind Text: Đối tượng nằm bên dưới lớp văn bản. Tùy chọn này thường được 

dung để đặt ảnh làm nền hoặc ảnh lớn cho văn bản. 

- In front of text: Đặt đối tượng nằm trên lớp văn bản, che khuất văn bản nơi đối 

tượng được đặt. 

  
Hình 4.19:  Chèn ClipArt  

 
Hình 4.20: Chèn hình ảnh   
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2.4. Chèn và hiệu chỉnh lưu đồ 

Smart Art là tập hợp các loại đồ họa có thể sử dụng để tổ chức thông tin trong tài 

liệu. Để chèn SmartArt: 

+ Đặt con trỏ vào nơi muốn chèn minh họa hay hình ảnh 

+ Chọn tab Insert → Chọn nút SmartArt 

+ Chọn vào SmartArt  muốn chèn 

 

+ 

Chọn mũi tên phía bên trái để chèn văn bản hoặc gõ văn bản trong đồ họa. 

Để hiệu chỉnh SmartArt, chọn Tab Design và các nhóm liên quan: 

 

 

 
Hình 4.21: Định dạng hình ảnh   

 
Hình 4.22: Chèn SmartArt   
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2.5. Vẽ và hiệu chỉnh biểu đồ 

Biểu đồ là một dạng thể hiện bằng hình ảnh các số liệu của một bảng tính.   

Tại thẻ Insert → nhóm Illustrator, nhấn vào Chart 

 

Chọn một kiểu biểu đồ và nhập hoặc sửa 

nội dung bảng dữ liệu trực tiếp trên 

bảng dữ 

liệu Data Sheet của màn hình Excel. 

 

Đóng chương trình Excel, biểu đồ lưu 

lại trên màn hình Word 

 

2.6. Lập và hiệu chỉnh biểu thức toán học 
Word 2010 cho phép chèn các công thức toán học. Để xem công cụ toán học: 

+ Đặt con trỏ vào nơi   muốn chèn công thức toán học 

+ Chọn thẻ Insert → trên nhóm Symbols, Chọn nút Equation 

+ Chọn công thức toán học phù hợp hoặc Chọn Insert New Equation 

 

 

Xuất hiện cửa sổ chọn kiểu biểu đồ 

 

Hình 4.23: Chèn biểu đồ  
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Để chỉnh sửa công thức toán học: Nhấp chọn công thức và thẻ  Design sẽ xuất hiên 

trên vùng Ribbon 

 

3. Các hiệu ứng đặc biệt 

3.1. Hiệu ứng Text Effect 
+ Lựa chọn đoạn văn bản cần áp dụng hiệu ứng 

+ Nhấp chuột vào biểu tượng của Text Effect trên thanh công tại thẻ Menu Home, 

một menu đổ xuống cho phép lựa chọn các hiệu ứng cần áp dụng 

 

Hình 4.24: Chèn công thức toán học  
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Hình 4.25: Hiệu ứng Text Effect 
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Bài tập và sản phẩm thực hành số 2 

Kiến thức: 

Câu 1: Trình bày cách định dạng đoạn văn bản? 

Câu 2: Trình bày cách chia cột, chèn hình ảnh, chèn các kí tự đặc biệt trong văn bản? 

Câu 3:  Trình bày các bước tạo chữ  nghệ thuật, tạo Drop cap ?  

Kỹ năng: 

BÀI  TẬP THỰC HÀNH WORD  2 

YÊU CẦU :  Gõ và trình bày văn bản theo mẫu  sau va lưu lại với tên 

TH02.DOC 

Hướng dẫn thực hành  

1.  Gõ văn bản : 

- Font chung cho toàn bộ văn bản là Font : VN time new roman ; size : 14 

- Dòng tiêu đề : Font : VN time new roman ; size : 14, canh giữa 

 Dòng 1 : Chữ in hoa        ;      Dòng 2 : in đậm (BOLD) 

 Dòng 3: in nghiêng (Italic) ;Dòng 4 : Chèn Ký tự đặc biệt : insert / symbol 

 Dòng 5 : Font : Vntoronto ; size : 20 ; style : Bold ; in hoa 

- Văn bản: Trình bày theo mẫu với lề first line = 0.5 inches, canh dữ liệu: justify 

2. Lưu văn bản lại với tên TH02.DOC 

TRƯỜNG CAO ÐẲNG NGHỀ ÐÀ NẴNG 

KHOA CÔNG NGHỆ THÔNG TIN 

99 Tô Hiến Thành , Phường Phước Mỹ, Quận Sơn Trà, TP Ðà Nẵng 

0511.3940675 - 0905112233 

THƯ NGÕ 

Kính gởi  :  Các chúng ta học viên 

       Trong suốt thời gian vừa qua, KHOA CÔNG NGHỆ THÔNG TIN đã đào 

tạo được nhiều lớp Tin học ngắn hạn với chất lượng cao. Đặt biệt, Khoa ngày một 

chú trọng nhiều đến điều kiện học tập về mặt lý thuyết cũng như thực hành bằng các 

phương tiện hiện đại; tạo cho học viên dễ nắm bắt được nội dung bài học. 

Tuy nhiên, bên cạnh đó cũng không tránh khỏi những thiếu sót. Khoa CNTT 

Trường Cao Ðẳng Nghề Ðà Nẵng  mong muốn nhận được những góp ý của các 

chúng ta nhằm giúp Khoa phát triển và phục vụ ngày càng tốt hơn đối với các chúng 

ta. 

Trân trọng kính chào. 

Tp. Đà nẴng, ngày ..... Tháng ..... Năm 2012 

TRƯỞNG KHOA CNTT 

                   (Ký tên) 
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ata Zura Yamato Okina Wakabi 

mộng làm một kiếm khách vô 

địch, nhưng mỗi lần đấu với cha 

đều bị cha đánh bại, và phải nghe lời phê 

bình của cha là thân pháp quá chậm 

chạp. 

Nỗi buồn bực cứ trút xuống tâm trí 

Mata Zura Yamato Okina Wakabi 

nhưng chàng vẫn nuôi chí trở thành một 

kiếm sỉ đại danh. 

Một ngày kia Mata Zura Yamato 

Okina Wakabi xin phép cha để theo học 

Hoka Suzu Iwa Masaki Banzo Ladori - 

một kiếm sư đại tài, và chàng được cha 

chấp nhận. 

Mata Zura Yamato Okina Wakabi 

đến bái kiến Hoka Suzu Iwa Masaki 

Banzo Ladori : 

- Thưa đại sư, nếu toi sớm hôm ở 

cạnh đại sư không phút xa lìathi trong 

bao lâu tôi sẽ trở thành một kiếm sĩ vô 

địch 

- Mười năm 

- Thưa đại sư, cha tôi đã già tôi muốn 

rút ngắn thời gian để còn trở về chăm 

sóc người. Tôi nguyện hầu hạ đại sư cần 

mẫn gấp hai thì thời gian thành tài là bao 

lâu ? 

- Ba mươi năm !Hoka Suzu Iwa 

Masaki Banzo Ladori bình tỉnh đáp. 

Sao lại như thế được, thưa đại sư ? 

Mata Zura Yamato Okina Wakabi kinh 

ngạc hỏi. 

...(Vị kiếm sư Hoka Suzu Iwa 

Masaki Banzo Ladori vẫn trầm mặc) 

- Nếu tôi xả thân phụng sự đại sư 

không ngơi nghỉ chút nào thì bao lâu có 

thể thành đạt kiếm pháp ? 

- Bảy mươi năm ! 

Mata Zura Yamato Okina Wakabi 

mồm há hốc, vô cùng tuyệt vọng, ha 

chân chàng muốn khuỵu trông thật đáng 

thương. 

Kiếm sư Hoka Suzu Iwa Masaki 

Banzo Ladori ôn tồn giải thích cho Mata 

Zura Yamato Okina Wakabi nghe : 

- "Dục tốc bất đạt", người hấp tấp 

làm việc gì cũng khó thành công. 

Mata Zura Yamato Okina Wakabi 

phần nào hiểu được điều ấy. Chàng 

quyết tâm ở lại với đại sư Hoka Suzu 

Iwa Masaki Banzo Ladori  

 

          Theo sổ tay võ thuật, TP Hồ Chí Minh 

 

 

 

 

 

 

 

 

`Đánh giá kết quả học tập 

 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

M 
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người 

học 

I Kiến thức    

1 Nắm rõ cách định dạng đoạn 

văn bản 
Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

2  

2 Biết cách chia cột, chèn hình 

ảnh, chèn các kí tự đặc biệt 

trong văn bản 

4  

3  Nắm được các bước tạo chữ  

nghệ thuật, tạo chữ Drop cap 
4  

                                      Cộng: 10 đ  

II Kỹ năng    

1   Luyện tập các kĩ năng định 

dạng kí tự, định dạng đoạn văn 

bản, gõ tiếng việt 

  

  

Quan sát, Kiểm 

tra sản phẩm 

trong và sau buổi 

thực hành  

  

3 

 

2 Biết tạo chữ nghệ thuật, 

Dropcap 
3 

 

3  Biết chèn hình ảnh, định dạng 

hình ảnh 
2 

 

4  Biết chèn kí hiệu đặc biệt 2  

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1,5  

1.2 Không vi phạm nội quy lớp học 1,5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 

với thời gian quy 

định. 

2 

 

3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp 

Theo dõi việc 

thực hiện, đối 
4 
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3.1 Tuân thủ quy định về an toàn chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp 

1,5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1,5 

 

3.3 Vệ sinh phòng thựchànhđúng 

quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

                                                                                              

Cộng: 
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Bài tập và sản phẩm thực hành số 3 

Kiến thức: 

Câu 1:  Trình bày cách định dạng hình ảnh và  công dụng của các thẻ Color and Line, 

Size, Layout trong hộp thoại Format Picture? 

Câu 2: Trình bày cách đánh số thứ tự cho trang văn bản? 

Câu 3: Trình bày công dụng thẻ Page Layout?   

Kỹ năng: 

BÀI  TẬP THỰC HÀNH WORD  3 

YÊU CẦU :  Gõ và trình bày văn bản  sau va lưu lại với tên TH03A.DOC 

HƯỚNG dẫn thực hành  

1. Gõ văn bản : 

 Dùng font chữ chung là font : Times new roman ; size : 12 

 Dòng tiêu đề : dùng  font : Times new roman ; size : 26, Canh giữa 

- Tạo đường viền shadow bằng lệnh format / borders and shading 

- và kéo left indent và right  indent  thụt vào mỗi bên 1.5  

 Tên tác giả : font : Vnbanff ; size : 16, Canh phải 

 NÊN nhấp chọn nút            hoặc ctrl - J để văn bản gõ vào canh dều 2 biên. 

 Nhập nội dung trước rồi định dạng ký tự đầu đoạn sau bằng lệnh format / drop 

cap, tạo đường  viền và tô màu nền 

 Đối với đoạn “Em không nghe ....” font : Times new roman ; size : 14 

+ Kéo lề trái left Indent  và phải right indent  thụt vào mỗi bên 2  

+ Tạo viền trái và phải (Chọn From text là 20 pt). Tô nền 10 % 

 Đối với đoạn “Đặc biệt : ....”  Để đẩy biên trái các dòng trong đoạn lùi vào so 

với dòng đầu tiên, chọn thẻ Home/ paragraph kích vào  chọn mục special  và 

chọn Hanging sau đó ở mục By gõ số 1 

 Đối với đoạn “Rồi ngày....”  

+  Tạo viền trái và phải (chọn From text là 10 pt ). Tô nền 10%  

+  Kéo lề trái left Indent  và phải right indent  thụt vào (các dòng lệnh nhau) 

 Đối với đoạn “Đi giữa....”  font : Times new roman ; size : 14; canh giữa. Tô 

nền 10 %, Tạo viền trên và dưới. 

 Sau khi định dạng nhấp nút print xem hình thức trang in trên màn hình. Muốn 

chuyển trở lại cửa sổ soạn thảo thì chọn nút close 

2. Lưu văn bản   : với tên tập tin TH03A.DOC. 
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THƠ LƯU  TRỌNG LƯ 

Kiều Văn 

 

hong trào thơ mới như một vườn hoa muôn hồng ngàn tía, đã tạo nên cả nột 

thời đại thi ca rực rỡ trong lịch sử văn học Việt  Nam. Thơ mới bao gồm 

nhiều trường phái và hầu như mỗi bài thơ đều có một phong cách riêng biệt. 

         Thơ LưuTrọng Lư ngay từ lúc mới xuất hiện đã ”cát cứ” một góc cuả vườn 

thơ. Đó là thứ thơ Tình -Sầu -Mộng hết sức nhẹ nhàng, man mác, chơi vơi. 

         Lưu Trọng Lưu có một giọng thơ vừa hồn nhiên, vừa lạ, trong đó chúng ta 

nghe thấy cái nhạc điệu muôn thuở của tâm hồn mơ mộng: 

Em không nghe mùa thu  

Lá thu rơi xào xạc 

Con nai vàng ngơ ngác 

Đạp trên lá vàng khô? 

Hoặc tiếng đập của trái tim như ngẩn ngơ, như rời rạc trước một cuộc đời lúc nào 

cũng sầu muộn, cũng tan vỡ mà người trong cuộc cứ nhìn ngó với đôi mắt mơ màng, 

chẳng hề phản ứng, giành giật hay níu kéo. 

Rồi ngày lại ngày 

Sắc màu : phai 

Lá cành :rụng 

Ba gian: trống 

Xuân đi, 

Chàng cũng đi. 

Phải chăng trong một thời đại vô cùng xôi động, dòng thơ mát dịu như hơi 

sương, như nước suối và đầy hoa mộng của Lưu Trọng Lư là phương thuốc màu 

nhiệm giúp mọi người lấy lại sự “ cân bằng sinh thái” trong tâm hồn mình? 

Điều cuối cùng nói về nhà thơ quá cố là: trọn đời, tác giả bài thơ “ Tiếng thu” 

mang trong ngực một trái tim dịu dàng, nhân ái. Lưu Trọng Lư và thơ của ông là 

một.Chính vì vậy khi tổng kết lòei thơ của mình, ông đã viết: 

 

Đi giữa vườn nhân dạ ngẫn ngơ, 

Vì thương người lắm mới say thơ. 

 

  

P 
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3. YÊU CẦU :  Gõ công thức toán học dưới đây và lưu lại với tên TH03B.DOC 

 HƯỚNG DẪN : dùng lệnh INSERT/SYMBOL và chọn EQUATION  

+ Sau đó chọn biểu tượng ở hộp symbol để gõ từng ký tự của công thức 

+ Chọn Font : vnarial hay Vntime new roman 

+ Gõ xong công thức nhắp chuột vào vị trí bất kỳ của văn bản 

+ Muốn sửa chữa nhắp đôi (duoble click) tại công thức  

+ Sau đó lưu văn bản với tên TH03B.DOC 

Các bước tiến hành :  

+ Gọi Insert \ Symbols\ Equation xuất hiện thanh công cụ  

Gõ chữ  "X",  và kích vào  

Gõ tiếp số "1", dùng phím mũi tên di chuyển điểm nháy lên một nấc.  

Tương tự như thế gõ "X2 " gõ dấu = và chọn tiếp  

Trong khung soạn thảo xuất hiện một phân số và chúng ta chỉ có việc gõ tử số 

và mẫu số. Các ký hiệu như , căn sô...các chúng ta tự tìm trong các biểu tượng trên 

thanh công cụ Equation. 

Tương tự, soạn tiếp các công thức dưới đây : 

 

a

b
XX






2
21

  

32

12
1 









  xxaî

b

anm
n cbadX

n

kji

2

)()()(

cba
PVåïi

cpbpappStg





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2
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2
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2
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n
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
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Đánh giá kết quả học tập 

 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

người 

học 

I Kiến thức    

1 Trình bày đúng cách định 

dạng hình ảnh, hiểu rõ công 

dụng các thẻ trong hộp thoại 

Format Picture 
Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

4  

2   Trình bày được cách đánh số 

thứ tự cho văn bản 
2  

3  Trình bày rõ công dụng thẻ 

Page Layout 
4  

                                      Cộng: 10 đ  

II Kỹ năng    

1 Biết định dạng đoạn văn bản Quan sát, kiểm 

tra sản phẩm 

trong và sau buổi 

thực hành 

2  

2  Biết định dạng tab, viền khung 2  

3 Biết tạo chữ nghệ thuật, Drop 

cap 
2 

 

4 Biết cách lập và hiệu chỉnh 

công thức toán học 
4 

 

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1,5  

1.2 Không vi phạm nội quy lớp học 1,5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 
2 
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với thời gian quy 

định. 

3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 1,5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1,5 

 

3.3 Vệ sinh phòng thực hành đúng 

quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

   Cộng:  
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BÀI 5: XỬ LÝ BẢNG BIỂU 

 

Giới thiệu: 

Ngoài các tính năng soạn thảo văn bản thông thường, MS Word 2010 còn cho phép 

xây dựng các bảng biểu trong văn bản. Người sử dụng có thể định dạng các bảng 

biểu như đối với bất kỳ đoạn văn bản nào khác. Ngoài ra, có thể chèn vào văn bản 

một số công thức toán học thông thường để tính toán, có thể căn chỉnh  độ rộng, cao 

của dòng, cột. 

Mục tiêu:                                                   

- Mô tả được các thao tác tạo và xử lý bảng biểu. 

- Trình bày nội dung văn bản trên bảng biểu. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung: 

1.Chèn bảng biểu vào văn bản  

Để tạo một bảng: 

-  Đặt con trỏ vào trang nơi muốn tạo bảng 

-  Chọn tab Insert → nhóm Tables, Chọn vào nút Tables. Tạo một bảng theo một 

trong 4 cách sau: 

 

 

 

 

 

 

+ Đánh dấu số dòng và cột 

+ Chọn Insert Table và nhập số dòng và cột 

+ Chọn vào Draw Table, tạo bảng bằng cách Nhấp và nhập số dòng và cột 

+ Chọn Quick Tables và chọn bảng. 

2. Các thao tác trên bảng biểu 

2.1. Các phím dùng để di chuyển trong bảng 
- Di chuyển lên xuống một ô: dùng các phím  ↓,↑. 

- Di chuyển sang phải một ô: dùng phím Tab. 

- Di chuyển sang trái một ô: dùng tổ hợp phím Shift+Tab. 

2.2. Định dạng bảng 

2.2.1. Chỉnh nhấp thước dòng, cột 
Để chỉnh Nhấp thước dòng, cột của bảng, thực hiện các bước sau: 

-  Đặt trỏ chuột tại biên dòng , cột của bảng →  

Hình 5.2: chèn bảng 
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-  Sử dụng thao tác kéo chuột để thay đổi Nhấp thước dòng, cột. 

2.2.2. Chèn dòng, cột trong bảng 

Chọn vào bảng và sẽ thấy có hai thẻ mới trên vùng Ribbon là: Design và 

Layout. Hai thẻ này dùng để thiết kế và bố trí bảng. 

2.2.2.1 Chèn dòng 

Tại thẻ Layout→ nhóm Rows and Column 

+  Nếu chọn  Insert Above : dòng chèn vào nằm trên dòng chứa ô hiện hành. 

+ Nếu chọn Insert Below : dòng chèn vào nằm dưới dòng chứa ô hiện hành. 

 

2.2.2.2 Chèn cột 

Tại thẻ Layout→ nhóm Rows and Column 

+ Nếu chọn Insert Left: cột chèn vào nằm bên trái chứa ô hiện hành. 

+ Nếu chọn Insert Right: dòng chèn vào nằm bên phái chứa ô hiện hành. 

2.2.3. Xóa dòng/cột trong bảng 

Để xóa dòng/cột thực hiện các bước: 

- Chọn dòng/cột cần xóa. 

- Tại thẻ Layout→ nhóm Rows and Column, chọn nút Delete 

+ Delete Row: Xóa dòng 

+ Delete Column: Xóa cột  

2.2.4. Kết nối các ô/ tách ô 

 Kết nối ô 

Thực hiện các bước: 

-  Chọn các ô cần kết nối với nhau (các ô cần trộn). 

-  Nhấp chuột vào thẻ Layout → nhóm Merge, chọn Merge cells 

 Tách ô 

Thực hiện các bước: 

-   Chọn các ô cần tách. 

-   Nhấp chuột vào thẻ Layout→ nhóm Merge, chọn Split cells xuất hiện hộp 

thoại 

 
 

2.3. Định dạng đường viền và nền cho bảng 

 Định dạng đường viền cho bảng 

Tạo đường viền cho Tables ta làm các bước sau: 

- Tô khối cả bảng và chọn Tables Tools. 

- Chọn tiếp Design, nhấn vào nút Border chọn All Borders 
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- Chọn các kiểu đường viền và nhấp OK 

 Tô nền cho bảng 

Phối hợp màu sắc để tạo nền cho Tables. Thực hiện theo các bước sau: 

- Chọn các ô cần tô màu, sau đó  nhấn vào Tables Tools  chọn Design. 

- Chọn tiếp mục Shading và chọn màu nền cho ô. 

. 

2.4. Chèn công thức toán học vào bảng 

Đối với phần mềm Microsoft Word khi thao tác với bảng biểu, nếu dữ liệu trong các 

ô là số, ta có thể thực hiện một số phép toán đơn giản như tính Tổng (sum), Tích 

(Product), trung bình (average) các số trong các ô nhờ các hàm có sẵn. 

Để thực hiện tính toán, thực hiện các bước sau: 

- Nhấp chuột vào ô mà tại đó muốn xuất hiện kết quả tính toán. 

- Nhấp chuột vào thẻ Layout→ Data, chọn Formula…, xuất hiện hộp thoại: 

 

 

 

 

 

 

 

Kích chọn hàm 
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+ Xóa hàm có trong ô Formula, nếu hàm không đúng yêu cầu ( không xóa 

dấu bằng ) 

+ Nhấp vào mũi tên tại ô Paste function, để chọn hàm thích hợp. 

Lưu ý: Đối số của hàm là:  

Above: nếu muốn tính toán đối với các ô nằm ở trên và cùng cột so 

với ô kết quả. 

Below: Nếu muốn tính toán đối với các ô nằm ở dưới và cùng cột so 

với ô kết quả. 

Left: Nếu muốn tính toán đối với các ô nằm ở bên trái và cùng cột so 

với ô kết quả. 

Right: Nếu muốn tính toán đối với các ô nằm ở bên phải và cùng cột 

so với ô kết quả. 

- Nhấp nút OK để thực hiện việc tính toán. 

3. Thay đổi cấu trúc bảng biểu  

Chọn vào bảng, thấy hai thẻ mới trên vùng Ribbon là: Design và Layout. Hai thẻ 

này dùng để thiết kế và bố trí bảng. 

 

 
Trên thẻ Design, có thể chọn: 

• Table Style Options 

 
• Draw Borders 
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BÀI  TẬP THỰC HÀNH WORD  4 

KIẾN THỨC 

Câu 1: Trình bày cách tạo một bảng biểu mới? 

Câu 2: Trình bày các thao tác trên bảng biểu(chèn/xóa dòng cột và  tách/ kết nối 

ô),định dạng đường viền và nền cho bảng? 

Câu 3: Trình bày công dụng thẻ Design và layout? 

KỸ NĂNG:  

A. YÊU CẦU :  Gõ và trình bày văn bản  sau và lưu lại với tên TH04A.DOC 

 

Hướng dẫn thực hành  

1. Nhắp chuột công cụ TAB    (bên trái cây thước) một vài lần đến khi xuất  

hiện các loại tab  ,   ,       .... theo yêu cầu. Nhắp chuột tại các mốc dừng cần 

đặt thước tab. 

NHƯ : Đặt tab giữa (center tab)  tại vị trí 1.25 và 4.5 cho “Công ty . . . . “ và 

“Cộng hòa. . . “ 

- Dòng tiêu đề căn giữa 

2. Đặt các mốc tab tại các vị trí trên các mốc dừng. Đặt right tab      tại vị trí 2 và 

5.88 trên cây thước. Tiếp tục đặt Decimal tab    tại các vị rí 2.75, 3.5 và 

4.25 trước khi gõ  “Mặt hàng ..... “ 

3. Dùng lệnh format / tab  chọn tab 2 đặt leader 2  rồi nhắp chọn nút set. Tiếp tục 

chọn tab 5.88 đặt leader 2 rồi nhắp chọn nút set. Cuối cùng nhắp chọn OK 

4. Quét chọn từ dòng “1. Hải sản.....” đến hết dòng “Da cá sấu ..... “ để kẻ đường 

viền trên và đường viền dưới : dùng lệng format / borders and shading 

 

 Công ty xuất nhập khẩu    Cộng hòa xã hôi chủ nghĩa việt Nam                 
 TP Hồ Chí Minh Độc lập - Tự do - Hạnh phúc 

   

TÌNH HÌNH XUẤT NHẬP KHẨU 

6 tháng đầu năm 2000 

 

MẶT HÀNG ĐVT QUÝ 1 QUÝ 2 CỘNG GHI CHÚ 

1. Hải sản chế biến : 

 Tôm đông lạnh.............. Tấn 23.50 115.73 139.23Thị trường Nhật

 .............................................  

 Tôm khô ......................... Kg 2500 3100 5600.00..... 70% sang Nhật 

 Bong bóng cá .................. Kg 688.85 1200.1 1888.95...........Hồng Kông 

 Khô mực ......................... Kg 3570 5000 8570.00...................... Nhật 

2. Súc sản, gia cầm chế biến : 

 Vịt đông lạnh ................ Con 3000 6500 9500.00................ Châu Âu 

 Da Bò thuộc .................... m2 2500.55 3123.3 5623.85...................... Pháp 

 Da Cá Sấu ....................... m2 250.6 423.15 673.75............... Châu Âu 
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B. YÊU CẦU :  Gõ và trình bày văn bản theo mẫu  sau va lưu lại với tên 

TH04B.DOC 

 HƯỚNG DẪN : - Dùng lệnh :insert/table / insert  table  

TRUỜNG CAO ÐẲNG NGHỀ ÐÀ NẴNG 

KHOA CÔNG NGHỆ THÔNG TIN 
 

 99 TÔ Hiến Thành . 0511. 940674 

CHIÊU SINH CÁC LỚP TIN HỌC 

TỔNG HỢP TÌNH HÌNH GHI DANH CÁC LỚP TIN HỌC 

LỚP HỌC 
KHÒA 

1/1998 

KHÒA 

1/1999 

KHÒA 

1/2000 

KHÒA 

1/2001 

TỔNG 

SỐ 

 TH CănBản 100 120 160 150 530 

 ĐT Văn Phòng 50 70 150 250 520 

 Foxpro 10 15 25 25 75 

 Pascal 15 15 20 15 65 

 C++ 0 0 0 5 5 

 Windows 50 50 60 50 210 

 Winword 100 200 200 200 700 

 Excel 70 80 100 140 390 

 Corel Draw 10 10 15 10 45 

 Access 0 0 10 30 40 

 Auto CAD 4 6 10 10 30 

TỔNG SỐ 409 566 750 885 2610 

TRUNG BÌNH 37,18 51,45 68,18 80,45 109,34 

 THỨ  

HAI - TƯ - SÁU 

THỨ 

BA - NĂM - BẢY 

 

SÁNG 

 

 7g 30 - 9g30    : Tin học CB (10/05) 

 9g30 - 11g30   :  Foxpro CB (10/05) 

 7g30 - 9g30  : Tin học VP (11/05) 

          (windows - winword - excel) 

 9g30 - 11g30 : pascal NC (15/05) 

 

CHIỀU 

 

 13g30 - 15 g30 : Pascal CB (14/05) 

 15g30 - 17g30  : Foxpro NC (19/05) 

 13g30 - 15 g30   : foxpro NC (19/05) 

 15g30 - 17g30  : Tin học CB (15/05) 

 

TỐI 
 18g - 20 g         : Tin học VP (18/05) 

            (windows - winword - excel) 

 18g - 20 g         : Foxpro CB (21/05) 
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Tổng Số Học  Viên là :  

 

 

Đánh giá 

kết quả học 

tập 

 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

người 

học 

I Kiến thức    

1  Trình bày được thao tác tạo 

bảng biểu 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

2  

2 Trình bày các thao tác trên 

bảng biểu: 

+ chèn/xóa dòng cột và  tách/ 

kết nối ô 

+ định dạng đường viền và 

nền cho bảng 

4  

3   Trình bày và nắm rõ công 

dụng thẻ Design và Layout 
4  

                                      Cộng: 10 đ  

II Kỹ năng    

1  Biết cách tạo bảng, chèn/xóa 

hàng cột , kết/tách ô 

  

 Quan sát, kiểm 

tra sản phẩm 

3 
 

2   Biết định dạng đường viền và 

nền cho bảng  
3 

 

STT HỌ TÊN 

ĐIỂM 

T
Ổ

N
G

 

C
Ộ

N
G

 

T
R

U
N

G
 B

ÌN
H

 

WORD EXCEL 
ACCES

S 

1 NGUYỄN T. KIM 

ÁNH 

2 6 4 12 4 

2 NGUYỄN KIM 

LINH 

4 5 6 15 5 

3 LÊ HỒNG NHUNG 10 4 6 20 6,67 

4 NGÔ THỊ LANH 8 6 7 21 7 

5 NGUYỄN THỊ 

PHÚC 

8 9 7 24 8 
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3 Biết cách chèn công thức toán 

học vào bảng 

trong và sau buổi 

thực hành 

  

  

2 
 

4  Biết sử dụng một số hàm toán 

học  đơn giản để tính toán 
2 

 

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1,5  

1.2 Không vi phạm nội quy lớp học 1,5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 

với thời gian quy 

định. 

2 

 

3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 1,5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1,5 

 

3.3 Vệ sinh phòng thựchànhđúng 

quy định 
1 

 

                              Cộng: 10 đ  

KẾT QỦA HỌC TẬP 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

    Cộng:  
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BÀI 6: BẢO MẬT VÀ IN ẤN 

 

Giới thiệu:  

In ấn là việc rất quan trọng, đặc biệt đối với những người mới học word, chưa có 

nhiều kỹ năng về in ấn. Qua các chức năng trong bài này, giúp ta biết cách bảo mật 

được file văn bản, quan sát được cấu trúc trang in, nội dung chi tiết trên trang in. 

Qua đó sẽ có những điều chỉnh hợp lí, kịp thời đối với tài liệu để khi in ra sẽ có được 

kết quả như  ý muốn. 

Mục tiêu:                    

- Thực hiện được thao tác tạo mật khẩu cho văn bản. 

- Chọn lựa chế độ và hiệu chỉnh trước khi in ấn. 

- Thực hiện được các thao tác trộn văn bản. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung:  

1.Bảo mật  

Tạo Password cho văn bản: 

+ Tại thẻ File, chọn  Info,  chọn Protect Docunment,  chọn Encrypt with 

Password 

+ Tại hộp Encrypt Documnent gõ vào Password, sau đó chọn OK  

+ Tại hộp Confirm Password, Gõ lại Password và nhấn chọn OK 

 

 

 

 

 

 

 

 

 

2. In ấn 

2.1 Định dạng trang in 
Mỗi khi tạo file mới, trong cửa sổ văn bản đã có sẵn một trang giấy trắng để bắt đầu 

soạn văn bản (thường là giấy letter hoặc giấy A4)  

- Tab Page Layout, nhóm Page Setup, chọn mũi tên dưới góc phải để mở hộp 

thoại Page Setup 

 

             Hình 6.1: Hộp thoại tạo Password 
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Chọn loại giấy 

– Tab Paper 

- Paper Size : 

chọn loại giấy, 

Nhấp thước 

tương ứng sẽ 

hiện ra trong 

width và height, nếu chọn Custom phải cho số đo Nhấp thước giấy trong width và 

height 

 

2.2. Đặt lề cho trang in 

 

Hình 6.3: Hộp thoại chọn loại giấy in(Paper) 

 
  Hình 6.2: Chọn nhóm Page Setup 
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- Top : Lề bên trên của 

trang in 

- Bottom : Lề bên dưới 

của trang in 

- Left : Lề trái của 

trang in 

- Right : Lề phải của 

trang in 

- Gutter : Khoảng cách 

dùng để đóng gáy sách 

- From edge: Khoảng 

cách từ mép của tờ giấy 

đến header hoặc footer 

- Orientation : chọn 

hướng in 

o Portrait : Giấy dọc 

o Landscape : Giấy 

ngang 

 

 

- Mirror margins : 

Đặt lề đối xứng nhau. 

Nếu lệnh này có dùng, 

giấy sẽ được phân biệt là có trang lẻ và trang chẵn (Odd and Even), thường áp dụng 

để in sách.  

2.3. In tài liệu  

-Thẻ File, chọn Print 

 

                      Hình 6.4:Đặt lề trang giấy 
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Hình 6.5 : In tài liệu 

 

- Copies: chọn số bản in 

- Printer : chọn tên máy in tương ứng đã được cài đặt trong Windows. Nếu máy in 

đang sử dụng không có tên trong danh sách này (nghĩa là chưa được khai báo) thì 

phải thực hiện các bước sau: 

o Nhắp Start, chọn Settings và nhắp Printers. 

o Nhắp đúp vào biểu tượng Add Printer. 

o Thực hiện các bước cài đặt máy in của chức năng Add Printer 

Wizard 

- Pages : in số trang chọn lựa bằng cách gõ các số trang vào, dùng dấu “,” để 

phân cách các trang rời, dấu gạch nối “-“ để in các trang liên tiếp 

3. Trộn văn bản 

3.1. Các khái niệm 

3.1.1. Trộn thư 
Trong thực tế, đôi khi chúng ta cần phải in văn bản gởi cho nhiều người chẳng hạn 

như thư mời, phiếu báo điểm, giấy chứng nhận, bằng tốt nghiệp. 

Thay vì phải gõ những thông tin của từng người vào nội dung của từng giấy chứng 

nhận (rất dễ nhằm lẫn), ta có thể dùng công cụ Mail Merge để giải quyết vấn đềtrên 

một cách nhanh chóng. 

3.1.2. Tập tin data source 
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Một file chứa dữ liệu nguồn thường được trình bày dưới dạng bảng biểu đơn giản 

như table, sheet (của Excel, Access) bảo đảm đủ số cột, hàng và nội dung trong các 

ô. 

3.1.3. Tập tin main document 

Một file văn bản mẫu đã được trình bày hoàn chỉnh 

Bước 1. Tạo tập tin Main chính trong WORD như sau 

Công Ty TNHH XYZ 

999 Pasteur, Q.1, TP.HCM 

8223344 Ngày 30 tháng 3 năm 2012 

THƯ MỜI 

----- 

Kính gởi: 

Sinh năm: 

Địa chỉ: 

Mời sắp xếp thời gian đến dự cuộc phỏng vấn tuyển nhân sự cho Công ty. 

Thời gian:  giờ,  ngày 

Địa điểm: 

                                                                         Giám đốc 

                                                                                  Trần Văn B 

Bước 2. Tạo tập tin nguồn dữ liệu trên Excel với các cột có tên tương ứng  

Bước 3. Trên tập tin Main chính trong Word 

Chọn Start Mail Merge trên tab Mailings và sau đ chọn Step by Step Mail Merge 

Wizard. 

 

Trình Wizard sẽ mở ra một cửa sổ bên phải tài liệu. Cửa sổ này có thể di chuyển 

bằng chuột đến một vị trí mới trên màn hình và cũng có thể thay đổi kích cỡ của nó. 

 

Để thực hiện merge mail cần phải qua 6 bước, làm theo hướng dẫn bằng cách 

chọn những tùy chọn phù hợp rồi nhấn Next ở dưới cùng của hộp thoại, nếu muốn 

quay lại thì nhấn vào Previous. 

Trong mục Select document type đã chọn sẵn Letters. Chọn Next qua bước 2 

 

Trong mục Select starting document đã chọn sẵn Use the current document. 

Chọn Next qua bước 3 
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Trong mục Select recipients nhấn nút Browse. Chọn 

va mở file danh sách excel đã lưu. 

 
Chọn Sheet1, OK 

 
Ở hộp thoại Mail Merge Recipents, ta có thể loại bỏ hoặc trích lọc những hàng không 

muốn tạo thư mời. 

Nhấn OK. 

Nhấn Next qua bước 4. 
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Trong mục Write your letter, nhấn chọn More items… 

Đặt con trỏ text ở vị trí xác định trong văn bản mẫu, nơi cần chèn dữ liệu vào, l ần 

lượt chèn các field vào trong main document như sau: 

 
Nhấn Next sang bước 5, ở bước này nhấn vào nút >> đề xem trước các thư mời tiếp 

theo 

 
Nhấn nút Next sang bước thứ 6. 
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Chọn Print nếu muốn in các thư mời trực tiếp ra máy in, chọn Edit indidual 

letters nếu muốn xem trước các thư mời trong văn bản. 

 
Trong hộp thoại Merge to New Document có thể chọn tạo ra toàn bộ các thư mời có 

trong danh sách hoặc chỉ chọn tạo thư mời cho một số người. 

 

BÀI  TẬP THỰC HÀNH WORD  5 

KIẾN THỨC 

Câu 1: Trình bày các bước và cách thực hiện trộn văn bản? 

Câu 2: Giả sử có văn bản thuctap.doc. Hãy thực hiện các yêu cầu sau: 

- Xem văn bản trước khi in 

- In các trang chẵn 

- In các trang lẻ 

- In tất cả các trang 

- In 3 bản thuctap.doc 

Câu 3: Trình bày các chức 

năng hộp thoại Page Setup? 
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KỸ NĂNG:  

YÊU CẦU :  

Dùng chức năng trộn văn bản để in giấy quyết định lương 

1) Soạn danh sách nhân viên được nâng lương và lưu vào file có tên 

“DanhSachNangLuong.doc”  

S

T

T 

Họ tên Tên ngạch 
Mã 

ngạch 

Từ hệ 

số 
Từ ngày Lên hệ số 

Tên đơn 

vị 

1 Lê Văn Thành Chuyên viên 1003 2.67 1/10/11 3.0 

Phòng 

hành 

chính 

2 Ngô Văn Hiền 
Chuyên viên 

chính 
1002 3.0 11/10/11 3.33 

Phòng 

hành 

chính 

3 Nguyễn Văn Liêm 
Chuyên viên cao 

cấp 
1001 5.08 15/5/11 5.42 

Phòng 

thiết bị 

4 Phạm Minh Kỹ sư 6033 3.33 11/12/11 3.33 
Phòng 

kỹ thuật 

5 Lê Lân 
Chuyên viên 

chính 

1002 

 
5.08 15/4/11 5.42 

Phòng 

quản trị 

6 Nguyễn Hương Chuyên viên 1003 3.66 5/9/11 3.99 
Phòng 

tài chính 

7 Lê Trà Chuyên viên 1003 4.65 8/7/11 4.98 

Phòng 

kinh 

doanh 
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1. Soạn mẫu như sau lưu với tên QĐNangLuong.doc  và thực hiện trộn QĐ nâng 

lương tự động cho các nhân viên 

BỘ GIÁO DỤC VÀ ĐÀO TẠO       CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

TRƯỜNG CAO ĐẲNG NGHỀ ĐÀ NẴNG Độc lập - Tự do - Hạnh phúc 

Số : 1234/TCCB-QĐNL    Đà Nẵng, ngày 31 tháng 12 năm 2011 

QUYẾT ĐỊNH CỦA HIỆU TRƯỞNG 

V/v nâng bậc lương cho nhân viên năm 2011 

HIỆU TRƯỞNG 

- Căn cứ Nghị định số 25/CP ngày 23/05/1993 của Chính phủ ban hành tạm thời chế độ tiền 

lương của Công chức, viên chức hành chính, sự nghiệp; 

- Căn Thông tư số 04/1999/TT-TCCP ngày 20/03/1999 của Ban Tổ chức Cán bộ Chính phủ, 

hướng dẫn thực hiện Nghị định số 95/1998/NĐ-CP của Chính phủ về tuyển dụng, sử dụng và 

quản lý công chức; 

- Theo đề nghị của Ông/Bà Trưởng phòng TCHC. 

QUYẾT ĐỊNH 

Điều 1: Nâng bậc lương cho Ông (Bà): 

Đơn vị : 

Ngạch :    Mã số: 

Từ hệ số : 

Lên hệ số:    kể từ ngày 

Điều 2: Ông (Bà) có tên ở điều 1 chịu trách nhiệm thi hành quyết định này. 

HIỆU TRƯỞNG 

Nơi nhận: 
- Như điều 2. 

- Lưu VT, TCHC 
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3. Tạo PassWord 123456 cho file QĐNangLuong.doc cho file  

4. In file QĐNangLuong.doc  

Đánh giá kết quả học tập 
 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

người 

học 

I Kiến thức    

1   Trình bày được các bước và 

cách thực hiện trộn văn bản 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

2  

2  Thực hiện được  cách in ấn 

văn bản theo nội dung yêu cầu 
4  

3   Trình bày được các chức 

năng hộp thoại Page Setup  
4  

                                      Cộng: 10 đ  

II Kỹ năng    

1  Biết cách trộn văn bản   

 Quan sát, kiểm 

tra sản phẩm 

trong và sau buổi 

thực hành 

  

  

6  

2  Tạo Password    2  

3  In ấn 

2 

 

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1,5  

1.2 Không vi phạm nội quy lớp học 1,5  
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1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 

với thời gian quy 

định. 

2 

 

3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp Theo dõi việc 

thực hiện, đối 

chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 1,5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1,5 

 

3.3 Vệ sinh phòng thựchànhđúng 

quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

                                                                                              

Cộng: 

 

 



 Trang 110  

BÀI 7: TỔNG QUAN VỀ BẢNG TÍNH EXCEL 

 

Giới thiệu: 

Hằng ngày công việc thường xuyên nhất của một nhân viên văn phòng đó là 

soạn thảo văn bản. Đây là một công việc dễ gây nhàm chán. Nhưng nếu chúng ta là 

một kế toán viên thì công việc tính toán là công việc gần gũi nhất. Để phục vụ cho 

công việc tính toán đầy căng thẳng và đảm bảo tính chính xác tuyệt đối cũng như 

qui mô tính toán và độ phức tạp của nó Microsoft viết ra một trình ứng dụng chuyên 

về tính toán đó là MS Excel. 

Mục tiêu: 

- Trình bày được khái niệm về bảng tính; 

-  Mô tả được cách thức tổ chức làm việc trên bảng tính; 

- Thực hiện các thao tác an toàn với máy tính. 

1 Giới thiệu Excel  

1.1 Excel là gì: 

Microsoft Excel là một phần mềm hay là một chương trình ứng dụng, mà khi chạy 

chương trình ứng dụng này sẽ tạo ra một bảng tính và bảng tính này giúp ta dễ dàng 

hơn trong việc thực hiện: 

 Tính toán đại số, phân tích dữ liệu 

 Lập bảng biểu báo cáo, tổ chức danh sách 

 Truy cập các nguồn dữ liệu khác nhau 

 Vẽ đồ thị và các sơ đồ 

 Tự động hóa các công việc bằng các macro 

 Và nhiều ứng dụng khác để giúp chúng ta có thể phân tích nhiều loại hình bài toán 

khác nhau. 

Trình bày các khái niệm: 

Ribbon là gì? 

Ribbon: Excel 2010 thay đổi giao diện người dùng từ việc sử dụng các thanh thực 

đơn truyền thống thành các cụm lệnh dễ dàng truy cập được trình bày ngay trên màn 

hình gọi là Ribbon. Có các nhóm Ribbon chính: Home, Insert, Page Layout, 

Formulas, Data, Reviews, View, Developer, Add-Ins. 
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Thanh công cụ Ribbon 

Home: Là nơi chứa các nút lệnh được sử dụng thường xuyên trong quá trình làm 

việc như: cắt, dán, sao chép, định dạng tài liệu, các kiểu mẫu có sẵn, chèn hay xóa 

dòng hoặc cột, sắp xếp, tìm kiếm, lọc dữ liệu,… 

Insert: Chèn các loại đối tượng vào bảng tính như: bảng biểu, vẽ sơ đồ, đồ thị, ký 

hiệu, … 

Page Layout: Chứa các nút lệnh về việc hiển thị bảng tính và thiết lập in ấn. 

Formulas: Chèn công thức, đặt tên vùng (range), 

công cụ kiểm tra theo dõi công thức, điều khiển việc tính toán của Excel. 

Data: Các nút lệnh thao đối với dữ liệu trong và ngoài Excel, các danh sách, phân 

tích dữ liệu,… 

Review: Các nút lệnh kiễm lỗi chính tả, hỗ trợ dịch từ, thêm chú thích vào các ô, các 

thiết lập bảo vệ bảng tính. 

View: Thiết lập các chế độ hiển thị của bảng tính như: phóng to, thu nhỏ, chia màn 

hình, … 

Developer: Tab này mặc định được ẩn vì nó chỉ hữu dụng cho các lập trình viên, 

những người có hiểu biết về VBA. Để mở nhóm này nhấn vào nút Office ->Excel 

Options ->Popular ->Chọn Show Developer tab in the Ribbon. 

Add-Ins: Tab này chỉ xuất hiện khi Excel mở một tập tin có sử dụng các tiện ích bổ 

sung, các hàm bổ sung,… 

Sử dụng thực đơn ngữ cảnh (shortcut menu) 

Khi muốn thực hiện một thao tác nào đó trên đối tượng (ô, vùng, bảng biểu, đồ thị, 

hình vẽ…) trong bảng tính, chúng ta hãy nhấp phải chuột lên đối tượng đó. Lập tức 
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một thanh thực đơn hiện ra chứa các lệnh thông dụng có thể hiệu chỉnh hay áp dụng 

cho đối tượng mà chúng ta chọn. 

 

Thực đơn ngữ cảnh 

1.2 Mô tả cấu trúc của một bảng tính: 

 Workbook: Trong Excel, một workbook là một tập tin mà trên đó chúng ta làm 

việc (tính toán, vẽ đồ thị, …) và lưu trữ dữ liệu. Vì mỗi workbook có thể chứa 

nhiều sheet (bảng tính), do vậy chúng ta có thể tổ chức, lưu trữ nhiều loại thông 

tin có liên quan với nhau chỉ trong một tập tin (file). Một workbook chứa rất nhiều 

worksheet hay chart sheet tùy thuộc vào bộ nhớ máy tính của chúng ta. 

 Worksheet: Còn gọi tắt là sheet, là nơi lưu trữ và làm việc với dữ liệu, nó còn được 

gọi là bảng tính. Một worksheet chứa nhiều ô (cell), các ô được tổ chức thành các 

cột và các dòng. Worksheet được chứa trong workbook. Một Worksheet chứa được 

16.384 cột và 1.048.576 dòng (phiên bản cũ chỉ chứa được 256 cột và 65.536 

dòng). 

 Chart sheet: Cũng là một sheet trong workbook, nhưng nó chỉ chứa một đồ thị. 

Một chart sheet rất hữu ích khi chúng ta muốn xem riêng lẻ từng đồ thị. 

 Sheet tabs: Tên của các sheet sẽ thể hiện trên các tab đặt tại góc trái dưới của cửa 

sổ workbook. Để di chuyển từ sheet này sang sheet khác ta chỉ việc nhấp chuột 

vào tên sheet cần đến trong thanh sheet tab. 
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Các thành phần của Workbook 

Excel 2010 dùng định dạng tập tin mặc định là “.XLSX” (dựa trên chuẩn XML giúp 

việc trao đổi dữ liệu giữa các ứng dụng được dễ dàng hơn) thay cho định dạng chuẩn 

trước đây là “.XLS”. 

 

Giao diện Excel 2010 

 Nút lệnh Office chứa các lệnh rất thường hay sử dụng như tạo tập tin mới, mở tập 

tin, lưu tập tin, … và danh mục các tập tin đã mở trước đó. Nút lệnh Office giống 

như thực đơn File của các phiên bản trước.  

 Chúng ta có thể chế biến thanh các lệnh truy cập nhanh chứa các lệnh mà ta hay 

sử dụng nhất. Nhấn vào  để mở danh mục các lệnh và vào các lệnh cần cho 

hiện lên thanh lệnh truy cập nhanh. Nếu các nút lệnh ở đây còn quá ít chúng ta có 

thể nhấn chọn More Commands… để mở cửa sổ điều chế thanh lệnh truy cập 

nhanh 
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Các lệnh trong thực đơn Office  

 

Bảng lựa chọn lệnh truy cập nhanh 

 

Hộp thoại để chế biến thanh các lệnh truy cập nhanh 
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2. Các lệnh cơ bản đối với bảng tính 

2.1 Tạo mới workbook  

Chọn nút Office ->New, một hộp thoại hiện ra (xem hình bên dưới) cung cấp nhiều 

lựa chọn để tạo workbook như: workbook trống, workbook theo mẫu dựng sẵn, 

workbook dựa trên một workbook đã có. Để tạo workbook trống, chúng ta chọn 

Blank workbook và nhấp nút Create. 

 

2.2 Mở workbook có sẵn trên đĩa 

Một tập tin có sẵn có thể được mở bằng nhiều cách: 

1. Chọn nút Office ->chọn tên tập tin trong danh sách Recent Documents, có 

thể có tối đa 50 tên tập tin được sử dụng gần đây nhất trong danh sách này (để 

điều chỉnh thì nhấn vào nút Office ->Excel Options ->Advance ->phần 

Display ->Show this number of Recent Documents ). 

2. Dùng trình quản lý tập tin như Windows Explorer, tìm đến nơi lưu trữ tập 

tin và nhấp chuột hai lần lên tên tập tin. 

3. Chọn nút Office ->Open, hộp thoại Open hiện ra. Trong hộp thoại Open, 

chúng ta phải tìm đến nơi lưu trữ tập tin (tại Look In) và chọn tên tập tin cần 

mở sau đó nhấn nút Open để mở tập tin. Các tùy chọn của nút Open trong hộp 

thoại Open: Open (mở bình thường), Open Read-Only (Không lưu đè được 
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những thay đổi), Open as Copy (Tạo bản sao của tập tin và mở ra), Open in 

Browser (Mở tập tin bằng trình duyệt web mặc định), Open and Repair (Rất 

hữu dụng trong trường hợp tập tin bị lỗi). 

 

2.3 Lưu workbook 

ột điều cần lưu ý khi làm việc trên máy tính là các chúng ta phải nhớ thực hiện lệnh 

lưu lại công việc đã thực hiện thường xuyên. Việc ra lệnh lưu trữ không tốn nhiều 

thời gian nhưng nếu máy bị hỏng hay cúp điện đột ngột có thể mất tong cả giờ làm 

việc của chúng ta. Nhằm an toàn cho dữ liệu, chúng ta nên bật tính năng Auto 

Recover, Excel sẽ tự động thực hiện lệnh lưu theo thời gian qui định (mặc định là 

10 phút lưu một lần). Để sử dụng tính năng Auto Recover chúng ta chọn nút Office 

->Excel Options ->Save Save AutoRecover 

information every  minutes. 

Một số cách lưu workbook: 

1. Chọn nút Office ->Save 

2. Nhấp chuột lên nút  trên thanh lệnh truy cập nhanh (Quick Access Tollbar). 

3. Dùng tổ hợp phím <Ctrl+S> hoặc <Shift+F12>. 

Nếu tập tin đã được lưu trước đó rồi thì Excel sẽ lưu tiếp các phần cập nhật, còn nếu 

là tập tin được ra lệnh lưu lần đầu thì hộp thoại Save As hiện ra. Trong hộp thoại 

Save As, chúng ta hãy chọn nơi lưu trữ tập tin (tại Look In) và đặt tên cho tập tin tại 
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hộp File name, chọn kiểu tập tin tại Save as type và sau đó nhấn nút Save để lưu 

trữ. 

 

Minh họa lưu tập tin 

Qui tắt đặt tên: Đặt tên tập tin Excel dùng chung qui tắt đặt tên tập tin của 

Windows. Tên tập tin có thể dài tới 255 ký tự bao gồm cả khoảng trắng. Tuy nhiên 

trong tên tập tin không được dùng các ký hiệu như: \ ? : * “ < > | 

Để bảo mật tập tin, chúng ta có thể gán mật mã bảo vệ, khi đó cần phải biết 

mật mã mới được phép mở tập tin (trừ những cách tà đạo!). 

B1. Nhấn nút Office ->Save As, hộp thoại Save As hiện ra. 

B2. Nhấn nút Tools ->chọn General Options…, hộp thoại General Options hiện ra 

B3. Nhập mật mã mở và hiệu chỉnh workbook (hai mật mã này nên khác nhau để 

tăng bảo mật). Sau đó nhấn nút OK 

B4. Xác nhận lại mật mã mở workbook. Sau đó nhấn nút OK 

B5. Xác nhận lại mật mã hiệu chỉnh workbook. Sau đó nhấn nút OK 

B6. Nhấn nút Save để hoàn tất. 
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Dùng mật mã bảo vệ workbook 

Các tùy chọn trong hộp General Options: Always create backup (tạo bản sao có 

đuôi *.xlk trước khi gán mật mã), Password to Open (mật mã để mở workbook), 

Password to modify (mật mã để cập nhật nội dung workbook), Read-only 

recommended (mở dưới dạng chỉ đọc). 

2.4 Đóng workbook 

Một số cách đóng workbook: 

1. Chọn nút Office ->Close 

2. Dùng chuột chọn nút  ở góc trên bên phải (trên thanh tiêu đề). 

3. Dùng tổ hợp phím <Ctrl+F4> hoặc <Ctrl+W>. Nếu workbook có sự thay đổi nội 

dung thì Excel sẽ nhắc chúng ta lưu lại các thay đổi đó. 

* Sắp xếp workbook 

Chi mở nhiều 

workbook cùng lúc và 

cần tham khảo qua lại, 

để thuận tiện ta nên sắp 

xếp lại: Rê chuột nhấn 

vào nhóm lệnh View -

>chọn nút 

Arrange All ->Chọn   Sắp xếp các workbook trong cửa sổ Excel 

kiểu bố trí thích hợp. 
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3. Các thao tác căn bản trên một bảng tính 

3.1. Di chuyển trong bảng tính và sử dụng phím tắt 

Chúng ta có thể dùng chuột, các phím ->, thanh cuốn dọc, thanh cuốn ngang, sheet 

tab, các tổ hợp phím tắt đề di chuyển qua lại giữa các sheet hay đi đến các nơi bất 

kỳ trong bảng tính. 

Thanh cuốn dọc, thanh cuốn ngang 

Thanh cuốn dọc và thanh cuốn ngang được gọi chung là các thanh cuốn (scroll bars). 

Bởi vì màn hình Excel chỉ có thể hiển thị (cho xem) một phần của bảng tính đang 

thao tác, nên ta phải dùng thanh cuốn dọc để xem phần bên trên hay bên dưới bảng 

tính và dùng thanh cuốn ngang để xem phần bên trái hay bên phải của bảng tính.  

-Thanh cuốn dọc là thanh dài nhất, nằm dọc ở bên lề phải; hai đầu có hai mũi tên lên 

và mũi tên xuống; ở giữa có thanh trượt để cuốn màn hình lên xuống. 

-Thanh cuốn ngang là thanh nằm ngang, thứ hai từ dưới màn hình đếm lên. Có hình 

dạng giống thanh cuốn dọc, chỉ khác là nằm ngang. 

 

Thanh cuốn ngang 

Thao tác: 

-Nhấp chuột vào mũi tên sang trái để cuốn màn hình đi sang trái. 

-Nhấp chuột vào mũi tên sang phải để cuốn màn hình sang phải. 

Thanh Sheet tab 

Để di chuyển qua lại giữa các sheet ta nhấp chuột lên tên của sheet trên thanh sheet 

tab. Ngoài ra chúng ta có thể dùng <Ctrl + Page Up> để di chuyển đến sheet liền 

trước sheet hiện hành và <Ctrl+Page Down> để di chuyển đến sheet liền sau sheet 

hiện hành. Để trở về sheet đầu tiên chúng ta nhấp chuột và nút  trên thanh sheet 

tab và để đến sheet cuối cùng thì chúng ta nhấp chuột vào nút trên thanh  sheet 

tab. Nếu muốn đến một sheet nào đó trong trường hợp có quá nhiều sheet thì chúng 

ta hãy nhấp phải chuột vào thanh  và chọn tên sheet cần đến. 
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Sử dụng các tổ hợp phím tắt để di chuyển 

Để đến được nơi cần thiết trong bảng tính ngoài việc dùng chuột cuốn các 

thanh cuốn ngang và dọc, các phím mũi tên thì chúng ta nên nhớ các tổ hợp phím ở 

bảng bên dưới để giúp di chuyển được nhanh hơn. 

Các phím tắt di chuyển nhanh trong bảng tính 

3.2 Chọn vùng làm việc: 

Thao tác với ô và vùng 

Nhận dạng ô và vùng (cells, range) 

Địa chỉ một ô trong Excel được xác định bởi tiêu đề cột và số thứ tự của dòng. 

Một vùng trong bảng tính được xác định bằng địa chỉ của ô ở góc trên bên trái của 

vùng và địa chỉ ô góc dưới bên phải của vùng (có dấu : phân cách). Đặc biệt, địa chỉ 

Nhấn phím Di chuyển 

→ hoặc Tab  Sang ô bên phải  

← hoặc Shift + Tab  Sang ô bên trái  

↑  Lên dòng  

↓  Xuống dòng  

Home  Đến ô ở cột A của dòng hiện hành  

Ctrl + Home  Đến địa chỉ ô A1 trong worksheet  

Ctrl + End  Đến địa chỉ ô có chứa dữ liệu sau cùng trong worksheet  

Alt + Page Up  Di chuyển ô hiện hành qua trái một màn hình  

Alt + Page Down  Di chuyển ô hiện hành qua phải một mành hình  

Page Up  Di chuyển ô hiện hành lên trên một màn hình  

Page Down  Di chuyển ô hiện hành xuống dưới một màn hình  

F5  Mở hộp thoại Go To  

End + → hoặc Ctrl + 

→ 
Đến ô bên phải đầu tiên mà trước hoặc sau nó là ô trống  

End + ← hoặc Ctrl + 

← 
Đến ô bên trái đầu tiên mà trước hoặc sau nó là ô trống  

End + ↑ hoặc Ctrl + ↑  Lên ô phía trên đầu tiên mà trên hoặc dưới nó là ô trống  

End + ↓ hoặc Ctrl + ↓  Xuống ô phía dưới đầu tiên mà trên hoặc dưới nó là ô trống 

Ctrl + Page Up  Di chuyển đến sheet phía trước sheet hiện hành  

Ctrl + Page Down  Di chuyển đến sheet phía sau sheet hiện hành  
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của cả một cột hoặc dòng được xác định là <tên cột>:<tên cột> (ví dụ cột A thì được 

xác định ngắn gọn là A:A) và <số dòng>:<số dòng> (ví dụ địa chỉ của cả một dòng 

4 là 4:4).  

Ví dụ: Hình bên dưới ô hiện hành có địa chỉ là B11 vì nó có tiêu đề cột là B và số 

dòng là 11, vùng được bao bởi nét chấm đứt có địa chỉ là H2:H12 vì ô đầu tiên của 

vùng có địa chỉ là H2 và ô cuối của vùng là H12. 

 

 Địa chỉ ô và vùng 

Chọn vùng 

Nếu dùng chuột, trước tiên chúng ta dùng chuột di chuyển ô hiện hành đến 

góc trên bên trái của vùng cần chọn, sau đó giữ trái chuột kéo xuống dưới qua phải 

đến vị trí ô cuối cùng của vùng và thả chuột. Nếu dùng phím thì sau khi chọn ô đầu 

tiên chúng ta giữ phím Shift trong khi nhấn phím ->v

và thả các phím. (Chúng ta cũng có thể làm ngược lại là chọn ô cuối của vùng trước 

và kéo chọn đến ô đầu tiên). 

Khi muốn chọn cả sheet hiện hành thì nhấn <Ctrl+A>, còn muốn chọn cả 

workbook (nghĩa là chọn tất cả các sheet) thì nhấp phải chuột lên thanh sheet tab và 

chọn Select All Sheets. 

3.3 Chèn ô, dòng và cột trong bảng tính 

Chúng ta có thể chèn thêm các ô vào bên trái hoặc bên trên của ô hiện hành 

trong worksheet và dịch chuyển các ô đang chọn qua phải hoặc xuống dưới. Tương 
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tự, ta có thể chèn thêm các dòng bên trên, chèn thêm các cột vào bên trái và có thể 

xóa đi các ô, các dòng và cột. 

Chèn ô trống 

B1. Chọn các ô mà chúng ta muốn chèn các ô trống vào đó (muốn chọn các ô không 

liên tục thì giữ Ctrl trong khi chọn các ô). 

B2. Chọn Home->chọn nhóm Cells ->Insert ->Insert Cells… B3. Chọn lựa chọn 

phù hợp trong hộp thoại Insert 

Chèn dòng 

B1. Chọn một hoặc nhiều dòng liên tục hoặc cách khoảng mà chúng ta 

muốn chèn số dòng tương ứng phía trên các dòng này. 

B2. Chọn Home ->chọn nhóm Cells ->Insert ->Insert Sheet Rows 

 

 Minh họa chèn các dòng trống lên trên các dòng đang chọn 

Chèn cột 

B1. Chọn một hoặc nhiều cột liên tục hoặc cách khoảng mà chúng ta muốn chèn số 

cột tương ứng phía bên trái các cột này. 

B2. Chọn Home ->chọn nhóm Cells ->Insert ->Insert Sheet Columns  

3.4 Xóa các ô, dòng và cột 

B1. Chọn các ô, các dòng hoặc các cột cần xóa 
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B2. Chọn Home ->Cells ->Delete ->chọn kiểu xóa phù hợp (xem hình) 

 

3.5 Thay đổi độ rộng cột và chiều cao dòng 

Trong worksheet ta có thể qui định độ rộng cột từ 0 đến 255, đây chính là số 

ký tự có thể hiển thị trong một dòng. Độ rộng mặc định của cột là 8.43 ký tự, khi độ 

rộng là 0 thì cột được ẩn đi. Tương tự, chiều cao của dòng qui định từ 0 đến 409, 

đây là đơn vị đo lường bằng điểm (point: 1 point = 1/72 inch). Chiều cao mặc định 

của dòng là 12.75 point, khi chiều cao là 0 thì dòng bị ẩn đi. Các bước điều chỉnh 

dòng cột: 

B1. Chọn dòng hoặc cột cần điều chỉnh chiều cao hoặc độ rộng 

B2. Chọn Home ->Cells ->Format ->Chọn lệnh phù hợp 

- Row Height… chọn lệnh này để qui định chiều cao của dòng 

- AutoFit Row Height chọn lệnh này Excel sẽ tự canh chỉnh chiều cao dòng cho phù 

hợp với nội dung. 

- Column Width… chọn lệnh này để qui định độ rộng cột 

- AutoFit Column Width chọn lệnh này Excel sẽ tự canh chỉnh độ rộng cột cho phù 

hợp với nội dung. 

- Default Width… chọn lệnh này khi chúng ta muốn qui định lại độ rộng mặc định 

cho worksheet hay cả workbook. Ta có thể qui định chiều cao dòng và độ rộng cột 

cho cả worksheet hay cả workbook bằng cách chọn cả worksheet hay cả workbook 

trước khi thực hiện lệnh. Ngoài cách thay đổi chiều cao dòng và độ rộng cột như 

trên, ta còn có thể dùng chuột để thao tác nhanh hơn. Muốn thay đổi độ rộng cột nào 
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hãy rê chuột đến phía bên phải tiêu đề cột đó cho xuất hiện ký hiệu và kéo chuột về 

bên phải để tăng hoặc kéo về bên trái để giảm độ rộng cột. Tương tự, muốn thay đổi 

chiều cao dòng nào hãy rê chuột đến bên dưới số thứ tự dòng cho xuất hiện ký hiệu 

và kéo chuột lên trên để giảm hoặc kéo xuống dưới để tăng chiều cao dòng. 

Ta có thể qui định chiều cao dòng và độ rộng cột cho 

cả worksheet hay cả workbook bằng cách chọn cả 

worksheet hay cả workbook trước khi thực hiện lệnh. 

Ngoài cách thay đổi chiều cao dòng và độ rộng cột như 

trên, ta còn có thể dùng chuột để thao tác nhanh hơn. 

Muốn thay đổi độ rộng cột nào hãy rê chuột đến phía 

bên phải tiêu đề cột đó cho xuất hiện ký hiệu  và 

kéo chuột về bên phải để tăng hoặc kéo về bên trái để 

giảm độ rộng cột. Tương tự, muốn thay đổi chiều cao 

dòng nào hãy rê chuột đến bên dưới số thứ tự dòng cho 

xuất hiện ký hiệu  và kéo chuột lên trên để giảm 

hoặc kéo xuống dưới để tăng chiều cao dòng. 

 

* Nối nhiều ô thành một ô 

Khi nối nhiều ô thành một ô, nếu tất cả các ô đều có dữ 

liệu thì chúng ta cần chuyển hết dữ liệu lên ô ở góc trên 

cùng bên trái của nhóm ô cần merge vì chỉ có dữ liệu của 

ô này được giữ lại, dữ liệu của các ô khác sẽ bị xóa. 

B1. Chọn các ô cần nối lại. 
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B2. Chọn Home ->Alignment ->chọn Merge & Center. Để canh chỉnh dữ liệu trong 

ô dùng các nút canh chỉnh trong nhóm Algnment. 

* Chuyển một ô đã nối về lại nhiều ô 

Sau khi chuyển ô đã nối về lại nhiều ô thì nội dung sẽ hiện tại ô ở góc trên cùng bên 

trái. 

B1. Chọn ô đang bị nối. 

B2. Chọn Home ->Alignment ->chọn lại Merge & Center hoặc Unmerge Cells đều 

được. 

3.6 Sao chép và di chuyển vùng 

Sao chép (copy) giúp ta nhân bản một vùng nào đó đến một nơi nào đó trong bảng 

tính và dữ liệu gốc còn nguyên, còn di chuyển vùng thì cũng như sao chép nhưng dữ 

liệu gốc sẽ được di dời đến vị trí mới. Để sao chép hay di chuyển trước tiên chúng 

ta phải chọn vùng cần sao chép hay di chuyển, sau đó có thể dùng nút lệnh, phím tắt 

hay dùng chuột để thực hiện: 

- Dùng Ribbon: Chọn vùng ->Home ->nhóm Clipboard ->nhấn nút  hay  

(Copy hay Cut), đến nơi đích và Home ->nhóm Clipboard ->nhấn nút   (Paste). 

Chúng ta có thể gọi các lệnh trên từ thực đơn ngữ cảnh ->nhấp phải chuột. 

- Chuột: Chọn vùng ->giữ trái chuột và giữ thêm phím Ctrl nếu là sao chép (không 

giữ thêm phím Ctrl sẽ là lệnh di chuyển) ->kéo chuột tới nơi đích cần sao chép hay 

di chuyển đến và thả chuột. 

Dán đặc biệt (Paste Special) 

Trong quá trình sao chép đôi khi chúng ta 

cần dán nội dung đã sao chép hay cắt từ bộ 

nhớ vào với một số chọn lọc nào đó, khi đó 

thay vì dùng lệnh Paste chúng ta hãy sử 

dụng Paste Special… Sau khi chọn vùng, 

ra lệnh Copy, đến đích cần sao chép đến và 

nhấp phải chuột, chọn lệnh Paste 

Special…. hộp thoại Paste Special có một số lựa chọn như bảng sau: 

Hạng mục Mô tả 

All Dán cả giá trị và định dạng của vùng nguồn  
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Formulas Dán giá trị và công thức, không định dạng  

Values Chỉ dán giá trị và kết quả của công thức, không định dạng  

Formats Chỉ dán vào định dạng, bỏ qua tất cả giá trí và công thức  

Comments Chỉ dán vào chú thích của các ô, bỏ qua tất cả giá trí và 

công thức  

Validation Chỉ dán vào các qui định xác thực dữ liệu cho vùng đích  

All using source 

theme 

Dán vào mọi thứ và dùng mẫu định dạng từ vùng nguồn  

All except borders Dán vào mọi thứ và loại bỏ các khung viền  

Column widths Chỉ dán vào thông tin qui định chiều rộng cột  

Formulas and 

number formats  

Dán vào giá trị, công thức và các định dạng gốc của các 

con số, các định dạng khác bị loại bỏ.  

Values and number 

formats  

Dán vào giá trị, kết quả của công thức và các định dạng gốc 

của các con số.  

None Không kèm theo việc tính toán nào trên dữ liệu sắp dán vào  

Add Cộng các giá trị của vùng nguồn vào các ô tương ứng ở 

vùng đích  

Subtract Các ô mang giá trị của vùng đích sẽ trừ đi các ô tương ứng 

của vùng nguồn.  

Multiply Các ô mang gia trị của vùng đích sẽ nhân với các ô tương 

ứng của vùng nguồn.  

Divide Các ô mang gia trị của vùng đích sẽ chia cho các ô tương 

ứng của vùng nguồn 

Skip blanks . Không dán đè các ô rỗng ở vùng nguồn vào ô có giá trị ở 

vùng đích  

Transpose Dán vào và đảo dòng thành cột hoặc ngược lại  

Paste Link Dán vào và tham chiếu ô đích đến ô nguồn  

4. Làm việc với dữ liệu trong Excel 

2.1. Nhập liệu, hiệu chỉnh 

Các ô trong bảng tính có thể chứa các con số, các chuỗi văn bản hay các biểu thức 

toán học. Ngoài ra bảng tính còn có thể chứa các biểu đồ, sơ đồ, hình ảnh, … các 

đối tượng này không chứa trong ô mà nổi trên bề mặt bảng tính. 

Nhập số, chuỗi, thời gian, ngày tháng năm 

B1. Trên worksheet, chọn ô cần nhập liệu 

B2. Nhập vào con số, chuỗi văn bản, ngày tháng hay thời gian,… mà chúng ta cần 

B3. Nhập xong nhấn Enter (ô hiện hành chuyển xuống dưới) hoặc Tab (ô hiện hành 

chuyển qua phải) để kết thúc. 
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Lưu ý: 

- Nếu nhập các con số vào mà Excel hiển thị ##### là do chiều rộng cột không đủ 

chúng ta bản tăng thêm chiều rộng cột. 

- Mặc định Excel sẽ dùng dấu chấm (.) để phân cách phần số nguyên và phần số thập 

phân. 

- Khi nhập các con số mà các con số này không cần tính toán thì chúng ta nên định 

dạng ô là Text trước khi nhập (Home ->nhóm Number ->chọn Text từ danh sách). 

- Ngày và thời gian nhập vào ô thì nó dùng định dạng ngày mặc định trong Control 

Panel ->Regional and Language Options. 

- Khi nhập ngày dùng dấu / hoặc - để phân cách, ví dụ 10/05/2007 hoặc 10-05-2007. 

Khi muốn nhập ngày hiện tại vào ô hãy gõ <Ctrl+;>. Khi muốn dùng định dạng ngày 

mặc định cho ô chứa ngày thì chọn ô và gõ <Ctrl+Shift+#>. 

- Khi nhập thời gian và muốn định dạng theo chuẩn 12 giờ thì thêm A hoặc P vào 

sau thời gian nhập vào, ví dụ 8:30 AM hoặc 4:15 PM, nếu không Excel tự hiểu là 

AM. Khi muốn nhập thời gian hiện tại vào ô hãy gõ <Ctrl+Shift+;>. Khi muốn dùng 

định dạng thời gian mặc định cho ô chứa thời gian thì chọn ô và gõ <Ctrl+Shift+@>. 

Muốn nhập cùng một nội dung cho nhiều ô, chúng ta hãy chọn các ô và nhập liệu 

vào sau đó nhấn <Ctrl+Enter>. Ngoài ra còn có thể sử dụng chức năng AutoFill 

(phần sau). Muốn nhập cùng nội dung trên các ô ở nhiều sheet, chúng ta hãy chọn 

các sheet đó, sau đó chọn các ô trên sheet hiện hành, tiếp theo nhập liệu (có thể mất 

dữ liệu do bị nhập đè lên các ô có dữ liệu). Để bỏ chọn các sheet thì nhấp phải chuột 

lên thanh sheet tab và chọn Ungroup Sheets. 
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Ví dụ nhập các loại dữ liệu 

Nhập đè lên ô có sẵn nội dung:  

Muốn nhập đè lên các ô có sẵn nội dung, trước tiên hãy chọn ô đó và nhập 

vào nội dung mới. Khi đó, nội dung cũ của ô sẽ mất đi và thay bằng nội dung vừa 

nhập đè. 

Hiệu chỉnh nội dung các ô: 

Muốn hiệu chỉnh nội dung sẵn có của ô chúng ta làm các cách sau: 

1. Nhấp chuột hai lần lên ô cần hiệu chỉnh ->dùng chuột hoặc các phím mũi tên di 

chuyển đến nơi cần hiệu chỉnh , dùng phím Backspace hoặc Delete để xóa một số 

nội dung sau đó nhập vào nội dung mới. 

2. Chọn ô cần hiệu chỉnh và nhấn F2 để vào chế độ hiệu chỉnh và làm tương tự như 

trên 

3. Chọn ô cần hiệu chỉnh, sau đó nhấp chuột vào thanh công thức (Formula) 

Sử dụng các kỹ thuật khi nhập liệu 

Sử dụng chức năng AutoFill 

Sử dụng công cụ này Excel sẽ giúp chúng ta điền tự động dữ liệu theo các 

mẫu AutoFill có sẵn. Ngoài ra chúng ta còn có thể tạo thêm các mẫu phục vụ cho 

công việc của mình. 

Danh sách một số AutoFill có sẵn 
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Các giá trị khởi đầu Chuỗi sau khi mở rộng 

1, 2, 3 4, 5, 6 

9:00 10:00, 11:00, 12:00 

Mon Tue, Wed, Thu 

Monday Tuesday, Wednesday, Thursday 

Jan Feb, Mar, Apr 

Jan, Apr  Jul, Oct, Jan 

Jan-99, Apr-99 Jul-99, Oct-99, Jan-00 

15-Jan, 15-Apr 15-Jul, 15-Oct 

1999, 2000 2001, 2002, 2003 

1-Jan, 1-Mar 1-May, 1-Jul, 1-Sep,... 

Qtr3 (or Q3 or Quarter3) Qtr4, Qtr1, Qtr2,... 

Product 1, On backorder Product 2, On backorder, Product 3, On 

backorder,... 

Text1, textA text2, textA, text3, textA,... 

1st Period 2nd Period, 3rd Period,... 

Product 1 Product 2, Product 3,... 

- Chúng ta muốn điền các số lẻ trong khoảng từ 1 đến 25 vào cột A chúng ta làm 

như sau: 

B1. Chọn ô đầu tiên A1 và nhập vào số 1 

B2. Chọn ô tiếp theo A2 nhập vào số 3 (bước nhảy bằng 3-1 = 2, Excel sẽ cộng số 2 

vào ô chứa số lẻ trước đó để có được số lẻ kế tiếp). 

B3. Chọn hai ô A1:A2, di chuyển chuột xuống dấu vuông nhỏ màu đen (Fill handle) 

ở góc dưới bên phải vùng chọn cho chuột biến thành dấu cộng màu đen. 

B4. Giữ trái chuột kéo xuống phía dưới cho đến khi hiện số 25 thì dừng lại. 
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-Khi chúng ta muốn 

điền tự động (sao chép) 

dữ liệu hay công thức 

của ô hiện hành cho các 

ô bên trái, bên phải, 

phía trên hay bên dưới 

nó thì chúng ta làm theo các cách sau: 

1. Chọn ô hiện hành đang chứa dữ liệu hay công thức cần sao chép, sau đó giữ Fill 

handle và kéo theo hướng chúng ta cần (lên, xuống, trái hay phải). Khi đó dữ liệu 

hay biểu thức sẽ được sao chép. 

2. Chọn ô chứa dữ liệu (hay công thức) cần sao chép và tất cả các ô cần sao dữ liệu 

đến, sau đó vào Home ->nhóm Editing ->Fill ->chọn hướng phù hợp (Down, Right, 

Up, Left). 

- Tự tạo danh sách AutoFill chúng ta vào nút Office ->Excel Options ->Popular -

>trong phần trong phần Top options for working with Excel ->chọn Edit Custom 

Lists ->hộp thoại Custom Lists hiện ra. Tại đây, chúng ta hãy nhập vào danh sách 

trong khung List entries, sau khi nhập xong nhấn nút Add để thêm vào Custom lists 

và kể từ lúc này chúng ta có thể sử dụng chức năng AutoFill với danh sách tự tạo 

của chúng ta. 

-Muốn xóa một danh sách thì chúng ta chỉ cần chọn danh sách đó và nhấn nút Delete. 

- Nếu muốn hiệu chỉnh danh sách thì chọn danh sách đó và hiệu chỉnh trong ô List 

entries, sau khi hiệu chỉnh xong nhấn nút Add. 

2.2. Định dạng 

Định dạng chung 
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Định dạng văn bản và số 

Các nút định dạng thông dụng của Excel được bố trí rất thuận lợi truy cập trong 

nhóm Home của thanh Ribbon. Trong quá trình soạn thảo, tính toán trên Excel, mỗi 

khi cần định dạng chúng ta chỉ việc nhấn chuột lên nút lệnh phù hợp dưới đây. 

Khi cần các định dạng phức tạp hơn mà trên thanh Ribbon không có nút lệnh thì 

chúng ta truy cập vào hộp thoại Format Cells: Chọn Home ->nhóm Cells ->Format 

->Format Cells… 

 

Giải thích hộp thoại Format Cells 

Sử dụng Wrap Text 

Khi chúng ta muốn đoạn văn bản dài trong ô có nhiều dòng thì chúng ta dùng chức 

năng wrap text hoặc dùng <Alt+Enter> để xuống dòng tại vị trí mong muốn. 

B1. Chọn ô cần định dạng Wrap text, ví dụ ô A1 
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B2. Chọn Home ->Alignment ->chọn Wrap Text ( ). Nếu dòng không tự động 

mở rộng là do ô bị thiết lập chiều cao cố định, chúng ta vào Home ->Cells ->Format 

->tại Cells Size chọn AutoFit Row Height 

Xoay chữ (Orientation) 

B1. Chọn các ô cần xoay chữ A1:D1 

B2. Chọn Home ->nhóm Alignment -

>Orientation ->Angle Counterclockwise 

Định dạng khung (border) 

Kẽ đường bao xung quanh vùng B2:E18 đậm, có đường phân cách giữa các ô bằng 

nét mãnh và màu tất cả đường kẽ là màu đỏ. 

B1. Chọn danh sách cần kẽ khung B2:E18 

B2. Chọn Home ->nhóm Cells ->Format ->Chọn Format Cells 

B3. Vào Tab Border, chọn màu là Red ( ) tại Color 

B4. Chọn Style là nét đậm , sau đó chọn nút Outline tại Preset 

B5. Chọn Style là nét mảnh , sau đó chọn nút Inside tại Preset 

B6. Nhấn OK hoàn tất 

 

Hiệu ứng tô nền ô (Fill effect) 

B1. Chọn vùng cần tô màu nền B2:E18 

B2. Chọn Home ->nhóm Cells ->Format ->Chọn Format Cells 
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B3. Vào Tab Fill ->Chọn Fill Effects… 

B4. Chọn các màu cần phối hợp: Color 1 (ví dụ là màu vàng Yellow) và Color 2 

(Blue) 

B5. Chọn Shading styles là Vertical và chọn kiểu thứ 3 

B6. Nhấn OK hai lần để hoàn tất. 

 

Tự động định dạng có điều kiện. 

Với Excel 2010 định dạng có điều kiện sẽ giúp 

chúng ta chỉ ra các mẫu trong dữ liệu và sử dụng 

rất đơn giản. Chỉ cần đánh dấu một nhóm các ô và 

kích vào Conditional Formatting trên ribbon 

Home. Khi đưa chuột trên những lựa chọn, chúng 

ta sẽ thấy preview của nó ngay lập tức. Có thể gán 

cho mỗi ô một màu để phán ảnh thứ hạng của nó 

trong toàn bộ dải các giá trị, thêm một thanh dữ 

liệu trong suốt phản ánh giá trị của ô… Cách thức 

tiến hành này cho phép đơn giản hơn rất nhiều so 

với sự phức tạp trong hộp thoại Conditional 

Formatting của Excel 2003. 
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Bảng và định dạng bảng (table) 

Excel thiết lập sẵn rất nhiều biểu mẫu định dạng bảng và còn hỗ trợ tạo thêm các 

biểu mẫu mới. Excel chỉ cho phép xóa các biểu mẫu tự tạo thêm và cho phép xóa 

định dạng bảng. Ngoài ra ta có thể hiệu chỉnh định dạng bảng khi cần thiết. 

Áp định dạng bảng cho danh sách và chuyển danh sách thành bảng 

B1. Chọn danh B2:E18 

B2. Chọn Home ->nhóm Styles ->chọn Format As Table 

B3. Cửa sổ Style liệt kê rất nhiều biểu mẫu định dạng bảng, chọn một trong các biểu 

mẫu. Ví dụ chọn mẫu Light số 9 

B4. Cửa sổ Format As Table hiện lên nhấn OK để xác nhận. 

-Để tạo mẫu mới thì tại bước 3 chọn New Table Style…, sau đó đặt tên cho biểu 

mẫu mới và nhấn Format để chế biến biểu mẫu. 

-Muốn xóa một mẫu tự tạo thì vào Home ->Style ->Format As Table, tại phần 

Custom nhấp phải chuột lên biểu mẫu và chọn Delete. 

-Các tùy chọn hiệu chỉnh bảng có ở Table Tools ->Tab Design trên thanh Ribbon 

 

Xóa kiểu định dạng bảng đang áp dụng và chuyển bảng về danh sách 
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-Để xóa một kiểu định dạng bảng đang áp dụng, trước tiên hãy chọn bảng, tại Tab 

Design vào nhóm Table Styles chọn More ( ) ->chọn Clear. Đến lúc này vùng chọn 

vẫn còn là 

bảng do vậy nó có các tính năng của bảng. 

-Để chuyển một bảng về thành danh sách thì chọn bảng, sau đó vào Tab Design, tại 

nhóm Tools chọn Convert to Range. 

Sử dụng mẫu định dạng tài liệu (Document Themes) 

Các mẫu tài liệu dựng sẵn giúp người sử dụng tạo nên các tài liệu có dáng vẽ chuyên 

nghiệp và rất dễ sử dụng. Các biểu mẫu tài liệu được thiết kế sẵn với nhiều màu, font 

chữ, hình ảnh, đồ thị,… với nhiều hiệu ứng đẹp mắt. Ngoài ra chúng ta còn có thể 

hiệu chỉnh và chế biến các mẫu này. 

-Để áp dụng biểu mẫu tài liệu chúng ta vào chọn nhóm Page Layout ->Themes -

>Chọn một biểu mẫu từ danh sách. 

-Có thể hiệu chỉnh biễu mẫu: vào Colors để chọn 

lại màu, vào Fonts để chọn lại kiểu Font và vào 

Effects để chọn lại hiệu ứng. 

-Lưu ý bảng phải áp dụng Style thì mới có tác dụng. 

-Tạo biểu mẫu mới Colors và Font chúng ta vào 

Page Layout ->Themes ->chọn Colors ->chọn 

Create New Themes Colors hay Page Layout -

>Themes ->chọn Fonts ->chọn Create New 

Themes Fonts. Nhớ lưu lại (Save) sau khi tạo. 

-Khi đổi kiểu mẫu khác đồng loạt các đối tượng 

được áp dụng biểu mẫu thay đổi định dạng và 

không bị thay đổi nội dung. 

2.3 Tìm và thay thế dữ liệu  

Để tìm dữ liệu hoặc tìm và thay thế dữ liệu: 
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• Kích nút Find & Select trên nhóm Editing của 

tab Home 

• Chọn Find hoặc Replace 

• Hộp thoại Find and Replace xuất hiện, nhập từ 

muốn tìm trong mục Find What (nếu chúng ta 

chọn Find ở bước trên) hoặc nhập từ muốn tìm 

trong mục Find What và từ thay thế trong mục 

Replace with (nếu chúng ta chọn Replace ở bước 

trên).  

• Kích nút Options để tìm thêm các tùy chọn 

 

2.4 Sắp xếp và lọc dữ liệu 

Sort (sắp xếp) và Filter (lọc) là những tính năng cho phép chúng ta thao tác dữ 

liệu trong một bảng tính được thiết lập dựa trên các tiêu chuẩn. 

Sắp xếp 

Để thực hiện một sắp xếp theo chiều tăng dần hay giảm dần 

trên một cột: 

• Đánh dấu các ô muốn được sắp xếp 

• Kích nút Sort & Filter trên tab Home 

• Kích nút Sort Ascending (A-Z) hay Sort Descending (Z-

A) 

Tùy chỉnh sắp xếp  
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Để sắp xếp nhiều hơn một cột: 

• Kích nút Sort & Filter trên tab Home 

• Chọn cột mà chúng ta muốn sắp xếp đầu 

tiên 

• Kích Add Level 

• Chọn cột tiếp theo chúng ta muốn sắp xếp 

• Kích OK 

Lọc dữ liệu  

Bộ lọc cho phép chúng ta chỉ hiển thị dữ liệu mà đáp ứng các tiêu chuẩn nhất định. 

Để sử dụng bộ lọc: 

• Kích vào cột hoặc chọn các cột chứa dữ liệu mà chúng ta muốn lọc 

• Trên tab Home, kích Sort & Filter 

• Kích nút Filter 

• Kích vào mũi tên phía dưới ô đầu tiên 

• Kích Text Filter 

• Kích Words chúng ta muốn lọc 

• Để không áp dụng bộ lọc, kích nút Sort & 

Filter  

• Kích Clear 

Bài tập và sản phẩm thực hành bài 07.7 

 

Kiến thức: 

Câu 1: Khởi động MS Excel. Nêu các lệnh cơ bản đ/v Bảng tính. 

Câu 2: Trình bày các kiểu dữ liệu trong MS Excel. Cách định dạng của từng loại dữ 

liệu? 

Câu 3: Trình bày các loại toán tử trong MS Excel và mức độ ưu tiên của nó dùng 

trong tính toán. 

 Bài tập ứng dụng:    
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Bài tập 07.7.1: 

Thành lập bảng tính  sau : 

BẢNG KÊ HÀNG BÁN 

 

YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô 

- Dùng lệnh để canh giữa cho tiêu đề của bảng tính và tiêu đề của các cột 

- Vào số thứ tự tự động  (thử bằng 2 cách) 

2. Tính toán  

- Cột (a) = số lượng * đơn giá 

- Cột (b) = 10 % cột cột (a) 

- Cột (c) = 0,3 % của đơn giá 

- Cột (d) = cột (a) + cột (b) + cột (c) 

- Cột (e) = Cột (d)* 14.680 

3. Lưu bảng tính vào đĩa với tên TH01.XLSX 

4. Kẻ khung và trình bày bảng tính 

5. Thoát khỏi Excel 

6. KhỎi đỘng lẠi excel và gỌi bẢng tính TH01.XLSX 

 

Bài tập 07.7.2: 

Thành lập bảng tính  sau : 

Dùng lệnh  insert / picture/ clip art 

Cộng  hòa xã hội chủ nghĩa Việt Nam 

Độc lập - Tự do - Hạnh phúc 
 
 

BẢNG THANH TOÁN LƯƠNG THÁNG 3 NĂM 2012 
 

TT HỌ VÀ TÊN HỆ SỐ 

LƯƠNG 

NGÀY 

CÔNG 

TRỪ  

TẠM ỨNG 

THỰC 

LÃNH 

KÝ TÊN 

1 Trần Duy Trị  2.88 15 $120.000 (a)  

2 Hồ Thị Tuyết 3.10 35 $70.000   

3 Lê Văn Mừng 2.50 17 $50.000   

4 Lê Ngọc Trong 4.40 5 $205.000   

5 Trần Hà Dũng 2.88 26 $210.000   

T

T 

TÊN 

HÀNG 
ĐVT NSX SL GIÁ T.TIỀN 

THU

Ế 

VAT 

THU

Ế 

NK 

TC 
TTIỀN 

VNAM 

1 Xe đạp Chiếc Nhật 150 120 (a) (b) (c) (d) (e) 

2 Quạt trần Cái Vnam 350 70      

3 Quạt đứng Cái  1700 50      

4 Xe future Chiếc Thái 500 2050      

5 Xe dream Chiếc  630 2100      

6 Xe best Chiếc Tquốc 700 1800      

7 Xe suzuki Chiếc  600 1750      

8 Ti vi Cái  1200 350      

9 Máyđĩa sony Cái  1050 220      

 10 Loa yamaha Cái  2000 101      
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6 Trần Thanh Thanh 3.10 7 $180.000   

7 Nguyễn Văn Trục 4.50 30 $175.000   

8 Lê Chí Hùng 2.50 12 $35.000   

9 Đoàn Huân 5.60 10 $220.000   

 10 Hoàng 

Xuân 

Nhĩ 4.50 20 $101.000   

TỔNG CỘNG : ? ?  

YÊU  CẦU:    
1. Thành lập bảng tính và vào số liệu thô 

- Dùng lệnh để canh giữa cho tiêu đề của bảng tính và tiêu đề của các cột. 

- Vào số thứ tự tự động (thử bẳng 2 cách) 

2. Tính toán: 

(a)= hệ số lương*200000/30*ngày công – tạm ứng 

- Tính Tổng cho các cột TRỪ TẠM ỨNG vă THỰC LÃNH 

- Định dạng lại cho cột THỰC LÃNH thành dạng currency, 0 số lẻ. 

3. Lưu bảng tính vào đĩa với tên TH02.XLSX 

4. Kẻ khung và trình bày bảng tính (có thể thực tập nhiều loại khung khác nhau) 

5. Thoát khỏi Excel. 

Bài tập 07.7.3: 

1. Cho ẩn, hiện các thanh Formular Bar, Status Bar.  

Chọn làm việc lần lượt với các sheet 2, 3, 1. Chèn thêm một Sheet mới vào bảng 

tính. 

Che, hiện các đường kẻ lưới trong bảng tính.  

Che, hiện Header Row, Header Column.  

Che, hiện thanh Sheet Tabs 

2. Xác lập chế độ mở 16 Sheets trên một book. Mở thêm Book thứ hai. Chọn làm 

việc với sheet 16. Di chuyển về sheet 1. Hiển thị đồng thời cả hai book trên màn 

hình. Di chuyển qua lại giữa hai books. Đóng một book. 

3. Di chuyển nhanh về dòng cuối cùng, về cột cuối cùng, về ô EA123, về ô A1 

4. Chọn Size chữ bằng 8 cho cả bảng tính 

5. Nhập : 

 

CNG TY XYZ  Học Bổng  Trình Độ Văn Hóa 

------******-----

- 

 0 Đồng  10/12 

Sau khi nhaäp, khoâng cho hieän giaù trò 0 ra baûng tính 

6. Nhập : 
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 A B C D E F G H 

1 BẢNG THEO DI 

2      Ngy 12/22/01  

3 HỌ TN 

NGÀY  

SINH 

NHẬT 

NGÀY 

 CÔNG 

TÁC 

 LÊN 

LƯƠNG  

LẦN 1 

 LÊN 

LƯƠNG  

LẦN 2 

NUMBER DATE 

4 Lê Thị Dung 02/13 06/20/1993 5/12/97 7/Jul/00 [ X1] [ X2] 

5 Chu Văn Ba 07/20 07/24/1995 27/11/97 12/Dec/00   

6 Lý Thu  Ha 04/16 07/19/1994 2/12/96 9/Sep/99   

7 Văn Kim Sa 09/11 01/19/1995 3/6/97 3/Mar/00   

 

Yêu Cầu: 

 Nhập đúng dữ liệu kiểu ngày 

 [X1} :  Cho biết số ngày giữa ngày chỉ định ở ô G2  và ngày LÊN LƯƠNG LẦN 

2 

 [X2] :  Giả sử sau đúng ba năm kể từ lần tăng lương cuối cùng, mỗi người được 

tăng tiếp một bậc lương, bằng công thức hãy điền ngày lên lương tiếp theo, định 

dạng theo dạng  yyyy/mm/dd 

 Chèn thêm cột SNGHLLL (Số ngày giữa hai lần lên lương) vào sau cột LÊN 

LƯƠNG LẦN 2. Tính toán số ngày này. 

 Chèn thêm cột Số TT vào trước cột HỌ TÊN, Điền Số TT tự động 

 Định dạng bảng tính theo đúng mẫu 

Định dạng các giá trị Date theo thứ tự quen dùng của người Việt Nam. 

 

CHỈ DẪN ĐỐI VỚI HỌC SINH THỰC HIỆN BÀI TẬP ỨNG DỤNG 

Đánh giá kết quả học tập 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối 

đa 

Kết quả thực 

hiện của 

người học 

I Kiến thức    

1 Khởi động MS Excel 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

1  

2 Các thao tác cơ bản đối với bảng 

tính  
1  

3 Các thao tác di chuyển trong bảng 

tính 
2  

4 Các loại địa chỉ trong Excel 1  

5 Các kiểu dữ liệu trong MS Excel 1  
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6 Các loại toán tử và độ ưu tiên của 

nó trong Excel 
2  

7 Định dạng các dữ liệu trong Excel  2  

                                      Cộng: 10 đ  

II Kỹ năng    

1 Khởi động và thoát khỏi MS 

Excel  

  

 Kiểm tra sản phẩm 

sau buổi thực hành 

  

  

1 
 

2 Lệnh cơ bản đối với bảng tính 2  

3 Thao tác thành thạo trong MS 

Excel 
2  

4 Nhập đúng dữ liệu theo yêu cầu 2  

5 Ban hành công thức đúng theo 

yêu cầu BT trong Excel 
3  

                              Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp Theo dõi việc thực 

hiện, đối chiếu với 

nội quy của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1.5  

1.2 Không vi phạm nội quy lớp học 1.5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc thực 

hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời gian 

thực hiện bài tập, 

đối chiếu với thời 

gian quy định. 

2 

 

3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp 
Theo dõi việc thực 

hiện, đối chiếu với 

quy định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 1.5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1.5 

 

3.3 Vệ sinh phòng thực hành đúng 

quy định 
1 

 

                              Cộng: 10 đ  
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KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0.3  

Kỹ năng  0.4  

Thái độ  0.3  

                                                                                              

Cộng: 
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BÀI 8: HÀM TRONG EXCEL 

 

Giới thiệu: 

 Để việc tính toán trở nên dễ hơn và có thể tính toán được những phép toán 

phức tạp nhưng chỉ cần ban hành một công thức có thể áp dụng cho nhiều đối tượng 

được tính đến. Excel cung cấp cho ta một thư viện Hàm phục vụ cho từng nhu cầu 

cụ thể. Thế Hàm là gì? Cách sử dụng nó như thế nào trong việc ban hành công thức? 

Để việc tính toán này đạt hiệu quả cao thì ta cần nghiên cứu nó kỹ hơn trong bài này 

nhé.  

Mục tiêu của bài: 

- Mô tả được khái niệm về các hàm trong Excel; 

- Trình bày được cú pháp của từng hàm; 

- Thực hiện được lồng ghép các hàm với nhau; 

Thực hiện các thao tác an toàn với máy tính.   

1 . Các khái niệm: 

Giới thiệu công thức (Formula) 

Công thức giúp bảng tính hữu ích hơn rất nhiều, nếu không có các công thức thì 

bảng tính cũng giống như trình soạn thảo văn bản. Chúng ta dùng công thức để tính 

toán từ các dữ liệu lưu trữ trên bảng tính, khi dữ liệu thay đổi các công thức này sẽ 

tự động cập nhật các thay đổi và tính ra kết quả mới giúp chúng ta đỡ tốn công sức 

tính lại nhiều lần. Vậy công thức có các thành phần gì? 

Công thức trong Excel được nhận dạng là do nó bắt đầu là dấu = và sau đó là sự kết 

hợp của các toán tử, các trị số, các địa chỉ tham chiếu và các hàm. 

Ví dụ: 

 

 

 

Ví dụ về công thức 

Các toán tử trong công thức 

Toán tử  Chức năng  Ví dụ  Kết quả  

+  Cộng  =3+3  3 cộng 3 là 6  



 Trang 144  

-  Trừ  =45-4  45 trừ 4 còn 41  

*  Nhân  =150*.05  150 nhân 0.5 thành 7.5  

/  Chia  =3/3  3 chia 3 là 1  

^  Lũy thừa  =2^4 

=16^(1/4)  

2 lũy thừa 4 thành 16 Lấy căn bậc 4 của 

16 thành 2  

&  Nối chuỗi  =”Lê” & 

“Thanh”  

Nối chuỗi “Lê” và “Thanh” lại thành “Lê 

Thanh”  

=  Bằng  =A1=B1  Ví dụ ô A1=3, ô B1=6 Kết quả:FALSE  

>  Lớn hơn  =A1>B1  Ví dụ ô A1=3, ô B1=6 Kết quả:FALSE  

<  Nhỏ hơn  =A1<B1  Ví dụ ô A1=3, ô B1=6 Kết quả: TRUE  

>=  Lớn hơn 

hoặc bằng  

=A1>=B1  Ví dụ ô A1=3, ô B1=6 Kết quả:FALSE  

<=  Nhỏ hơn 

hoặc bằng  

=A1<=B1  Ví dụ ô A1=3, ô B1=6 Kết quả: TRUE  

<>  Khác  =A1<>B1  Ví dụ ô A1=3, ô B1=6 Kết quả: TRUE  

,  Dấu cách 

các tham 

chiếu  

=Sum(A1,B1)  Ví dụ ô A1=3, ô B1=6 Kết quả: 9  

:  Tham chiếu 

mãng  

=Sum(A1:B1)  Ví dụ ô A1=3, ô B1=6 Kết quả: 9  

khoảng 

trắng  

Trả về các ô 

giao giữa 2 

vùng  

=B1:B6 

A3:D3  

Trả về giá trị của ô  

Thứ tự ưu tiên của các toán tử  

Toán tử  Mô tả  Ưu tiên  

: (hai chấm) (1 khoảng trắng) , (dấu phẩy)  Toán tử tham chiếu  1  

–  Số âm (ví dụ –1)  2  

%  Phần trăm  3  

^  Lũy thừa  4  

* và /  Nhân và chia  5  

+ và –  Cộng và trừ  6  

&  Nối chuỗi  7  

= < > <= >= <>  So sánh  8  

Giới thiệu hàm (Function)  

1. Hàm là gì? 

Hàm trong Excel được lập trình sẵn dùng tính toán hoặc thực hiện một chức năng 

nào đó. Việc sử dụng thành thạo các hàm sẽ giúp chúng ta tiết kiệm được rất nhiều 

thời gian so với tính toán thủ công không dùng hàm. Các hàm trong Excel rất đa 
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dạng bao trùm nhiều lĩnh vực, có những hàm không yêu cầu đối số, có những hàm 

yêu cầu một hoặc nhiều đối số, và các đối số có thể là bắt buộc hoặc tự chọn. 

Ví dụ: 

=Rand(): hàm không có đối số 

=If(A1>=5,”Đạt”,”Rớt”): hàm 3 đối số 

=PMT(10%,4,1000,,1): hàm nhiều đối số và đối số tùy chọn 

Tham chiếu trong công thức   

Các tham chiếu sử dụng trong công thức giúp cho chúng ta khỏi tốn công sửa chữa 

các công thức khi các giá trị tính toán có sự thay đổi. Có 3 loại tham chiếu sau: 

 Tham chiếu địa chỉ tương đối: Các dòng và cột tham chiếu sẽ thay đổi khi 

chúng ta sao chép hoặc di dời công thức đến vị trí khác một lượng tương ứng 

với số dòng và số cột mà ta di dời. Ví dụ A5:B7, C4  

 Tham chiếu địa chỉ tuyệt đối: Các dòng và cột tham chiếu không thay đổi khi 

ta di dời hay sao chép công thức. Ví dụ $A$5:$B$7, $C$4  

 Tham chiếu hỗn hợp: Phối hợp tham chiếu địa chỉ tương đối và tuyệt đối. Ví 

dụ A$5 nghĩa là cột A tương đối và dòng 5 tuyệt đối.  

Lưu ý: Dấu $ trước thứ tự cột là cố định cột và trước thứ tự dòng là cố định dòng. 

Nhấn phím F4 nhiều lần để (tuyệt đối) cố định/ bỏ cố định  dòng hoặc cột. 

Ví dụ: Tính thành tiền bằng Số lượng nhân Giá. Đổi sang giá trị Thành tiền sang 

VND. Tính tổng các cột Thành tiền và cột VND. 
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Minh họa địa chỉ tương đối và tuyệt đối 

B1. Tại ô D2 nhập vào =B2*C2 và Enter. Sau đó quét chọn cả vùng D2:D14 và gõ 

<Ctrl+D>. Vào các ô D3, D4... D14 ta thấy công thức các dòng tự động được thay 

đổi tương ứng với khoảng cách so với ô D2. Trường hợp này chúng ta dùng địa chỉ 

tương đối của B2*C2 là vì chúng ta muốn khi sao chép công thức xuống phía dưới 

thì địa chỉ các ô tính toán sẽ tự động thay đổi theo. 

B2. Tại ô E2 nhập vào =D2*B$17 và Enter, sau đó chép công thức xuống các ô 

E3:E14. Chúng ta cần cố định dòng 17 trong địa chỉ tỷ giá B17 vì ta muốn khi sao 

công thức xuống thì các công thức sao chép vẫn tham chiếu đến ô B17 để tính toán. 

B3. Tại ô D15 nhập vào =Sum(D2:D14) và chép sang ô E15. 

Lưu ý: 

 Tham chiếu đến địa chỉ ở worksheet khác nhưng cùng workbook thì có dạng  

 Tên_sheet!Địa_chỉ_ô. Ví dụ:  

=A2*Sheet2!A2 

=A2*’Thong so’!B4 

Khi tên sheet có chứa khoảng trắng thì để trong cặp nháy đơn ‘ ’ 

 Tham chiếu đến địa chỉ trong workbook khác thì có dạng  

[Tên_Workbook]Tên_sheet!Địa_chỉ_ô.  

Ví dụ: 
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=A2*[Bai2.xlsx]Sheet3!A4 

=A2*’[Bai tap 2.xlsx]Sheet3’!A4               

Khi tên Sheet hay Workbook có chứa khoản trắng để trong cặp nháy đơn ‘ ’ 

=A2*’C:\Tai lieu\[Bai tap 2.xlsx]Sheet3’!A4 

Khi tham chiếu đến workbook khác mà workbook này không mở  

=A2*’\\DataServer\Excel\[Bai tap 2.xlsx]Sheet3’!A4 

Khi tham chiếu đến tài nguyên chia sẽ trên máy chủ trong mạng 

Các lỗi thông dụng (Formulas errors)   

Các lỗi thông dụng 

Lỗi Giải thích 

#DIV/0! Trong công thức có chứa phép chia cho 0 (zero) hoặc chia ô rỗng 

#NAME? Do dánh sai tên hàm hay tham chiếu hoặc đánh thiếu dấu nháy 

#N/A Công thức tham chiếu đến ô mà có dùng hàm NA để kiểm tra sự 

tồn tại của dữ liệu hoặc hàm không có kết quả 

#NULL! Hàm sử dụng dữ liệu giao nhau của 2 vùng mà 2 vùng này không 

có phần chung nên phần giao rỗng 

#NUM! Vấn đề đối với giá trị, ví dụ như dùng nhầm số âm trong khi đúng 

phải là số dương 

#REF! Tham chiếu bị lỗi, thường là do ô tham chiếu trong hàm bị xóa 

#VALUE! Công thức tính toán có chứa kiểu dữ liệu không đúng. 

 

2. Các hàm cơ bản thường dùng: 

2.1 Hàm xử lý dữ liệu dạng số: 

CÁC HÀM TOÁN HỌC VÀ LƯỢNG GIÁC 

1.Hàm ABS(Number) 

Trong đó :  Number là một số mà ta muốn lấy giá trị tuyệt đối của nó. 

Công dụng :  Trả về giá trị tuyệt đối của một số 

Ví dụ :  

ABS(2) bằng 2  
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ABS(-2) bằng 2  

Nếu A1 chứa số -20 thì ABS(A1) bằng 20  

2.Hàm COS(Number) 

Trong đó : Number là góc theo Radian mà ta muốn lấy Cosin của nó. Nếu 

góc là độ thì ta nhân nó với PI()/180 để chuyển nó sang Radian. 

Công dụng : Trả về Cosin của góc đã cho. 

Ví dụ : 

COS(1.047) Bằng 0.500171 

COS(60*PI()/180) Bằng 0.5 (Cosin của góc 60o). 

3.Hàm COUNTIF(Range, Criteria) 

Trong đó :  Range Là vùng cell mà ta muốn đếm. Criteria Là tiêu chuẩn để 

được đếm. 

Tiêu chuẩn được cho dưới dạng văn bản có dạng Toán tử so sánh_Giá trị so 

sánh. (Không cần ghi toán tử =). 

Ví dụ “>=10”, “L1A”, A20 (Bằng giá trị ô A20), 10 (Bằng 10), “G*” (So sánh 

bằng với chuỗi có ký tự đầu tiên là G) 

Công dụng : Đếm số cell trong một vùng thỏa điều kiện đã cho. 

Ví dụ : 

Giả sử A1:A5 chứa các giá trị 10, 60, 20, 65, 40 

COUNTIF(A1:A5,”>30”) bằng 3 

4. Hàm EXP(Number) 

Trong đó :  Number là số mũ được gán cho cơ số e 

Công dụng :  Trả về lũy thừa của e  (e là cơ số của logarit tự nhiên) 

Lưu ý :  Để tính toán lũy thừa của các cơ số khác, dùng toán tử lũy thừa 

(^) 

EXP là phép tính ngược của LN 

Ví dụ :  EXP(LN(3)) Bằng 3 
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5.Hàm INT(Number)  

Trong đó : Number là số thực mà ta muốn lấy phần nguyên của nó 

Công dụng : Trả về phần nguyên của một số thực 

Ví dụ INT(6.7) Bằng 6 

INT(-6.7) Bằng -7 

6.Hàm LN(Number)  

Trong đo : Number là giá trị thực dương mà ta muốn lấy Logarit tự nhiên 

Công dụng : Trả về Logarit tự nhiên của một số 

Ví dụ 

LN(EXP(3))  Bằng 3 

7.Hàm LOG(Number,Base)  

Trong đó :  

Number là giá trị thực dương mà ta muốn lấy Logarit 

Base Là cơ số của Logarit. Nếu không ghi Base, giá trị mặc nhiên là 

bằng 10 

Công dụng : Trả về Logarit của một số theo cơ số ta chỉ định 

Ví dụ LOG(10) Bằng 1 

LOG(8,2) Bằng 3 

8.LOG10(Number)  

Trong đo : Number là giá trị thực dương mà ta muốn lấy Logarit cơ số 10 

Công dụng : Trả về Logarit cơ số 10 của một số 

Ví dụ LOG(10^5) Bằng 5 

9.Hàm MOD(Number, Divisor) 

Trong đo : Number là số bị chia mà ta muốn tìm số dư. Divisor là số chia 

Công dụng : Trả về phần dư của phép chia nguyên. Kết quả có cùng dấu như 

số chia 

Ví dụ MOD(-3,2) Bằng  1 

MOD(3,-2) Bằng -1 

10.Hàm PI() 

Công dụng : Trả về giá trị hằng số  Pi chính xác đến 15 chữ số 

Ví dụ SIN(PI()/2) Bằng 1 
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11.Hàm PRODUCT(Number1, Number2, ...) 

Trong đo : Number1, Number2, ... là 1 đến 30 đối số mà ta muốn nhân 

Công dụng : Nhân tất cả các đối số được cho và trả về giá trị tích 

Ví dụ  Giả sử cell A1:A3 có chứa giá trị số 1, 2, 3  

PRODUCT(A1:A3) Bằng 6 

PRODUCT(A1:A3,2) Bằng 12 

12.Hàm ROUND(Number, Num digits) 

Công dụng : Làm tròn một số theo số con số được chỉ định 

Trong đó :Number là số thực mà ta muốn làm tròn. Num digits là số ký số mà 

ta muốn làm tròn 

 Nếu Num digits >0 thì Number sẽ được làm tròn tới vị trí thập phân được chỉ 

định. 

 Nếu Num digits =0 hoặc bỏ qua thì Number sẽ được làm tròn tới số nguyên 

gần nhất. 

 Nếu Num digits <0 thì Number sẽ được làm tròn tới bên trái dấu chấm thập 

phân. 

Ví dụ ROUND(4.56,1) Bằng 4.6 

ROUND(34.56,-1) Bằng 30 

13.Hàm SIN(Number) 

Công dụng : Trả về Sin của góc đã cho. 

Ví du : SIN(PI()/2 Bằng 1 

SIN(30*PI()/180) Bằng 0.5 (Sin của góc 30o). 

14.Hàm SQRT(Number) 

Công dụng : Trả về căn bậc hai của một số không âm.  

Ví du : SQRT(16)  Bằng 4 

15.Hàm SUM(Number1, Number2, ...) 

Công dụng : Trả về tổng tất cả các giá trị số trong danh sách các đối số. 

Ví dụ Giả sử cell A1:A3 có chứa giá trị số 2, 3,4  

SUM(A1:A3)  Bằng 9 

SUM(A1:A3,2) Bằng 11 

16.Hàm SUMIF(Range, Criteria, Sum Range) 

Công dụng : Cộng các cell trong một vùng thỏa điều kiện đã cho. 
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Trong đo :  

 Range là vùng cell được kiểm tra qua tiêu chuẩn Criteria. 

 Criteria là tiêu chuẩn ban hành để xác định giá trị được tính tổng. Tiêu chuẩn 

được cho dưới dạng văn bản có dạng Toán tử so sánh_Giá trị so sánh. (Không 

cần ghi toán tử =). Ví dụ “>=10”, “L1A”, A20 (Bằng giá trị ô A20), 10 (Bằng 

10), “G*” (So sánh bằng với chuỗi có ký tự đầu tiên là G). 

 Sum Range là các cell có thể được cộng, các cell trong Sum Range được cộng 

chỉ khi cell tương ứng với nó trong Range thoả mãn Criteria. Nếu Sum Range 

được bỏ qua, ta hiểu Sum Range trùng với Range (Tức là các cell trong Range 

được cộng)  

Lưu y:  Range va Sum Range nên có số hàng và số cột bằng nhau 

Ví dụ : 

 

 A B C D  

1 L1A G103A 10 30 SUMIF(C1:C5,”>30”,D1:D5) bằng 

150 

2 L2B G012B 60 50 SUMIF(C1:C5,”>30”) bằng 165 

3 L3A T213A 20 20 SUMIF(A1:A5,A2,D1:D5) bằng 90 

4 L2B G112B 65 40 SUMIF(B1:B5,”T*”,D1:D5) bằng 80 

5 L1A T001B 40 60  

17.Hàm TAN(Number) 

Công dụng : Trả về TANG của góc đã cho. 

Ví dụ : TAN(45*PI()/180) Bằng 1 (TANG của góc 45o). 

18.Hàm TRUNC(Number, Num digits) 

Trong đó : Number là số thực mà ta muốn cắt. Num digits Là số chỉ định độ 

chính xác của phép cắt. Giá trị mặc nhiên là 0. 

Công dụng : Cắt bỏ phần thập phân của một số để tạo thành một số nguyên. 

Lưu y : TRUNC và INT cùng trả về một giá trị nguyên, nhưng TRUNC bỏ đi 

phần thập phân, còn INT trả về số nguyên nhỏ hơn và gần nó nhất. 

Ví dụ TRUNC(-4.6)  Bằng -4 

INT(-4.6)  Bằng -5 
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2.2 Hàm xử lý dữ liệu dạng chuỗi: 

1.Hàm LEN(Text) 

Trong đó :Text là một chuỗi  

Công dụng : Trả về chiều dài của một chuỗi. 

Ví du : LEN(“Tin Hoc”) Bằng 7  

2.Hàm LEFT(Text, Num Chars) 

Công dụng : Trả về các ký tự đầu tiên của một chuỗi 

Trong đó : Text là chuỗi mà ta muốn trích ra một phần của nó. Num Chars chỉ 

ra số ký tự được LEFT trả về. Num Chars phải lớn hơn hay bằng 0. Nếu Num 

Chars lớn hơn số ký tự có trong Text, LEFT trả về toàn bộ chuỗi. Nếu không ghi 

Num Chars, Nó có giá trị mặc nhiên bằng 1 

Ví dụ LEFT(“Tin Hoc”,3) Bằng “Tin” 

Nếu cell A1 chứa giá trị “G102A” thì LEFT(A1) bằng “G”  

3.Hàm LOWER(Text) 

Công dụng : Chuyển tất cả các chữ hoa trong chuỗi thành chữ thường. 

Ví dụ LOWER(“Tin Hoc”) Bằng “tin hoc” 

4.Hàm MID(Text, Start Num, Num Chars) 

Trong đo : Text là chuỗi mà ta muốn trích ra một phần của nó. Start Num là 

vị trí ký tự trong Text. Num Chars chỉ ra số ký tự được MID trả về kể từ vị trí Start 

Num 

Công dụng : Trả về một số chỉ định các ký tự từ một chuỗi, bắt đầu tại vị trí 

mong muốn. 

Ví dụ MID(“G102A”,2,1) Bằng “1” 

5.Hàm PROPER(Text) 

Công dụng : Chuyển sang chữ hoa chữ cái đầu tiên của các từ có trong chuỗi 

và các chữ đi ngay sau một ký tự không phải là chữ cái. Các chữ cái còn lại chuyển 

sang chữ thường. 

Ví dụ PROPER(“TIN HOC”) Bằng “Tin Hoc” 

6.Hàm RIGHT(Text, Num Chars) 

Trong đo : Text là chuỗi mà ta muốn trích ra một phần của nó. Num Chars chỉ 

ra số ký tự được RIGHT trả về. Num Chars phải lớn hơn hay bằng 0. Nếu Num 

Chars lớn hơn số ký tự có trong Text, LEFT trả về toàn bộ chuỗi. Nếu không ghi 

Num Chars, Nó có giá trị mặc nhiên bằng 1 

Công dụng : Trả về các ký tự cuối cùng của một chuỗi. 

Ví dụ RIGHT(“Tin Hoc”,3) Bằng “Hoc” 

Nếu cell A1 chứa giá trị “G102A” thì RIGHT(A1) bằng “A”  
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7.Hàm TEXT(Value, Format Text) 

Trong đo : Value là một giá trị số, một công thức trả về giá trị số, hay một tham 

chiếu tới một cell chứa đựng một giá trị số. Format Text Là một định dạng số xác 

định bởi mã khuôn định dạng. 

Công dụng : Chuyển một giá trị thành chuỗi theo khuôn dạng số được chỉ định. 

Ví dụ TEXT(2.715, “$0.00”) Bằng “$2.72” 

TEXT(“15/4/2002”, “mmmm dd.yyyy”) Bằng “April 15.2002” 

8.Hàm TRIM(Text) 

Công dụng : Trả về một chuỗi đã được loại bỏ tất cả các khoảng trắng thừa 

Ví dụ TRIM(“    MicroSoft     Excel   “) Bằng “MicroSoft Excel” 

9.Hàm UPPER(Text) 

Công dụng : Chuyển tất cả các chữ thường trong chuỗi thành chữ hoa. 

Ví dụ UPPER(“Tin Hoc”) Bằng “TIN HOC” 

10.Hàm VALUE(Text) 

Trong đo : Text là chuỗi đặt ở một khuôn dạng bất kỳ của số, ngày, hay giờ. 

Công dụng : Chuyển chuỗi các ký số thành giá trị số. 

Lưu y : Trong nhiều trường hợp sử dụng công thức, Excel có khả năng tự động 

chuyển chuỗi thành số khi cần thiết.  

Ví dụ VALUE(“$1000”) Bằng 1000 

VALUE(“12/31/2001”) Bằng 37256 

2.3 Hàm xử lý dữ liệu dạng ngày tháng: 

1.Hàm DATE(Year, Month, Day) 

Công dụng : Trả về giá trị của thời gian theo năm, tháng và ngày chỉ định 

Trong đó :  

Year là con số chỉ năm có giá trị từ 1900 đến 9999 

Month là con số chỉ tháng của năm có giá trị từ 1 đến 12. Nếu Month>12 thì phần 

dư sẽ được chuyển sang năm kế tiếp 

Day là con số chỉ ngày của tháng có giá trị từ 1 đến 31. Nếu Day lớn hơn số ngày 

có trong tháng thì phần dư sẽ được chuyển sang tháng kế tiếp 

Ví du : DATE(2001,12,31) Bằng 12/31/2001 

DATE(2001,12,33) Bằng 01/02/2002 

2. Hàm DATEVALUE(Date Text) 

Trong đó : Trả về số thứ tự của ngày khi biết giá trị ngày ở dạng chuỗi 
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Trong đó : Date Text là chuỗi trả về một ngày trong khuôn dạng ngày. Nếu 

phần năm của Date Text không có, hàm sẽ dùng năm hiện tại của đồng hồ hệ thống. 

Các thông tin về giờ, phút trong Date Text bị bỏ qua. 

Ví dụ : DATEVALUE(“12/31/2001”) Bằng 37256 

3.Hàm NOW() 

Công dụng : Trả về giá trị ngày và giờ hiện hành của đồng hồ hệ thống 

4.Hàm TODAY() 

Công dụng : Trả về giá trị ngày hiện hành của đồng hồ hệ thống 

5.Hàm DAY(Serial_Number) 

Trong đo : Serial_Number là mã ngày được dùng bởi MS Excel. 

Serial_Number có thể là dạng chuỗi, dạng hàm trả về giá trị thời gian hay dạng số 

thứ tự chỉ giá trị thời gian 

Công dụng : Trả về số thứ tự của ngày trong tháng. Giá trị được trả về là một 

số nguyên trong khoảng từ 1 đến 31. 

Ví du : DAY(Today()) Bằng số thứ tự của ngày hiện hành 

DAY(“4/30/2002”) Bằng 30 

DAY(37256) Bằng 31 

6.Hàm MONTH(Serial_Number) 

Công dụng : Trả về số thứ tự của tháng trong năm. Giá trị được trả về là một số 

nguyên trong khoảng từ 1 đến 12. 

Ví du : MONTH(Today())  Bằng số thứ tự của tháng hiện hành 

MONTH(“4/30/2002”) Bằng 4 

MONTH(37256) Bằng 12 

7.Hàm YEAR(Serial_Number) 

Công dụng : Trả về giá trị năm. Giá trị được trả về là một số nguyên trong 

khoảng từ 1900 đến 9999. 

Ví du : YEAR(Today()) Bằng giá trị năm hiện hành 

YEAR (“4/30/2002”) Bằng 2002 

YEAR (37256) Bằng 2001 

8.Hàm WEEKDAY(Serial_Number, Return_Type) 

Công dụng : Trả về giá trị ngày trong tuần. Ngày được cho như là một số nguyên 

trong khoảng từ 1 đến 7. 

Trong đó : Return_Type Là một số định kiểu giá trị trả về 

Nếu Return_Type =1 (hoặc không ghi), hàm trả về từ số 1 (Chủ nhật) đến số 7 

(Thứ bẩy) 
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Nếu Return_Type =2 hàm trả về từ số 1 (Thứ hai) đến số 7 (Chủ nhật) 

Nếu Return_Type =3 hàm trả về từ số 0 (Thứ hai) đến số 6 (Chủ nhật) 

Ví du : WEEKDAY(Today()) Bằng số thứ tự chỉ ngày trong tuần hiện hành. 

WEEKDAY(“4/30/2002”) Bằng 3 (Thứ ba) 

2.4 Hàm thống kê và thống kê có điều kiện 

2.3.CÁC HÀM THỐNG KÊ 

1.Hàm AVERAGE(Number1, Number2,...) 

Công dụng : Trả về giá trị trung bình số học của các đối số. 

Trong đo : Number1, Number2, ... Là 1 đến 30 đối số có giá trị số mà ta muốn 

tính giá trị trung bình 

Ví dụ : Giả sử A1:A5 chứa đựng các số 1, 2, 3, 4, 5. Khi đó  

AVERAGE(A1:A5)   Bằng 3 

AVERAGE(A1:A5,9)  Bằng 4 

2.Hàm COUNT(Value1, Value2, ...) 

Công dụng : Đếm có bao nhiêu giá trị số có trong danh sách các đối số 

Trong đó : Value1,Value2, ... Là 1 đến 30 đối sốHàm COUNTA(Value1, 

Value2, ...) 

Công dụng : Đếm số lượng giá trị có trong danh sách các đối số. Ta thường 

dùng Hàm COUNTA để biết số lượng cell có dữ liệu trong một vùng các cell. 

3.Hàm MAX(Number1, Number2,...) 

Công dụng : Trả về giá trị lớn nhất trong một danh sách các đối số. 

Ví du : Giả sử A1:A5 chứa đựng các số 4, 2, 1, 3, 5. Khi đó  

MAX (A1:A5)  Bằng 5 

MAX(A1:A5,9)  Bằng 9 

4.Hàm MIN(Number1, Number2,...) 

Công dụng : Trả về giá trị nhỏ nhất trong một danh sách các đối số. 

Ví du : Giả sử A1:A5 chứa đựng các số 4, 2, 1, 3, 5. Khi đó  

MIN (A1:A5)   Bằng 1 

MIN(A1:A5,9)  Bằng 1 

5.Hàm RANK(Number,Ref, Order) 

Công dụng : Trả về hạng của một số trong một danh sách các số. 

Trong đó : Number là số mà ta muốn tìm hạng của nó. Ref là một vùng chứa 

các giá trị số. Order là số chỉ định cách đánh hạng. Nếu Order=0 (Hoặc không ghi) 
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thì hạng được đánh theo thứ tự giảm dần so với Ref. Nếu Order là một giá trị khác 

0 thì hạng được đánh theo thứ tự tăng dần so với Ref.   

Ví dụ: Nếu các cell  A1:A5 lần lượt chứa các giá trị 6.5, 7, 6.5, 6, 5 thì 

RANK(A1, A1:A5) Bằng 2 

RANK(A4, A1:A5) Bằng 4 

2.4.CÁC HÀM LOGIC 

1.Hàm AND (Logical 1, Logical 2, ...) 

Trong đó : Logical1, Logical2, ... là từ 1 đến 30 đối số có giá trị logic 

Công dụng : Trả về giá trị TRUE nếu tất cả các đối số của nó là TRUE. Trả về 

giá trị FALSE nếu có ít nhất một đối số của nó là FALSE 

Ví dụ : AND(1+1=2, 2+2=4) Bằng TRUE 

AND(1+1=2, 2+2=5) Bằng FALSE 

2.Hàm OR(Logical1, Logical2, ...) 

Công dụng : Trả về giá trị TRUE nếu có ít nhất một đối số của nó là TRUE. 

Trả về giá trị FALSE nếu tất cả các đối số của nó là FALSE  

Ví dụ : OR(1+1=2, 2+2=5) Bằng TRUE 

OR(1+1=3, 2+2=5) Bằng FALSE 

3.Hàm IF(Logical_Test, Value_if_true, Value_if_false) 

Trong đó : Logical_Test là biểu thức trả về giá trị logic. Value_if_true là giá 

trị sẽ trả về khi Logical_Test là True. Value_if_false là giá trị sẽ trả về khi 

Logical_Test là False. 

Lưu ý : các hàm IF có thể lồng nhau đến 7 cấp, khi đó Value_if_true, 

Value_if_false lại là các hàm IF khác. 

Ví dụ 

 A B C D E Điểm TB bằng (LT+TH)/2 và nếu PH là “F” thì ĐTB 

được tăng thêm 1 điểm 

= If(A2=“T”, (B2+C2)/2, (B2+C2)/2+1) 

Nếu TB>=5 thì KQ là “Đậu”, ngược lại là “Rớt”   

= If(D2>=5, ”Đậu”, ”Rớt”) 

1 PH LT TH ĐT

B 

KQ 

2 F 4.5 4.0   

3 T 6.5 4.5   

4 F 5.0 6.0   
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2.5.CÁC HÀM TÌM KIẾM VÀ THAM CHIẾU 

1.Hàm CHOOSE(Index_Num, Value1, Value2, ...) 

Trong đo : Index_Num=1..29  

Công dụng : Nếu Index_Num = i, hàm trả về giá trị của đối số Value i. 

Ví dụ CHOOSE(2, “1st”, “2st”, “3st”, “Finish”) Bằng “2st” 

SUM(A1:CHOOSE(3,A10,A20,A30)) Bằng SUM(A1:A30) 

2.Hàm HLOOKUP(Lookup_Value, Table_array, Row_Index_Num, 

Range_lookup) 

Công dụng : Tìm kiếm một giá trị trên hàng đầu tiên của Table_array và trả 

về giá trị của cell được xác định bởi cột tương ứng vàhàng thứ Row_index_num 

trong Table_array 

Trong đó : 

 Lookup_Value là giá trị được tìm kiếm trên hàng đầu tiên của Table_array 

 Table_array là bảng chứa dữ liệu được tìm kiếm 

 Nếu Range_lookup bằng 1 (Hoặc bằng TRUE, Hoặc không dùng), thì những giá 

trị trong hàng đầu tiên của Table_array phải sắp xếp theo thứ tự tăng dần, nếu 

không hàm sẽ trả về giá trị không chính xác 

Nếu Range_lookup bằng 0 (Hoặc bằng FALSE) thì Table_array không cần phải 

được sắp xếp trước. 

Hàm không phân biệt chữ hoa chữ thường trong trường hợp Lookup_value là giá 

trị chuỗi 

 Row_Index_Num Là số thứ tự hàng trong Table_array 

 Range_lookup là giá trị xác định việc tìm kiếm là chính xác hay gần đúng. 

Nếu Range_lookup bằng 1 (Hoặc bằng TRUE, Hoặc không dùng) thì khi giá trị 

giống với Lookup_value không được tìm thấy thì hàm sẽ tìm giá trị lớn nhất mà 

nhỏ hơn Lookup_value. 

Nếu Range_lookup bằng 0 (Hoặc bằng FALSE) thì hàm sẽ tìm giá trị giống với 

Lookup_value.  

Nếu không có giá trị nào được tìm thấy thì hàm sẽ trả về mã lỗi #N/A 

Ví dụ 

Giả sử ta có bảng tính sau 

 A B C D HLOOKUP(“B”,B1:D4,4,0) Bằng 50 

1  A B C HLOOKUP(Right(“G102C”),B1:D4,2,0)

 Bằng 70 

2  60 65 70 HLOOKUP(60,B2:D4,3,0) Bằng 40 

3  50 55 60 HLOOKUP(67,B2:D4,2) Bằng 55 

4  40 50 60 HLOOKUP(80,B2:D4,3,0) Bằng N/A 
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2.Hàm INDEX(Array, Row_Num, Column_Num)   

Công dụng : Có hai hình thức của INDEX, Tham chiếu và Dãy. Hình thức tham 

chiếu luôn trả về một tham chiếu. Hình thức dãy luôn trả về một giá trị hay một dãy 

các giá trị 

Trong đó :  

Array là bảng chứa dữ liệu.  

Row_Num  là số thứ tự hàng trong bảng dữ liệu.  

Column_Num là số thứ tự cột trong bảng dữ liệu. 

INDEX theo hình thức dãy: 

Nếu cả hai đối số Row_num và Column_num được dùng, INDEX trả về giá trị 

tại cell là giao điểm của Row_num và Column_num. 

Nếu Array chỉ có một hàng hay một cột thì Row_num hay Column_num tương 

ứng là không cần thiết  

Nếu Array có nhiều hơn một hàng và nhiều hơn một cột và chỉ có một đối số là 

Row_num hay Column_num  được dùng thì hàm INDEX trả về một dãy của toàn 

bộ hàng hay cột tương ứng. 

INDEX theo hình thức tham chiếu :  

Sẽ trả về địa chỉ của cell nằm tại giao điểm của Row_num và Column_num 

Ví dụ 

 

 A B C D  

1     =INDEX(B2:D4,2,3) Bằng 55 

2  60 65 70 =INDEX(B2:B4,2) Bằng 45 

3  45 50 55 =SUM(B2:INDEX(B2:D4,3,1)) Bằng 

135 

4  30 35 40 =SUM(INDEX(B2:D4,3,)) Bằng 105 

3.Hàm MATCH(Lookup_Value, Lookup_array, Match_type) 

Công dụng : Trả về vị trí tương đối của một phần tử trong một bảng. 

Trong đó :  

 Lookup_Value là giá trị mà ta dùng để tìm kiếm trên Lookup_array 

 Lookup_array là một vùng thuộc một dòng hoặc một cột. 

 Match_type bằng 0, 1, -1. 

Nếu Match_type bằng 0, tìm giá trị trên Lookup_array bằng với giá trị 

Lookup_value 
Nếu Match_type bằng 1 (hoặc không dùng), tìm giá trị trên Lookup_array là 

lớn nhất, nhỏ hơn hay bằng với giá trị Lookup_value. Lúc đó Lookup_array 

phải được đặt theo thứ tự tăng dần. 
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Nếu Match_type bằng -1, tìm giá trị trên Lookup_array là nhỏ nhất, lớn hơn 

hay bằng với giá trị Lookup_value. Lúc đó Lookup_array phải được đặt theo 

thứ tự giảm dần. 

Ví dụ: Giả sử ta có bảng tính sau 

 A B C D =MATCH(“B”,B1:D1,0) Bằng 2 

1  A B C =MATCH(“B”,A1:D1,0) Bằng 3 

4.Hàm VLOOKUP(Lookup_Value, Table_array, Col_Index_Num, 

Range_lookup) 

Công dụng : Tìm kiếm một giá trị trên cột đầu tiên của Table_array và trả về giá trị 

của cell được xác định trên dòng tương ứng và cột thứ Col_index_num trong 

Table_array. 

Trong đó : 

 Lookup_Value là giá trị được tìm kiếm trên cột đầu tiên của Table_array 

 Table_array là bảng chứa dữ liệu được tìm kiếm 

 Nếu Range_lookup bằng 1 (Hoặc bằng TRUE, Hoặc không dùng), thì những giá 

trị trong cột đầu tiên của Table_array phải sắp xếp theo thứ tự tăng dần, nếu 

không hàm sẽ trả về giá trị không chính xác 

Nếu Range_lookup bằng 0 (Hoặc bằng FALSE) thì Table_array không cần phải 

được sắp xếp trước. 

Hàm không phân biệt chữ hoa chữ thường trong trường hợp Lookup_value là giá 

trị chuỗi 

 Col_Index_Num Là số thứ tự cột trong Table_array 

 Range_lookup là giá trị xác định việc tìm kiếm là chính xác hay gần đúng. 

Nếu Range_lookup bằng 1 (Hoặc bằng TRUE, Hoặc không dùng) thì khi giá trị 

giống với Lookup_value không được tìm thấy thì hàm sẽ tìm giá trị lớn nhất mà 

nhỏ hơn Lookup_value. 

 Nếu Range_lookup bằng 0 (Hoặc bằng FALSE) thì hàm sẽ tìm giá trị giống với 

Lookup_value.  

Nếu không có giá trị nào được tìm thấy thì hàm sẽ trả về mã lỗi #N/A 

Ví dụ: Giả sử ta có bảng tính sau 

 A B C D =VLOOKUP(“B”,A2:D4,3,0) Bằng 45 

1  0 1 2 =VLOOKUP(Right(“G102C”),A2:D4,2,0) Bằng 30 

2 A 20 40 60 =VLOOKUP(20,B1:D4,3,0) Bằng 60 

3 B 25 45 65 =VLOOKUP(27,B1:D4,2) Bằng 45 

 Bài tập và sản phẩm thực hành bài 07.8 

Kiến thức: 

Câu 1: Hàm là gì? Trình bày cú pháp chung của hàm. 

Câu 2: Trình bày cú pháp và công dụng của một số hàm thông dụng đã học. 
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Câu 3: Khi sử dụng hàm IF tối đa ta có thể lồng ghép bao nhiêu hàm? 

Bài tập ứng dụng:    

Bài tập 07.8.1: 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

Cộng hoa xã hội chủ nghĩa việt Nam 

Độc lập -  Tự do  - Hạnh phúc 

BẢNG KÊ PHÂN BỔ HÀNG HÓA 

 
T

T 

TÊN 

HÀNG 

ĐƠN 

GIÁ 

ĐVỊ QDOANH ĐVI TẬP THỂ TƯ NHÂN TỔNG 

TIỀN 

TỶ  

LỆ SỐ LG TTIỀN SỐ LG TTIỀN SỐ LG TTIỀN 

1 Xi măng 100 120 (a) 100 (b) 50 (c) (d) (e) 

2 Sắt 50 140  100  60    

3 Phân bón 60 160  50  30    

4 Trừ sâu 120 70  40  40    

5 Sơn 150 30  20  10    

6 Dầu lửa 30 20  10  30    

7 Xăng 40 40  50  50    

8 Gạo 20 250  120  20    

9 Đường 30 560  60  10    

10 Sữa 35 35  40  30    

11 Cà phê 40 40  20  10    

12 Thuốc Lá 16 16  10  50    

TỔNG TIỀN  ?  ?  ? ?  

TỶ LỆ  ?  ?  ?   

 

YÊU  CẦU:    

1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột 

- Các cột thành tiền = số lượng *đơn giá 

- Cột tổng tiền (d) = Tổng 3 cột TTiền  (Dùng hàm SUM) 

- Cột Tỷ lệ (e) = Tổng tiền của từng món hàng /ô  tổng cọng  (chú ý địa chỉ tuyệt 

đối) 

- Dấu ? : + Tính tổng tiền của  từng đơn vị (Dùng hàm SUM) 

      + Tính tỷ lệ = Tổng tiền  của từng đơn vị/ô tổng cộng (chú ý địa chỉ tuyệt 

đối) 

3. Đổi các cột thành tiền sang  dạng tiền tệ (Currency), 0 số lẽ  

    Đổi cột và hàng Tỷ lệ thành dạng số % (Percent), 2 số lẽ  

4. Kẻ khung như trên và ghi lại với tên TH05.XLSX 

Băi tập 07.8.2: 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

BẢNG ĐIỂM THI TỐT  NGHIỆP 
 

T

T 

HỌ VÀ TÊN TOÁN VĂN NNGU ĐTB KQUA XLOAI 

1 Trần Duy Trị  4 7.5 8 (a) (b) (c) 

2 Hồ Thị Tuyết 7.5 6.5 6.5    
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3 Lê Văn Mừng 8.5 8.5 8.5    

4 Lê Ngọc Trong 9 9 9    

5 Trần Hà Dũng 4 8.5 4    

6 Trần Thanh Thanh 6.5 6.5 6.5    

7 Nguyễn Vi Trục 7.5 7.5 7.5    

8 Lê Chí Hùng 8.5 4.5 6    

9 Đoàn Huân 5.5 5.5 5.5    

 10 Hoàng Nhĩ 9.5 8 3    

ĐIỂM THẤP NHẤT ?   

ĐIỂM CAO NHẤT ?   

YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô  

2. Tnh toán  

- Cột (a) = (Toán + Văn + NNgữ)/3 

- Cột (b) =  “Đậu” Nếu DTB >+ 5 vă “Rớt “ Nếu ĐTB  <5 

- Cột (c)= “XS”  Nếu ĐTB <10  

    = “Giỏi” Nếu ĐTB >=7 vă ĐTB=<9 

    =  “Khâ” Nếu ĐTB < 7 vă ĐTB >=5 

    = “Kém” Nếu ĐTB <5 

- Định dạng lại cho cột ĐTB thành dạng Number, 2 số lẽ 

3. Lưu bảng tính vào đĩa với tên TH03.XLSX và  Đóng tập tin lại 

4. Lấy lại tập tin TH03.XLSX vào bảng tnh 

5. Chèn Thêm cột PHÁI vào sau cột TEN, nhập dữ liệu cho cột này 

  - Chèn thêm 2 dòng vào dưới dòng BẢNG ĐIỂM .....  nhập thêm vào 

Năm học 1994 - 1995 
 
Sửa lại “BẢNG ĐIỂM . .” Thành “BẢNG KẾT QUẢ. . . . “ ghi lại tập tin vào đĩa 

5. Thoát khỏi Excel 

Chú ý :  C thể  tạo Font như trong bài hoặc tùy ý 

Băi tập 07.8.3: 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

Trường Đại học Đà Nẵng 

KẾT QUẢ  THI TUYỂN  

 
TT MÃ SỐ HỌ VÀ TÊN NS NGÀY SINH D1 D2 D3 ĐTC ĐKQ KQ 

1 T1A Trần Duy Trị  (a) 12/05/80 4 7.5 8 (b) (c) (e) 

2 Q4D Hồ Thị Tuyết  24/04/80 7.5 6.5 6.5    

3 D2B Lê Văn Mừng  12/12/80 8.5 8.5 8.5    

4 N3C Lê Ngọc Trong  30/04/79 9 9 9    

5 T1D Trần Hà Dũng  15/10/80 4 8.5 4    

6 Q4D Trần  Thanh  17/12/81 6.5 6.5 6.5    

7 D2B Nguyễn  Trục  25/09/79 7.5 7.5 7.5    

8 N3C Lê Chí Hùng  14/11/80 8.5 4.5 6    

9 Q4A Đoàn Huân  08/09/81 5.5 5.5 5.5    

 10 T1C Hoàng  Nhĩ  22/06/78 9.5 8 3    
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YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô  

  Chú ý : Định dạng cho cột ngày sinh dạng DATE 

2. Tính toán  

- Cột (a) = Nếu 2 ký tự đầu của Mã  số là : 

T1 thì điền vào “TP HCM” ; D2 thì điền vào “Dăklăk” ; N3 thì điềm vào “Ninh 

thuận”  

Q4 thì điền vào “Đà Nẵng” 

- Cột (b) =  D1+D2+D3 Và định dạng là dạng NUMBER, 2 số lẽ 

- Cột (c)= Nếu ĐTC >=22 thì lấy ĐTC, ngược lại : 

 + Nếu ký tự cuối  cùng của MASO là B thì cộng thêm 1.5 vào ĐTC 

 + Nếu ký tự cuối  cùng của MASO là C thì cộng thêm 1 vào ĐTC 

- Cột (d) = Nếu ĐKQ >= 22 thì điền vào “Đậu”, ngược lại “Hỏng” 

3. Lưu bảng tính vào đĩa với tên TH04.XLSX 
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Băi tập 07.8.4: 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

BẢNG THANH TOÁN  TIỀN TIÊU THỤ  ĐIỆN 
 

TT TÊN KHÁCH CHỈ SỐ CŨ CHỈ SỐ MỚI SỐ LƯỢNG SỐ TIỀN  THUẾ GTGT TTIỀN 

1 Trần Duy 100 250 (a) (b) (c) (d) 

2 Hồ Thị Hòa 50 172     

3 Lê Văn Lịch 60 182     

4 Lê Ngọc Sang 120 350     

5 Trần Hà Thanh 150 241     

6 Trần Thanh 30 172     

7 Nguyễn Văn An 40 312     

8 Lê Chí Đức 20 125     

9 Đoàn  Hường 30 109     

 10 Hoàng Xuân Hà 35 153     

 11 Lê Hoài Trân 40 183     

 12  Trần Vân Anh 16 321     

       

YÊU  CẦU 

1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột 

- Cột (a) = chỉ số mới - Chỉ số cũ 

- Cột (b) = số lượng * giá theo các định  mức sau của số lượng : 

 + Tiêu thụ 100 Kw đầu, chỉ tính giá      450 đ 

 + Tiêu thụ 100 Kw tiếp theo, tính giá      650 đ 

 + Số Kw còn lại, tính giá         850 đ  

- Cột (c) = số tiền * 0.1 

- Cột (d) = Số tiền +thuế GTGT  

- Tính hộ thanh toán tiền cao nhất và hộ thanh toán tiền thấp nhất  (Dùng hàm 

Max, Min) 

3. Chèn 1 hình tùy ý vào giữa bảng tính 

4. Di chuyển cột thuế GTGT vào trước cột số tiền 

5. Sắp xếp cột thành tiền theo thứ tự giảm dần 

6. Kẻ khung như trên và ghi lại với tên TH06.XLSX 

 

Băi tập 07.8.5: 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

 

 

 

 

 

 

 

BẢNG GIÁ 

C-cấp K-doanh 

Xăng 150 500 

Gasolt 120 450 

Dầu 100 260 
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BÁO CÁO PHÂN PHỐI NHIÊN LIỆU 

Từ 1/4/00 đến 30/4/00 

(số ngày phục vụ :25) 
T

T 

CHỨNG 

TỪ 

ĐƠN VỊ NHẬN SỐ 

LƯỢNG 

XĂNG GASOLT DẦU 

SỐ LG TIỀN SỐ LG TIỀN SỐ LG TIỀN 

1 X001C Cty du lịch 100       

2 GOO1K XN vân tải 150       

3 X002K Đội bảo vệ 200       

4 L001C N-máy Z75 100       

5 G002C Xưởng 304 50       

6 G003K Xn Điện Lạnh 120       

7 X004C Xn cơ khí 80       

8 L003K Cty lương thực 250       

9 X004C Căng tin 180       

10 L002C Đội vân tải 120       

 

YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột 

- Các cột số lượng căn cứ vào ký tự đầu tiên của số chứng từ để phân bổ số lượng 

vào cho các cột : XĂNG, GOSOLT hay DẦU LỬA 

 + Nếu ký tự đầu tiên bên trái là X thì phân bổ vào cột XĂNG 

 + Nếu ký tự đầu tiên bên trái là G thì phân bổ vào cột GOSOLT 

 + Nếu ký tự đầu tiên bên trái là L thì phân bổ vào cột DẦU LỬA 

- Các cột thành tiền = số lượng*đơn giá; Đơn giá  căn cứ vào ký tự cuối của số 

chứng từ. 

 + Nếu ký tự cuối là C thì lấy giá C-cấp 

+ Nếu ký tự cuối là K thì lấy giá K-doanh 

Hướng dẫn : Dùng hàm IF kết hợp với hàm LEFT và hàm RIGHT để tính 

3. Chèn 1 hình tùy ý vào giữa bảng tính 

4. Kẻ khung như trên và ghi lại với tên TH07.XLSX 

Bài tập 07.8.6: 
 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc 
 

 

BẢNG THANH TOÁN TIỀN KHÁCH SẠN 
 

T

T 

LOẠI 

PHÒNG 

TÊN ngày 

đến 

ngày đi số 

tuần 

số 

ngày 

giá 

tuần 

giá 

ngày 

tiền 

($) 

tiền 

(Đ) 

1 L3B Trị  10/05/00 23/06/00 (a) (b) (c) (d) (e) (f) 

2 L2A Tuyết 23/07/00 11/08/00       

3 L1A Mừng 12/06/00 19/06/00       

4 L1B Trong 26/05/00 07/06/00       
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5 TRA Dũng 19/08/00 25/08/00       

6 TRB Thanh 12/08/00 22/09/00       

7 L1A Trục 23/09/00 05/10/00       

8 L2B Hùng 13/09/00 27/10/00       

9 L1B Huân 24/11/00 26/12/00       

10 L3A Nhĩ 24/11/00 26/12/00       

11 L2A Lương 24/11/00 26/12/00       

12 L1A Tống 24/11/00 26/12/00       

13 L3B Đường 24/11/00 26/12/00       

14 TRB Triều 24/11/00 26/12/00       

15 TRA Minh 24/11/00 26/12/00       

16 L3A Thức 24/11/00 26/12/00       

Cộng thành tiền ? ? 
 

BẢNG GIÁ KHÁCH SẠN     BẢNG THỐNG KÊ 

LPHÒN

G 

Giá 

tuần 

Giá 

ngày 

TRA 50 10 

TRB 45 8 

L1A 60 12 

L1B 50 10 

L2A 55 11 

L2B 50 10 

L3A 40 7 

L3B 30 5 

 

YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột 

- Cột  (a) : Tính số tuần lưu lại khách sạn (Dùng hàm INT) 

- Cột (b)  : Tính số ngày lẽ lưu lại khách sạn (Dùng hàm MOD) 

- Đơn giá ngày và đơn giá tuần căn cứ vào loại phòng và bảng giá khách sạn (Dùng 

hàm VLOOKUP) 

- Cột (e) = số tiền tính theo tuần  (số tuần *đơn giá tuần)+ Số tiền tính theo ngày 

(Số ngày * đơn giá ngày) . Nhưng số tiền tính theo ngày vượt quá đơn giá 1 tuần 

thì lấy đơn giá tuần. (Dùng hàm MIN  và MAX) 

- Cột (d) = cột (e) *14680 

- Tính Tổng thành tiền cho cột TIỀN ($) và tiền (Đ) 

3. Tính toán bảng thống kê bằng 2 cách : data Table và  data consolidate 

4. Kẻ khung, trình bày theo mẫu và ghi lại với tên TH06.XLSX 

Bài tập 07.8.7: 

 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

SÁCH GIÁO KHOA XUẤT  

LPHÒNG SỐ 

TUẦN 

SỐ 

NGÀY 

TIỀN 

($) 

TRA    
TRB    
L1A    
L1B    
L2A    
L2B    
L3A    
L3B    
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TRONG  THÁNG 03/2011 

                BẢNG GIẢM GIÁ 

KHỐI 

LỚP 

TỈ LỆ giẢm (%) 

TRÊN ĐƠN GIÁ 

09 15% 

10 12% 

11 10% 

12 5% 

 
 

TT 

MÃ 

SGK 

NGÀY KHÔI 

LỚP 

loại 

sách 

SỐ 

LƯỢNG 

ĐƠN GIÁ 

BÁN 

GIẢM T TIỀN 

1 L12 10/05/00 (a) (b) 125 4.000,00 (c) (d) 

3 V12 12/06/00   80 4.500,00   

4 T09 26/05/00   150 3.200,50   

5 H09 19/08/00   175 3.750,20   

6 H12 12/08/00   240 5.200,00   

7 H11 23/09/00   120 4.700,00   

8 T10 13/09/00   150 5.123,00   

9 T12 24/11/00   140 2.980,00   

10 H10 24/11/00   90 3.400,00   

11 L09 24/11/00   150 4.300,00   

12 L11 24/11/00   150 3.125,00   

13 V11 24/11/00   75 3.900,00   

14 V09 24/11/00   130 4.720,00   

15 L10 24/11/00   75 5.500,00   

16 V10 24/11/00   160 3.750,00   
YÊU  CẦU:    

1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột 

- Cột  (a) : Dựa vào 2 ký tự cuối cùng của cột MÃ SGK để  lấy  khối lớp Ví dụ :  

V10 Tức lớp 10 

(Dùng hàm IF và hàm RIGHT) 

- Cột (b)  : Dựa vào ký tự đầu tiên  của cột Mã SGK để ban hành công thức  : 

 Nếu là L thì sách Lý ; Nếu là T thì sách Toán ; Nếu là V thì sách Vật lý ; Nếu 

là H thì sách Hóa 

- Cột (c) :( chứa mức giảm của từng loại sách) tính  : 

 GIẢM = ĐƠN GIÁ BÁN* TỈ LỆ GIẢM (%) (cho từng khối lớp) 

 Với tỉ lệ giảm (%) được ra cứu trên bảng mẫu (dùng hàm vlookup) 

- Cột (d) =số lượng * (đơn giá bán - giảm) 

3. Kẻ khung, trình bày theo mẫu và ghi lại với tên TH07.XLSX 

Bài tập 07.8.8: 
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Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

BẢNG TÍNH ĐIỂM HỌC SINH 

TT MÃ SỐ HỌ VÀ TÊN TÊN TRƯỜNG MÔN THI ĐIỂM THI XẾP LOẠI 

1 A01T Trần Duy Trị  (a) (b) 8 (c) 

2 A01V Hồ Thị Tuyết   5  

3 B01T Lê Văn Mừng   9  

4 C02S Lê Ngọc Trong   5.5  

5 B02T Trần Hà Dũng   9  

6 C01V Trần Thanh Thanh   7.5  

7 B02S Nguyễn Văn Trục   8.5  

8 A03T Lê Chí Hùng   9.5  

9 D03S Đoàn Huân   6.5  

10 H10 Hoàng Xuân Nhĩ   9  

11 A02T Trần  Bửu   7  

12 B03T Lê Hòa Hải   6  

13 B01T Trần Bình Chương   9.5  

14 B03S Lê Phước Hòa   4.5  

15 C02V Nguyễn văn Hậu   3.5  

16 C03T Trần kỳ  Hà   8.5  

                 BẢNG TRA TÊN TRƯỜNG     BẢNG TRA TÊN MÔN THI 

Mã tên trường 

A Võ trường toản 

B Đinh tiên hoàng 

C Hòa Bình 

D Nguyễn Du 

 

YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột 

- Cột (a) : Tên trường căn cứ vào 1 Mã bên trái của Mã số và Bảng tra tên trường 

(Dùng hàm VLOOKUP) 

- Cột (b) : Tên Môn thi căn cứ vào 1 mã bên phải của Mã số và bảng tra tên môn thi 

(Dùng hàm HLOOKUP) 

- Cột (c) : Từ điểm thi, Hãy ban hành công thức cho cột xếp loại 

3.Sắp xếp bảng tính trên dựa vào cột điểm thi 

4. Từ bảng tính trên trích ghi ra 1 bảng riêng gồm những học sinh thuộc trường võ 

trường toản 

5. Từ bảng tính trên trích ra  1 bảng riêng gồm 5 học sinh xếp hạng cao nhất 

6. Tạo bảng thống kê  sau : 

Thống kê số học sinh đi thi theo trường và môn thi 

 

               Môn thi 

Trường 

Sinh ngữ Toán Văn 

Đinh tiên hoàng    

Võ Trường Toản    

Hòa Bình    

Nguyễn Du    

Mã  S T  V  

Môn thi Sinh ngữ Toán  Văn 
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7. Bạn hãy thử nối cột Họ và cột tên thành 1 cột lấy tên HỌ VÀ TÊN (dùng toán tử 

&) 

8. Ghi vào đĩa với tên TH08.XLSX 

CHỈ DẪN ĐỐI VỚI HỌC SINH THỰC HIỆN BÀI TẬP ỨNG DỤNG 

Đánh giá kết quả học tập 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối 

đa 

Kết quả thực 

hiện của 

người học 

I Kiến thức    

1 Khởi động MS Excel 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

1  

2 Các thao tác cơ bản đối với bảng 

tính  
1  

3 Các thao tác di chuyển trong bảng 

tính 
2  

4 Các loại địa chỉ trong Excel 1  

5 Các kiểu dữ liệu trong MS Excel 1  

6 Các loại toán tử và độ ưu tiên của 

nó trong Excel 
2  

7 Định dạng các dữ liệu trong Excel  2  

                                      Cộng: 10 đ  

II Kỹ năng    

1 Khởi động và thoát khỏi MS 

Excel  

  

 Kiểm tra sản phẩm 

sau buổi thực hành 

  

  

1 
 

2 
Lệnh cơ bản đối với bảng tính 

2  

3 Thao tác thành thạo trong MS 

Excel 
2  

4 Nhập đúng dữ liệu theo yêu cầu 2  

5 Ban hành công thức đúng theo 

yêu cầu BT trong Excel 
3  

                              Cộng: 10 đ  

III Thái độ    
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1 Tác phong công nghiệp Theo dõi việc thực 

hiện, đối chiếu với 

nội quy của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1.5  

1.2 Không vi phạm nội quy lớp học 1.5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc thực 

hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời gian 

thực hiện bài tập, 

đối chiếu với thời 

gian quy định. 

2 

 

3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp 
Theo dõi việc thực 

hiện, đối chiếu với 

quy định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 1.5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1.5 

 

3.3 Vệ sinh phòng thực hành đúng 

quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0.3  

Kỹ năng  0.4  

Thái độ  0.3  

                                                                                              

Cộng: 
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BÀI 9: ĐỒ THỊ VÀ IN ẤN 

 

Giới thiệu: Bảng tính sẽ thể hiện số liệu một cách rõ ràng hơn khi ta thể hiện bằng 

đồ thị.  

Mục tiêu của bài: 

- Thực hiện được đồ thị dựa trên số liệu đã tính toán trong bảng tính; 

- Chọn lựa các chế độ và hiệu chỉnh trước khi in ấn; 

- Thực hiện các thao tác an toàn với máy tính. 

1 Giới thiệu đồ thị  

Đồ thị giúp trình bày các số liệu khô khan bằng việc vẽ thành các hình ảnh 

trực quan, dễ hiểu. Đồ thị được liên kết với dữ liệu của nó trong bảng tính, do đó khi 

thay đổi dữ liệu của nó trong bảng tính thì lập tức đồ thị sẽ thay đổi tương ứng theo. 

Trong Excel 2010 việc vẽ đồ thị chưa bao giờ dễ dàng và đẹp như bây giờ. Excel có 

rất nhiều kiểu đồ thị khác nhau phục vụ cho nhiều mục đích khác nhau của rất nhiều 

loại đối tượng sử dụng bảng tính, chúng ta sẽ cùng nhau khám phá thế giới đồ thị 

của Excel trong bài học này. Đồ thị là một đối tượng (object) của Excel, đối tượng 

này chứa các dữ liệu và biểu diễn thành hình ảnh với màu sắc và kiểu dáng rất phong 

phú. Nhìn chung, Excel có 2 loại đồ thị đó là đồ thị nằm trong WorkSheet (còn gọi 

là Embedded chart) và ChartSheet. Để chuyển đổi qua lại giữa 2 loại đồ thị này ta 

làm như sau: Chọn đồ thị ->Chart Tools ->Design ->Location ->Move Chart -

>chọn Object in + Tên Sheet (đồ thị nằm trong Worksheet) hay chọn New sheet + 

Nhập tên ChartSheet vào. 

 

Chọn ChartSheet hay Embedded chart 
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2. Vẽ đồ thị  

Phần này trình bày các bước vẽ đồ thị từ một bảng số liệu cho trước và một số tùy 

chọn của đồ thị. Kết quả nghiên cứu về sự thõa mãn của các nhóm khách hàng phân 

theo độ tuổi được cho như hình bên dưới, nếu chúng ta dùng kết quả này để báo cáo 

cũng không có vấn đề gì, tuy nhiên báo cáo sẽ sinh động và thuyết phục hơn nếu 

chúng ta biến các con số này thành đồ thị để được nhìn thấy một cách trực quan hơn. 

 

Bảng số liệu nghiên cứu 

Hãy làm theo các bước sau để vẽ đồ thị: B1. Chọn vùng dữ liệu A3:D9, chọn luôn 

các nhãn của các cột. B2. Chọn kiểu đồ thị từ Ribbon ->Insert ->Charts. Mỗi nhóm 

đồ thị bao gồm nhiều kiểu khác nhau, ví dụ chúng ta chọn nhóm Column -

>Clustered Column. 

 

Chọn kiểu đồ thị 

B3. Xong bước 2 là chúng ta đã có ngay một đồ thị dạng cột như hình trên, tuy nhiên 

chúng ta có thể đổi các bố trí của các thành phần trên đồ thị. Chọn đồ thị ->Chart 
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Tools ->Design ->Chart Layout ->Chọn cách bố trí thích hợp. Ví dụ ta chọn kiểu 

Layout 3 trong Chart Layout. 

 

Lựa chọn layout 

B4. Đảo các chuỗi số liệu từ dòng thành cột và ngược lại: Chart Tools ->Design -

>Data ->Switch Row/Column. Chúng ta thực hiện lệnh này khi các đồ thị ở bước 

trên chưa hiển thị đúng như mong muốn. Ví dụ chúng ta muốn nhóm các nhóm tuổi 

lại để dễ so sánh giữa các tháng với nhau. 

 

Đảo dòng/ cột 
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B5. Nếu thấy kiểu đồ thị trên không đẹp, chúng ta có thể đổi sang kiểu khác bằng 

cách: Chart Tools ->Design ->Type ->Change Chart Type, hộp thoại Insert Chart 

hiển thị liệt kê toàn bộ các kiểu đồ thị hiện có của Excel tha hồ cho bạn lựa chọn. 

 

Hộp thoại Insert Chart và chọn kiểu đồ thị khác 

B6. Ngoài ra, nếu bạn thấy tông màu của đồ thị chưa đẹp thì vào chọn Chart Tools 

->Design ->Chart Styles ->chọn More ( ).  

 

Chọn Chart Style 
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5.3. Các thao tác trên đồ thị  

a. Nhận biết các thành phần trên đồ thị  

Các thành phần thông dụng 

 

1. Chart Title  7. Horizontal Axis  

2. Chart Area  8. Data Table  

3. Plot Area  9. Horizontal Axis itle  

4. Data Label  10. Vertical Gridlines  

5. Legend  11. Vertical Axis  

6. Horizontal Gridlines  12. Vertical Axis Title  

Một số thành phần chỉ có trong đồ thị 3-D 

o Back wall: Màu/ hình hền phía sau đồ thị  

o Side wall: Màu/ hình nền ở các cạnh bên của đồ thị  

o Floor: Màu/ hình nền bên dưới đồ thị  

o Column depth: Độ sâu của các thành phần biểu diễn chuỗi số liệu dưới dạng 

3-D.  
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b. Các thao tác với đồ thị  

Chọn thành phần trên đồ thị  

o Cách dễ nhất là dùng chuột nhấp lên thành phần 

cần chọn, thành phần được chọn sẽ có 4 hoặc 8 

nút xuất hiện bao quanh.  

Khi đồ thị đã được chọn, chúng ta có thể dùng các phím 

mũi tên -> để di chuyển đến các thành phần trong đồ 

thị.  

o Ngoài ra, chúng ta có thể chọn các thành phần 

tại Chart Tools ->Format ->Current Selection  

Chọn thành phần trên đồ thị 

Di chuyển đồ thị  

- Đồ thị là Embedded Chart, nhấp trái chuột lên đồ thị vùng Chart Area để chọn đồ 

thị di chuyễn, khi đó đầu con trỏ chuột có thêm ký hiệu mũi tên 4 chiều . 

- Giữ trái chuột và di chuyển đồ thị đến nơi khác.  

Thay đổi kích thước đồ thị  

- Đồ thị là Embedded Chart, hấp trái chuột lên đồ thị vùng Chart Area để chọn đồ 

thị cần thay đổi kích thước, khi đó xung quanh đồ thị xuất hiện 8 nút nắm.  

-Di chuyển chuột vào các nút này, giữ trái chuột và kéo hướng vô tâm đồ thị để thu 

nhỏ và hướng ra ngoài để phóng to.  

Sao chép đồ thị  

- Chọn đồ thị, dùng tổ hợp phím <Ctrl+C> để chép đồ thị vào bộ nhớ, rồi di chuyển đến một ô nào 

đó trong bảng tính và nhấn <Ctrl+V> để dán đồ thị vào.  

Xóa đồ thị  

- Chọn đồ thị sau đó nhấn phím Delete để xóa đồ thị. Để xóa Chart Sheet, trước tiên 

hãy chọn Chart Sheet, sau đó nhấp phải chuột và chọn Delete từ thực đơn ngữ cảnh 

hiện ra.  



 Trang 176  

Thêm các thành phần của đồ thị  

- Chọn đồ thị ->chọn Chart Tools ->Design ->Chart Layouts Sử dụng các nhóm 

lệnh tạo các thành phần tương ứng trên đồ thị được thiết kế sẵn như tựa đề, chú thích, 

các nhãn, đường lưới,…  

Sắp xếp và xóa các thành phần của đồ thị  

- Một số thành phần trong đồ thị có thể di chuyển được như tựa đề, chú thích, nhãn. 

Muốn di chuyển thành phần nào trước tiên hãy dùng chuột chọn nó, sau đó nhấp và 

giữ trái tại cạnh của thành phần và kéo đến vị trí mới trong đồ thị.  

-  Ngoài ra có thể vào Chart Tools ->Layout ->chọn từ các danh sách thiết kế sẵn.  

-  Để xóa thành phần nào, chúng ta chỉ cần dùng chuột chọn thành phần đó và nhấn 

phím Delete.  

 

Các thành phần trên đồ thị 

c. Hiệu chỉnh và định dạng đồ thị  

Việc hiệu chỉnh và định dạng các thành 

phần trên đồ thị ta có thể dùng Ribbon hay 

dùng các hộp thoại. Cách dễ thực hiện nhất 

là nhấp phải chuột lên thành phần cần định 

dạng và chọn Format … hay nhấn 

<Ctrl+1>. Sau đây là minh họa hiệu chỉnh 

và định dạng một số thành phần của đồ thị.  

 

Định dạng Chart Area 
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Hiệu chỉnh Chart Area  

- Chúng ta có thể hiệu chỉnh màu sắc, hiệu ứng, đường kẽ, khung, đổ bóng… cho 

Chart Area bằnh cách: chọn Chart Area ->nhấp phải chuột ->chọn Format Chart 

Area…  

- Ngoài ra chúng ta có thể vào Ribbon ->Chart Tools ->Format Shape 

Styles có cung  

cấp rất nhiều mẫu định dạng dựng sẵn rất đẹp.  

Ghi chú:  

- Fill: Nhóm lệnh liên quan đến tô nền cho thành phần đang chọn  

- Border Color: Nhóm lệnh liên quan đến kẻ khung và màu sắc của thành phần đang 

chọn  

- Border Styles: Các kiểu đường két kẻ khung của thành phần đang chọn.  

- Shadow: Liên quan đến việc đổ bóng cho thành phần đang chọn  

- 3-D Format: Tạo hiệu ứng 3-D cho thành phần đang chọn.  

 

Định dạng bằng Ribbon 

Hiệu chỉnh Flot Area  

- Chọn Plot Area ->Chart Tools ->Format ->Shape Styles ->chọn kiểu định dạng  
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Muốn phóng to/ thu nhỏ Plot Area ->Nhấp chuột trái vào các nút bao quan Plot Area 

và kéo hướng vô Plot Area để thu nhỏ và hướng ra ngoài Plot Area để phóng to.  

Hiệu chỉnh tiêu đề đồ thị, chú thích, tiêu đề trục hoành và trục tung,…  

Tùy theo kiểu đồ thị đang xử lý mà Excel cho phép chúng ta hiệu chỉnh các loại tiêu 

đề của kiểu đồ thị đó.  

- Thêm tiêu đề chính cho đồ thị: Chart Tools ->Layout ->Labels ->Chart Title ->lựa 

chọn kiểu từ danh sách  

- Thêm tiêu đề cho trục hoành (hay trục tung): Chart Tools ->Layout ->Labels -

>Axis Titles ->lựa chọn kiểu từ danh sách  

- Thêm chú thích :Chart Tools ->Layout ->Labels ->Legend ->lựa chọn kiểu từ 

danh sách  

- Thêm nhãn dữ liệu :Chart Tools ->Layout ->Labels ->Data Labels ->lựa chọn 

kiểu từ danh sách  

 

 

 

 

 

 

 

 

 

Hiệu chỉnh chú thích cho đồ thị từ hộp thoại Data Source 

- Để thêm bảng dữ liệu vào Chart Tools ->Layout ->Labels ->Data Table ->lựa 

chọn kiểu từ danh sách.  
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- Ngoài ra chúng ta có thể chèn các Text Box vào đồ thị Chart Tools ->Layout -

>Insert ->Text Box.  

Hiệu chỉnh đường lưới ngang và dọc  

- Muốn thêm hay bỏ đường lưới trước tiên chúng ta chọn Plot Area, rồi vào Chart 

Tools ->Layout ->Axes ->Gridlines ->chọn kiểu phù hợp từ danh sách.  

- Để hiệu chỉnh màu sắc, kiểu của đường lưới nào thì chọn nó và vào Chart Tools -

>Format ->Shape Style ->chọn kiểu và màu sắc theo nhu cầu.  

Hiệu chỉnh các trục Muốn hiệu chỉnh thông số cho trục trên đồ thị thì chúng ta hãy 

chọn trục ->nhấp phải chuột ->chọn Format Axis… Sau đây là giải thích các thông 

số trong hộp thoại Format Axis. 

 

Hộp thoại Format Axis tùy theo giá trị của trục mà chúng ta chọn 

Value Axis  

Hầu hết các đồ thị trình bày giá trị trên trục tung và phân nhóm trên trục hoành. Các 

chúng ta nên chọn thử để biết rõ hơn công dụng của các tùy chọn.  

- Minimum Xác định giá trị nhỏ nhất trên trục (giá trị khởi đầu)  

o Auto Để Excel tự xác định  

o Fixed Qui định giá trị nhỏ nhất cho trục  

- Maximum Xác định giá trị lớn nhất trên trục (giá trị kết thúc)  
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o Auto Để Excel tự xác định  

o Fixed Qui định giá trị nhỏ nhất cho trục  

- Major unit:Xác định giá trị các khoảng chia chính trên trục.  

o Auto Để Excel tự xác định  

o Fixed Qui định giá trị nhỏ nhất cho trục  

- Minor unit Xác định giá trị các khoảng chia phụ trên trục.  

o Auto Để Excel tự xác định  

o Fixed Qui định giá trị nhỏ nhất cho trục  

- Values in reverse order Đảo thứ tự sắp xếp các giá trị trên trục  

- Logarithmic scale Chuyển các giá trị trên trục sang hệ logarith với cơ số do ta qui 

định tại Base (không thể dùng cho giá trị âm hay bằng 0)  

- Display units Chọn đơn vị hiển thị trên trục.  

- Show display units label on chart Cho hiển thị các nhãn đơn vị trên đồ thị  

- Major tick mark type Qui định cách hiển thị ký hiệu phân cách chính trên đồ thị.  

o None Không sử dụng  

o Inside Hiển thị phía bên trong trục  

o Outside Hiển thị phía bên ngoài trục  

o Cross Hiển thị cắt ngang trục  

- Minor tick mark type Qui định cách hiển thị ký hiệu phân cách phụ trên đồ thị.  

- Axis labels Xác định cách hiển thị các nhãn trên trục  

o None Không sử dụng  

o High Hiển thị phía bên phải trục  

o Low Hiển thị phía bên trái trục  

o Next to Axis Hiển thị kế bên trục (theo mặc định)  
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- Horizontal axis crosses Các lựa chọn qui định cách mà trục tung cắt trục hoành 

(Đối với đồ thị 3-D đó chính là tùy chọn Floor crosses at)  

o Automatic Do Excel tự xác định.  

o Axis value Xác định giá trị mà các trục sẽ giao nhau  

o Maximum axis value Hai trục sẽ giao nhau tại giá trị lớn nhất trên trục (tung)  

Category Axis  

- Interval between tick marks Xác định sự thể hiện các nhóm theo khoảng chia (có 

bao nhiêu nhóm trong một khoảng chia, thường là một nhóm).  

- Interval between labels Xác định sự xuất hiện của nhãn theo khoảng chia  

o Automatic Excel tự xác định (thường là 1)  

o Specify interval unit Xác định nhãn sẽ xuất hiện sau bao nhiêu khoảng chia trên 

trục.  

- Categories in reverse order Các nhóm thể hiện theo thứ tự ngược lại  

- Label distance from axis Xác định khoảng cách của nhãn so với trục  

- Axis Type Xác định loại trục sử dụng như Automatic, Text axis hoặc Date axis  

- Major tick mark type Qui định cách hiển thị ký hiệu phân cách chính trên đồ thị.  

- Minor tick mark type Qui định cách hiển thị ký hiệu phân cách phụ trên đồ thị.  

- Axis labels Xác định cách hiển thị các nhãn trên trục  

- Vertical axis crosses Các lựa chọn qui định cách mà trục tung cắt trục tung  

o Automatic Do Excel tự xác định.  

o At category number Xác định số nhóm mà tại đó các trục sẽ giao nhau  

o At maximum category Hai trục sẽ giao nhau tại giá trị lớn nhất trên trục  

- Position Axis Qui định cách hiển thị của các nhóm và nhãn trên trục (Dùng cho đồ 

thị 2-D area, column, và line).  

o On tick marks Hiện ngay ký hiệu phân cách  
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o Between tick marks Hiện giữa các ký hiệu phân cách  

Time Scale Axis  

- Minimum Xác định giá trị (ngày) nhỏ nhất trên trục (ngày bắt đầu)  

- Maximum Xác định giá trị (ngày) lớn nhất trên trục (ngày kết thúc)  

- Major unit Xác định khoảng chia chính trên trục (đơn vị là ngày, tháng hay năm)  

- Minor unit Xác định khoảng chia phụ trên trục (đơn vị là ngày, tháng hay năm)  

- Base Unit Xác định đơn vị tính cho trục  

- Dates in reverse order Hiển thị theo thứ tự ngược lại trên trục  

- Axis Type Xác định loại trục sử dụng như Automatic, Text axis hoặc Date axis  

- Major tick mark type Qui định cách hiển thị ký hiệu phân cách chính trên đồ thị.  

- Minor tick mark type Qui định cách hiển thị ký hiệu phân cách phụ trên đồ thị.  

- Axis labels Xác định cách hiển thị các nhãn trên trục  

- Vertical Axis crosses Các lựa chọn qui định cách trục tung giao với trục hoành  

o Between dates Do Excel tự xác định  

o At date Giao nhau tại ngày do chúng ta nhập vào  

o At maximum date Giao nhau tại ngày lớn nhất (gần đây nhất) trên trục  

- Position Axis Qui định cách hiển thị của các nhóm và nhãn trên trục (Dùng cho đồ 

thị 2-D area, column, và line).  

o On tick marks Hiện ngay ký hiệu phân cách  

o Between tick marks Hiện giữa các ký hiệu phân cách  

d. Các thao tác với chuỗi số liệu trong đồ thị  

Xóa bớt một chuỗi số liệu khỏi đồ thị  

- Chọn chuỗi số liệu trên đồ thị (Ví dụ: chọn đường cung)  

- Nhấn phím Delete trên bàn phím để xót chuỗi khỏi đồ thị  
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Minh họa xóa chuỗi đường cung khỏi đồ thị 

Thêm chuỗi mới vào đồ thị  

- Chọn đồ thị cần thêm chuỗi mới vào.  

- Chart Tools ->Design ->Data ->Select Data. Hộp thoại Select Data Source xuất 

hiện.  

- Nhấp nút Add, hộp thoại Edit Series xuất hiện  

- Đặt tên cho chuỗi mới tại Series Name (bằng tham chiếu hoặc nhập trực tiếp tên 

vào từ bàn phím) và chọn vùng chứa dữ liệu tại Series Values  

- Ngoài ra ta có thể thêm nhanh chuỗi mới vào đồ thị bằng cách chép (Ctrl+C) dữ 

liệu của nó vào bộ nhớ, sau đó chọn đồ thị và dán (Ctrl+V) vào đồ thị.  

 

Minh họa thêm chuỗi dữ liệu của tháng 3/2008 vào đồ thị 
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Thay đổi chuỗi số liệu  

Cũng với ví dụ trên nhưng ta muốn chỉ vẽ cho 2 sản phẩm Giày và Dép  

- Chọn đồ thị cần chỉnh sửa  

- Chart Tools ->Design ->Data ->Select Data. Hộp thoại Select Data Source xuất 

hiện.  

- Chọn chuỗi cần chỉnh sửa, nhấp nút Edit, hộp thoại Edit Series xuất hiện  

- Chọn lại vùng dữ liệu mới tại Series Values. Làm tương tự cho các chuỗi số liệu 

khác.  

 

Minh họa thay đổi chuỗi số liệu 

Ngoài ra chúng ta có thể sử dụng hàm Series cho đồ thị. Cú pháp như sau: = 

Series(series_name, category_labels, values, order, sizes) Trong đó:  

- Series_name: (tùy chọn) tham chiếu đến ô chứa tên chuỗi, chúng ta có thể nhập 

văn bản trực tiếp vào nhớ đặt trong cặp nháy kép.  

- Category_labels: (tùy chọn) tham chiếu đến vùng chứa các nhãn cho các nhóm số 

liệu trên trục, nếu bỏ trống Excel tự đánh số các nhóm bắt đầu là số 1. Có thể nhập 

trực tiếp các nhãn vào Tab cách nhau bằng dấu phẩy và đặt trong cặp ngoặc móc {}.  

- Values: (bắt buộc) tham chiếu đến vùng chứa số liệu của các chuỗi cần vẽ.  
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- Order: (bắt buộc) Là số nguyên qui định thứ tự vẽ của các chuỗi (nếu đồ thị có 

nhiều hơn 1 chuỗi)  

- Sizes: (chỉ dùng cho đồ thị bong bóng – Bubble chart) Tham chiếu đến vùng chứa 

dữ liệu về kích thước của bong bóng trong đồ thị kiểu Bubble (sử dụng trong phân 

tích tài chính). Các giá trị có thể nhập trực tiếp Tab cách nhau bằng dấu phẩy và đặt 

trong cặp ngoặc móc {}.  

 

Minh họa hàm Series của chuỗi số liệu tháng 3/2008 

Thêm đường xu hướng vào đồ thị 

 Khi vẽ các đồ thị với dữ liệu theo thời 

gian chúng ta thường vẽ thêm đường 

xu hướng để biết được xu hướng trong 

tương lai của tập dữ liệu. Một tập số 

liệu có thể có nhiều đường xu hướng 

tùy theo cách phân tích của chúng ta. 

Để thêm đường xu hướng chúng ta 

vào:  

Minh họa thêm đường xu hướng vào đồ thị 

- Chart Tools ->Layout ->Analysis ->Trendline ->chọn kiểu đường xu hướng từ 

danh sách hay vào More Trendline Options…  
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Định Dạng Trang Và In Bảng Tính 

6.1. Các chế độ hiển thị trang trong Excel 

Excel 2010 hỗ trợ mạnh hơn trong việc in ấn, với nhiều chế độ xem trực quan giúp 

chúng ta có thể thấy được kết quả in ngay trên màn hình. 

Có 3 chế độ hiển thị là Nornal View, Page Layout View và Page Break Preview. 

Để truy cập các chế độ xem vào nhóm View ->chọn Workbook Views ->chọn kiểu 

xem. 

 Normal View: Đây là chế độ chúng ta sử dụng thường xuyên trong quá trình 

nhập liệu, tính toán,… trên bảng tính và là chế độ mặc định của Excel. 

 Page Layout View: Là chế độ xem trước khi in, trong chế độ này chúng ta 

vẫn có thể tính toán và nhập liệu. 

 Page Break Preview: Hiển thị bảng tính Excel với các dấu phân trang, tại đây 

chúng ta có thể chia lại trang bằng cách kéo thả các đường chia cách trang. 

6.2. Thiết lập thông số cho trang in 

Tất cả các tùy chọn thiết lập thông số trang in có tại nhóm Page Layout ->nhóm 

Page Setup (Margins: tùy chọn lề trang, Orientation: chiều trang ngang hay dọc, 

Size: tùy chọn khổ giấy, Print Area: tùy chọn vùng in, Breaks: tùy chọn ngắt trang, 

Background: chèn hình nền, Print Titles: tùy chọn in tiêu đề lặp lại trên mỗi 

trang,…). Chúng ta có thể thiết lập các thông số tại đây hoặc vào hộp thoại Page 

Setup để điều chỉnh. Để vào hộp thoại Page Setup chúng ta vào nhóm Page Layout 

-> hóm Page Setup ->nhấn vào nút  
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Chiều trang in (Orientation) 

1. Ribbon ->Page Layout ->Page Setup ->Orientation ->chọn Portrait (trang dọc)/ 

chọn Landscape (trang ngang) 

2. Trong hộp thoại Page Setup ->chọn ngăn Page ->Orientation ->chọn chiều trang 

in Portrait / Landscape  

Khổ giấy (Size) 

1. Ribbon ->Page Layout ->Page Setup ->Size ->chọn khổ giấy 

2. Trong hộp thoại Page Setup ->chọn ngăn Page ->Page size ->chọn giấy 

Canh lề giấy (Margins) 

1. Ribbon ->Page Layout ->Page Setup ->Margins ->chọn kiểu chừa lề 

2. Trong hộp thoại Page Setup ->chọn ngăn Margins ->nhập các giá trị vào Top (lề 

trên), Bottom (lề dưới), Left (lề trái), Right (lề phải), Header (lề tiêu đề đầu trang), 

Footer (lề tiêu đề chân trang). Ngoài ra còn có tùy chọn canh giữa: Horizontally 

(canh giữa trang theo chiều ngang) và Vertically (canh giữa trang theo chiều dọc) 

Chọn vùng in (Set Print Area) 
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Quét chọn vùng cần in, vào Ribbon ->Page Layout ->Page Setup ->Print Area -

>Set Print Area. 

Ngắt trang (Page Break) 

 Chèn ngắt trang ngang: Di chuyển ô hiện hành đến nơi sẽ chèn ngắt trang tại 

cột A, sau đó vào Ribbon ->Page Layout ->Page Setup- Breaks ->Insert 

Page Break. (Nếu không để ở cột A sẽ ngắt trang theo chiều ngang và dọc) 

 Bỏ từng dấu ngắt trang: Di chuyển ô hiện hành đến ô nằm ngay dưới dấu, sau 

đó vào Ribbon ->Page Layout ->Page Setup -Breaks ->Remove Page Break. 

 Bỏ tất cả đánh dấu ngắt trang: Ribbon ->Page Layout ->Page Setup Breaks 

->Reset All Page Breaks. 

Thêm hình nền (Background) 

Vào Ribbon ->Page Layout ->Page Setup -Background ->chọn hình lưu trữ trên 

máy ->nhấn nút Insert 

In tiêu đề dòng và cột (Row and column headers) 

Vào Ribbon ->Page Layout ->Sheet Options -Headings ->chọn Print 

In tiêu đề cột và dòng lặp lại ở các trang 

B1. Vào Ribbon ->Page Layout ->Page Setup -Print Title 

B2. Tại ô Rows to repeat at top ta quét chọn dòng số 1 vào ->$1:$1 

B3. Tại ô Columns to repeat at left ta quét chọn cột A ->$A:$A 

B4. Nhấn OK hoàn tất. 

Điều chỉnh tỉ lệ phóng to/ thu nhỏ trang in 

Trong một số trường hợp ta cần in nén hay phóng to nội dung vào một số trang nhất 

định khi đó ta dùng Ribbon ->Page Layout ->Scale To Fit ->Scale. Ta có thể thu 

nhỏ tài liệu đến 10% và phóng to tới 400%. 

Ngoài ra ta có thể ép Excel in tài liệu ra với số trang ta qui định tại Ribbon ->Page 

Layout ->Scale To Fit ->Width và Ribbon ->Page Layout ->Scale To Fit ->Height. 
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 In đường lưới của các ô 

Để in đường lưới kẽ các ô trong bảng tính ta chọn Ribbon ->Page Layout ->Sheet 

Options ->Gridline ->Print. 

Thêm thông tin vào đầu trang và chân trang (Header và Footer) 

Header chứa các thông tin xuất hiện ở đầu mỗi trang và Footer chứa các thông tin 

xuất hiện ở cuối mỗi trang. Các phiên bản trước ta dùng ngăn Hearder/ Footer trong 

hộp thoại Page Setup để thêm Header và Footer nhưng phiên bản này làm bằng một 

cách khác dễ dàng và trực quan hơn, đặc biệt có thể chèn hình vào. 

Vào Ribbon ->View ->chuyển sang chế độ xem Page Layout ->Tiến hành thêm 

Header và Footer 

 

Lưu ý chúng ta phải nhấp chuột vào vùng 

Header hoặc Footer thì nhóm lệnh 

Design mới hiện ra. 

Các nút lệnh trong thanh Design 

Các mã lệnh và nút lệnh trong Header và 

Footer 
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Nút lệnh Mã lệnh  Chức năng 

 
&[Page] Hiển thị số trang tài liệu 

 
&[Pages] Hiển thị tổng số trang được in 

 
&[Date] Hiển thị ngày hiện tại 

 
&[Time] Hiển thị giờ hiện tại 

 
&[Path]&[File] Hiển thị đường dẫn đầy đủ đến nơi lưu tập tin và Tên 

tập tin 

 
&[File] Hiển thị tên tập tin 

 
&[Tab] Hiển thị tên sheet 

 
Không có Chèn hình lựa chọn vào. Chúng ta phải tìm đến hình 

cần chèn vào trong hộp thoại Insert Picture, chọn 

hình và nhấn nút Insert. 

 
Không có Thiết lập các thông cố cho hình chèn vào. 

Do Excel dùng ký hiệu & để bắt đầu mã lệnh, do vậy trong trường hợp đoạn văn bản 

trong Header và Footer cần dùng ký hiệu & thì chúng ta hãy nhập ký hiệu này 2 lần 

&&. Ví dụ chúng ta muốn nhập “Công thức & Hàm” vào Header thì hãy nhập “Công 

thức && Hàm”. Các lựa chọn khác của Header và Footer: 

 Different First Page: Nếu chọn thì chúng ta có thể thiết lập thông tin khác 

vào header/ footer của trang đầu tiên so với header/ footer của các trang còn 

lại trong tài liệu. 

 Different Odd & Even Pages: Nếu chọn, thì chúng ta có thể đặt header/ footer 

khác nhau cho các trang chẵn và các trang lẻ. 

 Scale With Document: Nếu chọn, kích thước chữ của header/ footer sẽ tăng 

giảm theo tài liệu khi tài liệu sử dụng chức năng in có điều chỉnh tỉ lệ phóng 

to/ thu nhỏ. 

 Align With Page Margins: Nếu chọn, lề trái và lề phải của header/ footer canh 

đều với lề trái và lề phải của tài liệu. 
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6.3. Thiết lập thông số hộp thoại Print 

Để gọi hộp thoại Print, chúng ta chọn nút Office ->chọn Print hay nhấn tổ hợp phím 

<Ctrl+P>. Dùng hộp thoại này để chọn máy in, chọn trang cần in, chọn số lượng bản 

sao và một số tùy chọn khác. 

 

 Selection: Chỉ in vùng đang chọn trước nhấn 

lệnh Office ->Print 

 Active sheet(s): Chỉ in sheet hiện hành hay 

các sheet đang chọn. 

 Entire workbook: In toàn bộ workbook 

 Table: Chỉ có tác dụng khi ô hiện hành đang 

trong một bảng, nếu chọn thì chỉ in bảng này. 

 Ignore print areas: Khi chọn, Excel sẽ bỏ 

qua tất cả các thiết lập vùng in đã thực hiện. 

 

6.4. Các lưu ý khác 

Ngăn không cho in một số vùng 

Trong một số trường hợp, dữ liệu có các thông tin nhạy cảm mà chúng ta không 

muốn in ra. Khi đó chúng ta làm theo các cách sau. Ẩn các dòng hay cột chứa thông 

tin đó. Home ->Cells ->Format ->Chọn lệnh ẩn. 

 Tô màu chữ giống với màu nền của các ô. 

 Vẽ hình đè lên vùng dữ liệu nhạy cảm. 

Ngăn không cho in các đối tượng 

Một số đối tượng trên bảng tính như đồ thị, hình vẽ, SmartArt mà chúng ta không 

muốn in thì làm như sau: 

B1. Nhấp phải chuột lên đối tượng và chọn Size and Properties. 
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B2. Chọn ngăn Properties trong hộp thoại 

B3. Bỏ lựa chọn tại Print Object. 

Bài tập và sản phẩm thực hành bài 07.8 

Kiến thức: 

Câu 1: Đồ thị là gì? Nêu cách hiệu chỉnh đồ thị. 

Câu 2: Trình bày lệnh In bảng tính và chọn chiều in.  

Bài tập ứng dụng:    

Bài tập 07.9.1: 

 

1- Gọi lại bảng tính TH07.XLSX 

2. Sử dụng tính năng SUBTOTAL tạo tổng con (chi tiết) cho biết Tổng THÀNH 

TIỀN heo khối lớp 

3. Sử dụng tính năng AUTO FILTER lọc bảng tính chỉ còn các mẫu tin chứa khối 

các lớp cấp 3 

4. Từ bảng tính trên  trích ghi ra mọt bảng riêng gồm những loại sách là lý và hóa 

5. Lưu lại bảng tính. 

Bài tập 07.9.2: 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

BẢNG TÍNH ĐIỂM HỌC SINH 

TT MÃ SỐ HỌ VÀ TÊN TÊN TRƯỜNG MÔN THI ĐIỂM THI XẾP LOẠI 

1 A01T Trần Duy Trị  (a) (b) 8 (c) 

2 A01V Hồ Thị Tuyết   5  

3 B01T Lê Văn Mừng   9  

4 C02S Lê Ngọc Trong   5.5  

5 B02T Trần Hà Dũng   9  

6 C01V Trần Thanh Thanh   7.5  

7 B02S Nguyễn Văn Trục   8.5  

8 A03T Lê Chí Hùng   9.5  

9 D03S Đoàn Huân   6.5  

10 H10 Hoàng Xuân Nhĩ   9  

11 A02T Trần  Bửu   7  

12 B03T Lê Hòa Hải   6  

13 B01T Trần Bình Chương   9.5  

14 B03S Lê Phước Hòa   4.5  

15 C02V Nguyễn văn Hậu   3.5  

16 C03T Trần kỳ  Hà   8.5  
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      BẢNG TRA TÊN TRƯỜNG     BẢNG TRA TÊN MÔN THI 

Mã tên trường 

A Võ trường toản 

B Đinh tiên hoàng 

C Hòa Bình 

D Nguyễn Du 

 

YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột 

- Cột (a) : Tên trường căn cứ vào 1 Mã bên trái của Mã số và Bảng tra tên trường 

(Dùng hàm VLOOKUP) 

- Cột (b) : Tên Môn thi căn cứ vào 1 mã bên phải của Mã số và bảng tra tên môn thi 

(Dùng hàm HLOOKUP) 

- Cột (c) : Từ điểm thi, Hãy ban hành công thức cho cột xếp loại 

3.Sắp xếp bảng tính trên dựa vào cột điểm thi 

4. Từ bảng tính trên trích ghi ra 1 bảng riêng gồm những học sinh thuộc trường võ 

trường toản 
5. Từ bảng tính trên trích ra  1 bảng riêng gồm 5 học sinh xếp hạng cao nhất 

6. Tạo bảng thống kê  sau : 

Thống kê số học sinh đi thi theo trường và môn thi 

 

               Môn thi 

Trường 

Sinh ngữ Toán Văn 

Đinh tiên hoàng    

Võ Trường Toản    

Hòa Bình    

Nguyễn Du    

7. Bạn hãy thử nối cột Họ và cột tên thành 1 cột lấy tên HỌ VÀ TÊN (dùng toán tử 

&) 

8. - Vẽ đồ thị  tỷ lệ học sinh tham gia thi môn Sinh ngữ giữa 4 trường (Đồ thị Tròn) 

    - Vẽ đồ thị  minh họa sự tương quan số học sinh tham gia 3 môn thi theo các trường 

(Đồ thị khối) 

9. Ghi vào đĩa với tên TH10.XLSX 

Bài tập 07.9.3: 

Thành lập bảng tính  sau : (Xác định lại độ rộng cho các cột đủ để chứa dữ  liệu) 

 

 

 

 

 

 

 

 

Mã  S T  V  

Môn thi Sinh ngữ Toán  Văn 
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BẢNG THANH TOÁN TIỀN CÔNG TÁC PHÍ 

VIỆN NGHIÊN CỨU KHOA HỌC 

 

 

 

 
TT TÊN  LCB Cấp 

bậc 

KHU 

VỰC 

TỪ NGÀY  ĐẾN NGÀY HỆ 

SỐ 

HỆ SỐ 

THỰC 

TIỀN 

1 Trị  2.88 KS HNI 10/05/00 23/06/00 (a) (b) (c) 

2 Tuyết 3.10 CN HUE 23/07/00 11/08/00    

3 Mừng 2.50 CN HUE 12/06/00 19/06/00    

4 Trong 4.40 KT SGN 26/05/00 7/06/00    

5 Dũng 2.88 KS HNI 19/08/00 25/08/00    

6 Thanh 3.10 KT SGN 12/08/00 22/09/00    

7 Trục 4.50 CN HUE 23/09/00 05/10/00    

8 Hùng 2.50 CN HNI 13/09/00 27/10/00    

9 Huân 5.60 CN SGN 24/11/00 26/12/00    

10 Nhĩ 4.50 CB HUE 24/11/00 26/12/00    

11 Bửu 2.80 GD HNI 24/11/00 26/12/00    

12 Hải 2.80 CN SGN  24/11/00 26/12/00    

13 Chương 4.50 KS SGN 24/11/00 26/12/00    

14 Hòa 2.88 KS HUE 24/11/00 26/12/00    

15 Hậu 2.50 KT HUE 24/11/00 26/12/00    

16 Hà 3.50 CN HNI 24/11/00 26/12/00    

 
BẢNG HỆ SỐ CÔNG TÁC PHÍ  

 HNI HUE SGN 

CN 150 145 160 

GD 150 160 180 

KS 160 150 175 

KT 155 165 170 

YÊU  CẦU:    
1- Thành lập bảng tính và vào số liệu thô (chú ý Font tùy ý) 

2. Tính toán các cột như sau : 

- Cột (a) : Dựa vào cột Cấp bậc và bảng hệ số để tính toán cột hệ số (Dùng hàm 

VLOOKUP và HLOOKUP) 

- Cột (b) : Dựa vào bảng định mức thanh toán ngày 

Nếu Hệ số >175 thì lấy 175; Nếu hệ số<150 thì lấy 150 (Dùng hàm Max và Min) 

- Cột (c) = Số ngày công tác * hệ số thực *LCB 

3. Tạo Bảng thống kê sau : 

THỐNG KÊ SÓ NGƯỜI CÔNG TÁC THEO CHỨC VỤ VÀ KHU VỰC 

 HNI HUE SGN 

CN    

KS    

KT    

ĐỊNH MỨC THANH 

TOÁN NGÀY 

Tối thiểu :                      150 

Tối đa     :                       175 
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GD    

Có thể thực hiện bảng thống kê này bằng mấy cách ? thử thực hiện 

4. Dùng lệnh Thống kê tổng tiền cho từng nhóm khu vực công tác. 

5. lưu bảng tính vào đĩa với TH11.XLSX 
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CHỈ DẪN ĐỐI VỚI HỌC SINH THỰC HIỆN BÀI TẬP ỨNG DỤNG 

Đánh giá kết quả học tập 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối 

đa 

Kết quả thực 

hiện của 

người học 

I Kiến thức    

1 Khởi động MS Excel 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

  

 

2  

2 Các tạo đồ thị dựa vào vào số liệu 

trên bảng tính  
3  

3 Các thao tác hiệu chỉnh đồ thị 2  

4 Lệnh in bảng tính 2  

5 In bảng tính theo yêu cầu định dạng  1  

                                      Cộng: 10 đ  

II Kỹ năng    

1 Khởi động và thoát khỏi MS 

Excel  

  

 Kiểm tra sản phẩm 

sau buổi thực hành 

  

  

1 
 

2 Lệnh tạo đồ thị 2  

3 Định dạng đồ thị 2  

4 Định dạng bảng tính trước khi 

in  
2  

5 Lệnh in bảng tính 3  

                              Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp Theo dõi việc thực 

hiện, đối chiếu với 

nội quy của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1.5  

1.2 Không vi phạm nội quy lớp học 1.5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc thực 

hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời gian 

thực hiện bài tập, 

đối chiếu với thời 

gian quy định. 

2 
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3 Đảm bảo an toàn lao động và vệ 

sinh công nghiệp 
Theo dõi việc thực 

hiện, đối chiếu với 

quy định về an toàn 

và vệ sinh công 

nghiệp 

4 
 

3.1 Tuân thủ quy định về an toàn 1.5  

3.2 Đầy đủ bảo hộ lao động( quần 

áo thực hành, thẻ học sinh,  
1.5 

 

3.3 Vệ sinh phòng thực hành đúng 

quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0.3  

Kỹ năng  0.4  

Thái độ  0.3  

                                                                                              

Cộng: 
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Bài 10: TỔNG QUAN VỀ POWERPOINT 

 

Giới thiệu:         

 Microsoft office PowerPoint là phần mềm nằm trong bộ sản phẩm Văn phòng 

Microsoft office. 

 Sản phẩm này hổ trợ tạo các Slide trình diễn, để ta có thể chuẩn bị một nội 

dung trình bày, một vấn đề nào đó, trên máy tính thông qua thiết bị trình chiếu 

Projector một cách hiệu quả nhất, trực quan nhất, phong cách chuyên nghiệp nhất, 

có tác dụng mạnh nhất với người nghe, nhưng với một khoảng thời gian ngắn nhất. 

 Office PowerPoint cung cấp nhiều công cụ tiện ích hơn, hỗ trợ nhiều chức 

năng mạnh hơn so với các phiên bản trước.  
 

Mục tiêu: 

- Trình bày được Powerpoint là phần mềm dùng để trình diễn; 

- Mô tả được các thao tác trên trình đơn; 

 -  Thực hiện các thao tác an toàn với máy tính. 

Nội dung: 

1.  Giới thiệu 

1.1. khởi động và kết thúc làm việc với Office PowerPoint 

** Khởi động và thoát: 

*. Khởi động: 

- Start \ Run\ duyệt và chọn file POWERPNT.EXE \ Open. 

- Có thể chọn phím Start trên Windows Task Bar, chọn menu Program, và chọn 

biểu tượng của MS. PowerPoint.  

*. Thoát: 

- Chọn menu File, Exit 

- Nhắp chuột vào phím  trên góc cao bên phải của cửa sổ làm việc 

- Nhắp chuột vào biểu tượng của MS P.Point trên góc cao bên trái để mở hộp điều 

khiển (Control Box), chọn menu Close. 
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1.2. Màn hình chương trình Office PowerPoint 

                                              (Màn hình giao diện). 

Giao diện: 
Trước khi bắt đầu tạo bản trình diễn (presentation), chúng ta làm quen với 

giao diện của Powerpoint và khung tác vụ. 

 

2.  Làm quen với Presentation-Slide 

2.1. Các bước thiết kế một tập tin trình diễn đơn giản 

2.2.1. Tạo một tập tin trình diễn mới: 
 

Trong menu File , chọn New. 

a. Tạo phần trình diễn với 1 slide mặc định rỗng: chọn 

Blank Presentation. 

b. Tạo phần trình diễn với các slide có hỗ trợ mẫu thiết kế 

sẵn: chọn From design template. 

c. Tạo phần trình diễn có hỗ trợ chủ đề theo kiểu đồ thuật: 

chọn From AutoContent wizard. 

d. Tạo phần trình diễn hỗ trợ từ các phần trình diễn khác 

đã có sẵn: chọn From existing Presentation. 

2.2.2. thêm slide vào trình diễn 

        Khi vừa khởi tạo, một trình diễn chỉ một hoặc vài slide, sau đó có thể thêm vào, 

chỉnh sữa, xóa bỏ slide một cách tùy thích. 

       Thêm slide và trình diễn đang mở( đang thiết kế): 

*Cách 1: Mở Menu ngữ cảnh tại một slide nào đó trên khung slide. 

        Kích chọn lệnh New slide  

        Khi đó có một slide mới được chèn vào ngay sau slide mà ta mở menu ngữ 

cảnh( slide hiện tại). Slide mới thêm vào có layout giống như Layout của slide hiện 

tại. 

*Cách 2: Trên Tab Home, trong Group slides, Kích vào biểu tượng danh sách New 

slide để mở hộp danh sách các Layout theo chủ đề. 

       Kích chọn một mẫu Layout mà ta muốn. 

New 

Presentatio

n task 

View 

Selection 

Các Toolbar 

Slide 

thumbnails 

Vùng soạn 

thảo chính 

a 

b 

c 

d 
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       Khi đó có một Slide mới với Layout như đã chọn và Slide này cũng trở thành 

Slide hiện tại, sẵn sang cho việc thiết kế của ta. 

2.2.3. thay đổi Layout(dàn trang) của các slide. 

Ta có thể thay đổi layout của 1 slide mà ta đã thiết kế(đã nhập nội dung vào cho nó). 

Kích chọn các slide cần thay đổi  

Trên Tab Home trong group Slides : Kích vào biểu tượng layout để mở hộp danh 

sách này. 

Kích vào mẫu layout mà ta muốn chọn. 

Mẫu layout vừa kích chọn sẽ tác động đến tất cả các slide đã chọn.Việc thay đổi 

layuot của 1 slide không làm mất dữ liệu của nó. 

Để đánh dấu chọn nhiều slide khác nhau ta ấn phím Ctrl và lần lượt kích vào các 

slide mà ta muốn đánh dấu chọn. 

     Cũng cho thấy ta có thê kích vào biểu tượng Delete để xóa slide đã chọn. 

2.2.4. Nhập nội dung văn bản vào slide 

Soạn thảo trên Slide: 

 - Để soạn thảo trong PowerPoint, sử dụng đối tượng TextBox   làm nền 

nhập văn bản. Chỉ cần chọn đổi tượng và vẽ lên nền Slide sẽ tạo nên khung nhập dữ 

liệu. Thao tác gõ nhập và định dạng văn bản tương tự như Ms. Word. 

 Chú ý: với những đối tượng hình vẽ cơ bản khác trên thanh công cụ Drawing 

(như: Rectangle, Oval, AutoShape,..), để sử dụng nhập dữ liệu cần thực hiện qua 

thao tác sau: Vẽ đối tượng lên Slide, nháy phải vào đối tượng và chọn Add Text, lúc 

này đối tượng hình vẽ sẽ trở thành TextBox  

 - Soạn thảo trên Sile còn được thực hiện bởi các lệnh chèn đối tượng khác của 

Office: Table, Word Art, ClipArt, File, Picture, Bullest and Numbering,…Thao tác 

chèn các đối tượng này hoàn toàn tương tự như khi xử lý trên Word. 

 

Bài tập và sản phẩm thực hành bài 07.10 

 

Kiến thức: 

Câu 1: trình bày các bước thiết kế một tập tin trình diễn đơn giản?  

Kỹ năng: 

Bài tập ứng dụng:  

 Câu 1. Xây dựng một tệp trình diễn khoảng 10 slides để giới thiệu về ngôi 

trường mà chúng ta đang học tập. 

Câu 2. Xây dựng tệp trình diễn khoảng 5 slides để giới thiệu về chương 

trình học Tin văn phòng. 

 

CHỈ DẪN ĐỐI VỚI HỌC SINH THỰC HIỆN BÀI TẬP ỨNG DỤNG 

 

1. Bài tập ứng dụng phải thực hiện đúng trên máy tính giáo viên giao cho. 

2. Kiểm tra các ứng dụng chạy trên máy tính và hướng dẫn sử dụng trước khi 

thực hiện lệnh. 

3. Thực hiện đầy đủ các bước chuẩn bị khi thực hiện lệnh xây dựng 1 tệp trình 

diễn 
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4. sử dụng ứng dụng theo qui định và thao tác đúng các lệnh. 

5. Tổng điểm và kết cấu điểm của các bài như sau: 

Tổng số điểm tối đa cho bài: 100 điểm, kết cấu như sau: 

a, Phần thực hành khi thực hiện : Tổng cộng 70 điểm 

b, Phần chính xác và nhanh chóng : 30 điểm 

- Thời gian thực hiện bài tập vượt quá 25% thời gian cho phép sẽ không được 

đánh giá. 

- Thí sinh phải tuyệt đối tuân thủ các qui định an toàn lao động, các qui định của 

xưởng thực tập, nếu vi phạm sẽ bị đình chỉ thực tập 

Đánh giá kết quả học tập 

 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả 

thực 

hiện của 

người 

học 

I Kiến thức    

1 Các câu lệnh dùng để vào 

PowerPoint 

Vấn đáp, đối 

chiếu với nội 

dung bài học 

1  

1.1 Liệt kê đầy đủ các mục trong 

PowerPoint 
0,5  

1.2 Liệt kê đầy đủ các cú pháp 

lệnh trong PowerPoint 
0,5  

2 Chức năng, nguyên lý làm 

việc của màn hình PowerPoint 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

2.1 Nêu đầy đủ cấu tạo của màn 

hình PowerPoint 
0,5  

2.2 Trình bày công dụng và  

nguyên lý làm việc của các 

lệnh trong PowerPoint.  

1  

2.3 Trình bày đúng cách thực hiện 

các lệnh. 
0,5  

3 Phạm vi ứng dụng của 

PowerPoint 
Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

3.1 Nêu đúng thực chất của 

PowerPoint 

 

1  

3.2 Trình bày đầy đủ đặc điểm của 

PowerPoint 

0,5  
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3.3 Nêu đúng phạm vi ứng dụng 

của các lệnh trong PowerPoint 

 

0,5  

4 Trình bày màn hình và cách 

thực hiện lệnh 

 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

1,5  

5 Chọn chế độ làm việc và cách 

thực hiện lệnh hợp lý. 

Làm bài tự luận 

và trắc nghiệm 

đối chiếu với nội 

dung bài học 

1,5  

5.1 Nêu cách chọn lệnh phù hợp 0,5  

5.2 Trình bày đúng cách thực hiện 

lênh.  

0,5  

5.3 Trình bày cách chọn đường 

dẫn đến lệnh chính xác 

0,5  

6 Trình bày đúng kỹ thuật thực 

hiện lệnh 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

2 

 

                                      Cộng: 10 đ  

II Kỹ năng    

1 Nhận biết một số giao diện của 

PowerPoint 

Quan sát hình 

ảnh, đối chiếu 

với nội dung bài 

học để nhận biết 

2 

 

2 Vận hành thành thạo một số 

lệnh trong PowerPoint. 

Quan sát các thao 

tác, đối chiếu với 

quy trình vận 

hành 

3 

 

3 Nhận biết và sử dụng các loại 

lệnh phụ trợ trong PowerPoint 

một cách  thành thạo 

Quan sát hình 

ảnh, ký hiệu các 

loại lệnh đối 

chiếu với nội 

dung bài học để 

nhận biết 

2 

 

4 Phân biệt và phân loại các loại 

lệnh trong PowerPoint 

Quan sát các 

lệnh, đối chiếu 

với nội dung bài 

học để nhận biết 

3 

 

                                        Cộng: 10 đ  

III Thái độ    
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1 Tác phong công nghiệp khi  Theo dõi việc 

thực hiện, đối 

chiếu với nội quy 

của trường. 

4  

1.1 Đi học đầy đủ, đúng giờ 1,5  

1.2 Không vi phạm nội quy lớp học 1,5  

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện bài 

tập  

 

Theo dõi thời 

gian thực hiện 

bài tập, đối chiếu 

với thời gian quy 

định. 

2 

 

3 Đảm bảo an toàn thực hành và 

vệ sinh công nghiệp 

Theo dõi việc 

thực hiện, đối 

chiếu với quy 

định về an toàn 

và vệ sinh công 

nghiệp trong 

phong máy tính 

4 
 

3.1 Tuân thủ quy định về an toàn 

khi thực hiện lệnh trong 

PowerPoint  

1,5 

 

3.2 Đầy đủ bảo hộ lao động trong 

phòng máy( quần áo bảo hộ, 

giày, thẻ học sinh…) 

1,5 

 

3.3 Vệ sinh phòng máy thực hành  

đúng quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

                                                                                              

Cộng: 
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Bài 11: HIỆU ỨNG VÀ TRÌNH DIỄN 

 

Giới thiệu:         

 Với PowerPoint hiệu ứng và trình diễn là vấn đề quan trọng nhằm diễn tả một 

ý đồ, một thuyết trình nào đó ta có thể thay đổi hiệu ứng của nó bằng cách hiệu chỉnh 

đối tượng cho các đối tượng hoạt động theo chủ ý, thay đổi sơ đồ màu, hoặc gán 

những chuyển cảnh (transitions)… 
 

Mục tiêu: 

-  Thực hiện được các hiệu ứng cho từng đối tượng; 

-  Mô tả các thao tác trên trình đơn; 

 -   Thực hiện các thao tác an toàn với máy tính. 

Nội dung: 

1. Tạo hiệu ứng cho đối tượng   

1.1. Tạo hiệu ứng nhanh theo mẫu 

Lệnh: Format \ Slide Layout, hoặc nháy phải \ Slide Layout, khung tác vụ bên 

phải màn hình soạn thảo xuất hiện, chọn lấy 1 kiểu từ danh sách các Layout, dạng 

như hình vẽ sau: 

 Khi ta Click chọn vào các Icon trên Layout sẽ cho phép chèn nhanh các đối 

tượng tương ứng với biểu tượng như Table ( ), Chart ( )… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.2. Tạo hiệu ứng theo tùy chọn của người thiết kế 

Hiệu ứng trên nút lệnh (Action button) – hiệu ứng hoạt động (Action Setting): 

Thao tác thực hiện cho các hiệu ứng: 

- Slide Show \ Action button, chọn 1 mẫu nút lệnh, vẽ nút lệnh lên  Slide, nhả 

chuột,  hộp thoại Action Setting xuất hiện.  

Có 2 Tab tùy chọn là Mouse Click và Mouse Over quy định hiệu ứng chuột 

Danh 

sách các 

1 kiểu 

Layout đã 
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trên đối tượng. Về cơ bản, chức năng hoạt động của 2 tùy chọn này là hoàn toàn 

giống nhau. 

+ Hyperlink to: chọn 1 đích để liên kết tới. Đích có thể là 1 Slide, Presentaion, 

1 File (*.*), End Show (kết thúc trình diễn), 1 URL,… 

+ Run Program: thực thi 1 chương trình ứng dụng bằng cách nhắp vào nút 

Brower, duyệt đến file *.exe 

+ Run Macro: chạy thực thi 1 đoạn chương trình nhỏ nhằm điều khiển 1 hoạt 

động theo ý muốn nào đó. Yêu cầu thiết lập Macro trước. 

+ Paly Sound: trình diễn cùng hoạt động là hiệu ứng âm thanh, chọn dạng file âm 

thanh trình diễn và Ok. 

1.3. Thay đổi hiệu ứng của một đối tượng 

Thao tác như sau: 

 - Chọn đối tượng cần thay đổi hiệu ứng, gọi lệnh: 

  + Slide Show \ Custom Animation 

  + Hoặc nháy phải \ Custom Animation 

 Khung tác vụ bên phải màn hình soạn thảo xuất hiện: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

-Để thêm 1 hiệu ứng, chọn vào Add Effect. Gồm có 4 dạng hiệu ứng sau (mỗi dạng 

gồm nhiều kiểu hiệu ứng khác nhau rất phong phú): 

  + Dạng hiệu ứng xuất hiện: Entrance mang đối tượng trình diễn trên 

màn hình 
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+ Dạng hiệu ứng nhấn mạnh 

đối tượng: Emphasis xảy ra khi đối 

tượng đã xuất hiện trên màn hình. 

+ Dạng hiệu ứng kết thúc: 

Exit mang đối tượng rời khỏi phần 

trình diễn. 

+ Dạng hiệu ứng đường đi 

cho đối tượng: Motion Paths vạch 

đường đi cho đối tượng trên Slide. 

 - Để hiệu chỉnh 1 hiệu ứng nói 

chung, thường đi qua các mục sau: 

 

 (2) Start: bắt đầu hiệu ứng bằng tác 

động chuột (on click) hay thời gian 

(after previous) 

 (3) Speed: tốc độ hiệu ứng, có nhiều mức độ từ Very Slow đến Very Fast. 

 (4)Danh sách các đối tượng đã tạo hiệu ứng, xảy ra theo trình tự từ trên xuống 

nếu hiệu ứng đó không được điều khiển bởi Trigger. 

 (5) Re-Order: 2 nút lệnh dùng để thay đổi trình tự trong danh sách các đối tượng 

đã tạo hiệu ứng. 

 (6) Remove: dùng gỡ bỏ hiệu ứng cho 1 đối tượng. 

 (1) Add Effects: thêm 1 hiệu ứng mới. 

 

*Chú ý: để thiết lập các điều khiển hiệu ứng cho đối tượng, thực hiện tại hộp thoại 

Timing như sau: 

 + Lệnh gọi: Click vào đối tượng trong danh sách hiệu ứng, chọn Timing 

(Effects option \ Timing). Tại mục Trigger, chọn Start effect on click  at.  

2. Trình diễn Slide 

2.1. Cho trình diễn tất cả slide từ đầu đến cuối 

Chọn Slide cần tạo hiệu ứng chuyển trang, gọi 1 trong các lệnh sau: 

- Slide Show \ Slide Transition 

- Hoặc nháy phải \ Slide Transition 

Khung tác vụ bên phải màn hình soạn thảo xuất hiện.  

 

 

 

 

 

 

 

 

 

 

 

1 

5 

4 

3 

2 

6 

Chọn 1 kiểu 

chuyển 

trang 

Hiệu chỉnh 

về tốc độ và 

âm thanh 

Trang 

x.hiện khi 

Trang 

x.hiện tự 

động 

Áp dụng 

cho tất cả 

Slide 



 Trang 207  

 

 

 

 

 

 

2.2. Cho trình diễn từ slide hiện tại 

2.3. Cho trình diễn một đoạn slide bất kỳ 

Kích vào biểu tượng Set up Slide Show trong group Set up trên Tab slide 

show. Hộp thoại Set up Show xuất hiện: 

Nhập đoạn slide muốn trình diễn vào các hộp From, To trong khung show 

slides. 

Kích vào nút OK để hoàn thành. 

 2.4. Ẩn/ hiện slide 

Để ẩn /hiện Slide ta thực hiện như sau: 

Chọn slide cần cho ẩn/hiện nó. 

Kích chọn biểu tượng Hide Slide trong Group trong group Set up trên tab Slide 

Show: Slide đang ẩn sẽ hiện, Slide đang hiện sẽ ẩn 

 

 

Bài tập và sản phẩm thực hành bài 07.11 

 

Kiến thức: 

Câu 1. Hãy thiết kế phần trình diễn mô phỏng trò chơi ô chữ (tương tự Trò chơi ô 

chữ của Olympia trên VTV). 

 

Câu 2. Xây dựng hiệu ứng thể hiện công tắc điện đóng lại và dòng điện chạy qua 

trong mạch điện, công tắc ngắt thì dòng điện kết thúc. 

 

Câu 3. Tạo hiệu ứng thể hiện chiếc ô tô đang lăn bánh trên đường  

Kỹ năng: 

Bài tập ứng dụng:   

Câu 3. Giả sử chúng ta đang có một ý tưởng trong công việc nghiên cứu và học tập 

của mình. Hãy xây dựng một tệp trình diễn để giới thiệu ý tưởng của chúng ta trước 

mọi người. 

CHỈ DẪN ĐỐI VỚI HỌC SINH THỰC HIỆN BÀI TẬP ỨNG DỤNG 

 

1. Bài tập ứng dụng phải thực hiện đúng trên máy tính giáo viên giao cho. 

2. Kiểm tra các ứng dụng chạy trên máy tính và hướng dẫn sử dụng trước khi 

thực hiện lệnh. 

3. Thực hiện đầy đủ các bước chuẩn bị khi thực hiện lệnh xây dựng 1 tệp trình 

diễn 
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4. sử dụng ứng dụng theo qui định và thao tác đúng các lệnh. 

5. Tổng điểm và kết cấu điểm của các bài như sau: 

Tổng số điểm tối đa cho bài: 100 điểm, kết cấu như sau: 

a, Phần thực hành khi thực hiện : Tổng cộng 70 điểm 

b, Phần chính xác và nhanh chóng : 30 điểm 

- Thời gian thực hiện bài tập vượt quá 25% thời gian cho phép sẽ không được 

đánh giá. 

- Thí sinh phải tuyệt đối tuân thủ các qui định an toàn lao động, các qui định của 

xưởng thực tập, nếu vi phạm sẽ bị đình chỉ thực tập 

Đánh giá kết quả học tập 

 

TT Tiêu chí đánh giá 

Cách thức và 

phương pháp 

đánh giá 

Điểm 

tối đa 

Kết quả thực 

hiện của 

người học 

I Kiến thức    

1 Các câu lệnh dùng để vào 

PowerPoint 

Vấn đáp, đối 

chiếu với nội dung 

bài học 

1  

1.1 Liệt kê đầy đủ các mục 

trong PowerPoint 
0,5  

1.2 Liệt kê đầy đủ các cú pháp 

lệnh trong PowerPoint 
0,5  

2 Chức năng, nguyên lý làm 

việc của màn hình 

PowerPoint 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

2.1 Nêu đầy đủ cấu tạo của màn 

hình PowerPoint 
0,5  

2.2 Trình bày công dụng và  

nguyên lý làm việc của các 

lệnh trong PowerPoint.  

1  

2.3 Trình bày đúng cách thực 

hiện các lệnh. 
0,5  

3 Phạm vi ứng dụng của 

PowerPoint 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

2  

3.1 Nêu đúng thực chất của 

PowerPoint 

 

1  

3.2 Trình bày đầy đủ đặc điểm 

của PowerPoint 

0,5  

3.3 Nêu đúng phạm vi ứng dụng 

của các lệnh trong 

PowerPoint 

 

0,5  
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4 Trình bày màn hình và cách 

thực hiện lệnh 

 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 

 

1,5  

5 Chọn chế độ làm việc và 

cách thực hiện lệnh hợp lý. 

Làm bài tự luận và 

trắc nghiệm đối 

chiếu với nội dung 

bài học 

1,5  

5.1 Nêu cách chọn lệnh phù hợp 0,5  

5.2 Trình bày đúng cách thực 

hiện lênh.  

0,5  

5.3 Trình bày cách chọn đường 

dẫn đến lệnh chính xác 

0,5  

6 Trình bày đúng kỹ thuật 

thực hiện lệnh 

Làm bài tự luận, 

đối chiếu với nội 

dung bài học 
2 

 

                                      Cộng: 10 đ  

II Kỹ năng    

1 Nhận biết một số giao diện 

của PowerPoint 

Quan sát hình 

ảnh, đối chiếu với 

nội dung bài học 

để nhận biết 

2 

 

2 Vận hành thành thạo một số 

lệnh trong PowerPoint. 

Quan sát các thao 

tác, đối chiếu với 

quy trình vận hành 
3 

 

3 Nhận biết và sử dụng các 

loại lệnh phụ trợ trong 

PowerPoint một cách  thành 

thạo 

Quan sát hình 

ảnh, ký hiệu các 

loại lệnh đối chiếu 

với nội dung bài 

học để nhận biết 

2 

 

4 Phân biệt và phân loại các 

loại lệnh trong PowerPoint 

Quan sát các lệnh, 

đối chiếu với nội 

dung bài học để 

nhận biết 

3 

 

                                        Cộng: 10 đ  

III Thái độ    

1 Tác phong công nghiệp khi  Theo dõi việc 

thực hiện, đối 
4  

1.1 Đi học đầy đủ, đúng giờ 1,5  
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1.2 Không vi phạm nội quy lớp 

học 

chiếu với nội quy 

của trường. 1,5 
 

1.3 Tính cẩn thận, tỉ mỉ Quan sát việc 

thực hiện bài tập 1 
 

2 Đảm bảo thời gian thực hiện 

bài tập  

 

Theo dõi thời gian 

thực hiện bài tập, 

đối chiếu với thời 

gian quy định. 

2 

 

3 Đảm bảo an toàn thực hành 

và vệ sinh công nghiệp 

Theo dõi việc thực 

hiện, đối chiếu với 

quy định về an 

toàn và vệ sinh 

công nghiệp trong 

phong máy tính 

4 
 

3.1 Tuân thủ quy định về an toàn 

khi thực hiện lệnh trong 

PowerPoint  

1,5 

 

3.2 Đầy đủ bảo hộ lao động 

trong phòng máy( quần áo 

bảo hộ, giày, thẻ học sinh…) 

1,5 

 

3.3 Vệ sinh phòng máy thực 

hành  đúng quy định 
1 

 

                              Cộng: 10 đ  

 

KẾT QỦA HỌC TẬP 

 

Tiêu chí đánh giá 
Kết quả 

thực hiện 
Hệ số 

Kết qủa 

học tập 

Kiến thức   0,3  

Kỹ năng  0.4  

Thái độ  0,3  

                                                                       Cộng:  

 

 

 

 

 

 

 

 

Tài liệu cần tham khảo: 
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